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Preface

Audience for This Guide

Welcome to Oracle Applications Release 11i of the Oracle Collaborative Planning
Implementation and User’s Guide.

This guide assumes you have a working knowledge of the following;:

The principles and customary practices of your business area.
Oracle Collaborative Planning

If you have never used Oracle Collaborative Planning, Oracle suggests you
attend one or more of the Oracle Collaborative Planning training classes
available through Oracle University.

The Oracle Applications graphical user interface.

To learn more about the Oracle Applications graphical user interface, read the
Oracle Applications User’s Guide.

See Other Information Sources for more information about Oracle Applications
product information.

How To Use This Guide

This guide contains the information you need to understand and use Oracle
Collaborative Planning

Chapter 1 contains an introduction to Oracle Collaborative Planning and its
functionality.

Chapter 2 contains setup and implementation information for Oracle
Collaborative Planning.

Chapter 3 discusses collaboration with suppliers.
Chapter 4 discusses collaboration with customers.
Chapter 5 discusses vendor managed inventory.
Chapter 6 discusses collaborative inventory visibility.

Chapter 7 discusses how to create custom exceptions.

xiii



s Chapter 8 discusses how waterfall analysis is used in Oracle Collaborative
Planning.

s Chapter 9 discusses the advanced horizontal view feature of Oracle
Collaborative Planning.

= Appendix A lists the profile options associated with Oracle Collaborative
Planning.

s Appendix B discusses common errors you might encounter when using Oracle
Collaborative Planning.

s Appendix C discusses XML transactions and Oracle Collaborative Planning.

s Appendix D lists and describes key tables used in Oracle Collaborative
Planning.

Documentation Accessibility

Xiv

Our goal is to make Oracle products, services, and supporting documentation
accessible, with good usability, to the disabled community. To that end, our
documentation includes features that make information available to users of
assistive technology. This documentation is available in HTML format, and contains
markup to facilitate access by the disabled community. Standards will continue to
evolve over time, and Oracle Corporation is actively engaged with other
market-leading technology vendors to address technical obstacles so that our
documentation can be accessible to all of our customers. For additional information,
visit the Oracle Accessibility Program Web site at

http:/ /www.oracle.com/accessibility /.

Accessibility of Code Examples in Documentation

JAWS, a Windows screen reader, may not always correctly read the code examples
in this document. The conventions for writing code require that closing braces
should appear on an otherwise empty line; however, JAWS may not always read a
line of text that consists solely of a bracket or brace.

Accessibility of Links to External Web Sites in Documentation

This documentation may contain links to Web sites of other companies or
organizations that Oracle Corporation does not own or control. Oracle Corporation
neither evaluates nor makes any representations regarding the accessibility of these
Web sites.



Other Information Sources

You can choose from many sources of information, including online documentation,
training, and support services, to increase your knowledge and understanding of
Oracle Collaborative Planning.

If this guide refers you to other Oracle Applications documentation, use only the
Release 11i versions of those guides.

Online Documentation
All Oracle Applications documentation is available online (HTML or PDEF).

= Online Help - The new features section in the HTML help describes new
features in Oracle Applications Release 11i. This information is updated for each
new release of Oracle Collaborative Planning. The new features section also
includes information about any features that were not yet available when this
guide was printed. For example, if your administrator has installed software
from a mini-packs an upgrade, this document describes the new features.
Online help patches are available on OracleMetaLink.

=  11i Features Matrix - This document lists new features available by patch and
identifies any associated new documentation. The new features matrix
document is available on OracleMetaLink.

= Readme File - Refer to the readme file for patches that you have installed to
learn about new documentation or documentation patches that you can
download.

Related User’s Guides

Oracle Collaborative Planning shares business and setup information with other
Oracle Applications products. Therefore, you may want to refer to other user’s
guides when you set up and use Oracle Collaborative Planning

You can read the guides online by choosing Library from the expandable menu on
your HTML help window, by reading from the Oracle Applications Document
Library CD included in your media pack, or by using a Web browser with a URL
that your system administrator provides.

If you require printed guides, you can purchase them from the Oracle Store at
http:/ /oraclestore.oracle.com.

XV



Guides Related to All Products

Oracle Applications User’s Guide

This guide explains how to enter data, query, run reports, and navigate using the
graphical user interface (GUI) available with this release of Oracle Collaborative
Planning (and any other Oracle Applications products). This guide also includes
information on setting user profiles, as well as running and reviewing reports and
concurrent processes.

You can access this user’s guide online by choosing Getting Started with Oracle
Applications from any Oracle Applications help file.

User Guides Related to This Product

XVi

Oracle Advanced Planning Implementation and User’s Guide

This guide describes how to use Oracle’s planning solution for supply chain
planning performance. This guide can be used as a reference when you are
implementing Oracle Advanced Supply Chain Planning with Oracle Collaborative
Planning.

Oracle Inventory User’s Guide

This guide describes how to define items and item information, perform receiving
and inventory transactions, maintain cost control, plan items, perform cycle
counting and physical inventories, and set up Oracle Inventory.

Oracle Order Management User’s Guide

This guide describes how to enter sales orders and returns, copy existing sales
orders, schedule orders, release orders, create price lists, and discounts for orders,
run processes, and create reports.

Oracle Workflow Guide

This guide explains how to define new workflow business processes as well as
customize existing Oracle Applications-embedded workflow processes.You also use
this guide to complete the setup steps necessary for any Oracle Applications
product that includes workflow-enabled processes.



Installation and System Administration

Oracle Applications Concepts

This guide provides an introduction to the concepts, features, technology stack,
architecture, and terminology for Oracle Applications Release 11i. It provides a
useful first book to read before an installation of Oracle Applications. This guide
also introduces the concepts behind Applications-wide features such as Business
Intelligence (BIS), languages and character sets, and Self-Service Web Applications.

Installing Oracle Applications

This guide provides instructions for managing the installation of Oracle
Applications products. In Oracle Applications Release 11i, much of the installation
process is handled using Oracle Rapid Install, which minimizes the time to install
Oracle Applications, the Oracle9 technology stack, and the Oracle9i Server
technology stack by automating many of the required steps. This guide contains
instructions for using Oracle Rapid Install and lists the tasks you need to perform to
finish your installation. You should use this guide in conjunction with individual
product user’s guides and implementation guides.

Upgrading Oracle Applications

Refer to this guide if you are upgrading your Oracle Applications Release 10.7 or
Release 11.0 products to Oracle Applications Release 11i. This guide describes the
upgrade process and lists database and product-specific upgrade tasks. You must be
either at Oracle Applications Release 10.7 (NCA, SmartClient, or character mode) or
Oracle Applications Release 11.0, to upgrade to Oracle Applications Release 11i. You
cannot upgrade to Oracle Applications Release 11i directly from releases prior to
10.7.

Maintaining Oracle Applications

Use this guide to help you run the various AD utilities, such as AutoUpgrade,
AutoPatch, AD Administration, AD Controller, AD Relink, License Manager, and
others. It contains how-to steps, screenshots, and other information that you need to
run the AD utilities. This guide also provides information on maintaining the
Oracle applications file system and database.

Xvii



Oracle Applications System Administrator’s Guide

This guide provides planning and reference information for the Oracle Applications
System Administrator. It contains information on how to define security, customize
menus and online help, and manage concurrent processing.

Oracle Alert User’s Guide

This guide explains how to define periodic and event alerts to monitor the status of
your Oracle Applications data.

Oracle Applications Developer’s Guide

This guide contains the coding standards followed by the Oracle Applications
development staff. It describes the Oracle Application Object Library components
needed to implement the Oracle Applications user interface described in the Oracle
Applications User Interface Standards for Forms-Based Products. It also provides
information to help you build your custom Oracle Forms Developer 6i forms so that
they integrate with Oracle Applications.

Oracle Applications User Interface Standards for Forms-Based Products

This guide contains the user interface (UI) standards followed by the Oracle
Applications development staff. It describes the UI for the Oracle Applications
products and how to apply this Ul to the design of an application built by using
Oracle Forms.

Other Implementation Documentation

xviii

Oracle Applications Product Update Notes

Use this guide as a reference for upgrading an installation of Oracle Applications. It
provides a history of the changes to individual Oracle Applications products
between Release 11.0 and Release 11i. It includes new features, enhancements, and
changes made to database objects, profile options, and seed data for this interval.

Multiple Reporting Currencies in Oracle Applications

If you use the Multiple Reporting Currencies feature to record transactions in more
than one currency, use this manual before implementing Oracle Collaborative
Planning. This manual details additional steps and setup considerations for
implementing Oracle Collaborative Planning with this feature.



Multiple Organizations in Oracle Applications

This guide describes how to set up and use Oracle Collaborative Planning with
Oracle Applications' Multiple Organization support feature, so you can define and
support different organization structures when running a single installation of
Oracle Collaborative Planning.

Oracle Workflow Administrator's Guide

This guide explains how to complete the setup steps necessary for any Oracle
Applications product that includes workflow-enabled processes, as well as how to
monitor the progress of runtime workflow processes.

Oracle Workflow Developer's Guide

This guide explains how to define new workflow business processes and customize
existing Oracle Applications-embedded workflow processes. It also describes how
to define and customize business events and event subscriptions.

Oracle Workflow User's Guide

This guide describes how Oracle Applications users can view and respond to
workflow notifications and monitor the progress of their workflow processes.

Oracle Workflow API Reference

This guide describes the APIs provided for developers and administrators to access
Oracle Workflow.

Oracle Applications Flexfields Guide

This guide provides flexfields planning, setup and reference information for the
Oracle Collaborative Planning implementation team, as well as for users
responsible for the ongoing maintenance of Oracle Applications product data. This
manual also provides information on creating custom reports on flexfields data.

Oracle eTechnical Reference Manuals

Each eTechnical Reference Manual (eTRM) contains database diagrams and a
detailed description of database tables, forms, reports, and programs for a specific
Oracle Applications product. This information helps you convert data from your
existing applications, integrate Oracle Applications data with non-Oracle
applications, and write custom reports for Oracle Applications products. Oracle
e€TRM is available on Metalink
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Oracle Manufacturing APIs and Open Interfaces Manual

This manual contains up-to-date information about integrating with other Oracle
Manufacturing applications and with your other systems. This documentation
includes API’s and open interfaces found in Oracle Manufacturing.

Oracle Order Management Suite APIs and Open Interfaces Manual

This manual contains up-to-date information about integrating with other Oracle
Manufacturing applications and with your other systems. This documentation
includes API’s and open interfaces found in Oracle Order Management Suite.

Oracle Applications Message Reference Manual

This manual describes all Oracle Applications messages. This manual is available in
HTML format on the documentation CD-ROM for Oracle Applications Release 11i.

Training and Support

XX

Training

Oracle offers a complete set of training courses to help you and your staff master
Oracle Collaborative Planning and reach full productivity quickly. These courses are
organized into functional learning paths, so you take only those courses appropriate
to your job or area of responsibility.

You have a choice of educational environments. You can attend courses offered by
Oracle University at any one of our many Education Centers, you can arrange for
our trainers to teach at your facility, or you can use Oracle Learning Network
(OLN), Oracle University's online education utility. In addition, Oracle training
professionals can tailor standard courses or develop custom courses to meet your
needs. For example, you may want to use your organization structure, terminology,
and data as examples in a customized training session delivered at your own
facility.

Support

From on-site support to central support, our team of experienced professionals
provides the help and information you need to keep Oracle Collaborative Planning
working for you. This team includes your Technical Representative, Account
Manager, and Oracle’s large staff of consultants and support specialists with
expertise in your business area, managing an Oracle9i server, and your hardware
and software environment.



Do Not Use Database Tools to Modify Oracle Applications Data

Oracle STRONGLY RECOMMENDS that you never use SQL*Plus, Oracle Data
Browser, database triggers, or any other tool to modify Oracle Applications data
unless otherwise instructed.

Oracle provides powerful tools you can use to create, store, change, retrieve, and
maintain information in an Oracle database. But if you use Oracle tools such as
SQL*Plus to modify Oracle Applications data, you risk destroying the integrity of
your data and you lose the ability to audit changes to your data.

Because Oracle Applications tables are interrelated, any change you make using
Oracle Applications can update many tables at once. But when you modify Oracle
Applications data using anything other than Oracle Applications, you may change a
row in one table without making corresponding changes in related tables. If your
tables get out of synchronization with each other, you risk retrieving erroneous
information and you risk unpredictable results throughout Oracle Applications.

When you use Oracle Applications to modify your data, Oracle Applications
automatically checks that your changes are valid. Oracle Applications also keeps
track of who changes information. If you enter information into database tables
using database tools, you may store invalid information. You also lose the ability to
track who has changed your information because SQL*Plus and other database
tools do not keep a record of changes.

About Oracle

Oracle Corporation develops and markets an integrated line of software products
for database management, applications development, decision support, and office
automation, as well as Oracle Applications, an integrated suite of more than 160
software modules for financial management, supply chain management,
manufacturing, project systems, human resources and customer relationship
management.

Oracle products are available for mainframes, minicomputers, personal computers,
network computers and personal digital assistants, allowing organizations to
integrate different computers, different operating systems, different networks, and
even different database management systems, into a single, unified computing and
information resource.

Oracle is the world’s leading supplier of software for information management, and
the world’s second largest software company. Oracle offers its database, tools, and
applications products, along with related consulting, education, and support
services, in over 145 countries around the world.

XXi



Your Feedback

Thank you for using Oracle Collaborative Planning and this user’s guide. Oracle
values your comments and feedback. At the beginning of this guide is a Reader’s
Comment Form you can use to explain what you like or dislike about Oracle
Collaborative Planning or this user’s guide. You can send comments to us at the
e-mail address mfgdoccomments_us@oracle.com.

XXii



1

Introduction

This chapter introduces Oracle Collaborative Planning. The following topics are
addressed:

Overview of Oracle Collaborative Planning on page 1-2
Collaboration Methods on page 1-3

Collaborate with Customers on page 1-3

Collaborate with Suppliers on page 1-4

Multi-tier Collaborations on page 1-4

Oracle iSupplier Portal on page 1-5

Oracle Collaborative Planning Functionality on page 1-6
Time Buckets on page 1-7

Exception Management on page 1-7

Requests on page 1-8
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Overview of Oracle Collaborative Planning

Overview of Oracle Collaborative Planning

Oracle Collaborative Planning provides advanced capabilities for communicating,
planning, and optimizing supply and demand information for trading partners
across the supply chain. Oracle Collaborative Planning enables you to reduce
inventory levels, improve visibility across your supply chain, increase the speed of
information and materials, and promise delivery more accurately.

The following image depicts how Oracle Collaborative Planning works between
you, your customers and your suppliers:

Forecasts N Feorecasts
Purchase Orders N Purchase Orders N
Inventory Inventory N
> >
ATP Requests ATP Requests
Customers > You »1 Suppliers
P ASN's ASN's
> .
‘Supply Commits :Supply Commits

Oracle Collaborative Planning integrates with Oracle Advanced Supply Chain
Planning, Oracle Demand Planning, and Oracle iSupplier Portal for a complete
supply chain solution. You also can integrate Oracle Collaborative Planning with
legacy ERP systems or use it as a standalone product.

Through integration, Oracle Collaborative Planning enables you to:

= Use data collections to acquire setup data from ERP legacy systems (items,
customers, suppliers, users, company associations)

= Use data collections to access execution data, such as purchase orders and sales
orders
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Collaborate with Customers

s Publish order forecasts from Oracle Advanced Supply Chain Planning to your
suppliers in Oracle Collaborative Planning

= Receive supply commits from Oracle Collaborative Planning to Oracle
Advanced Supply Chain Planning

= Publish sales forecasts from Oracle Demand Planning to your customers in
Oracle Collaborative Planning

Collaboration Methods

You can send and receive information into Oracle Collaborative Planning using the
publish programs from Oracle Advanced Supply Chain Planning and Oracle
Demand Planning, direct entry through the user interface, flat file loads, or XML.

For more information about direct entry of information and flat file loads, refer to
Overview of Setup on page 2-2.

For more information about XML transactions in Oracle Collaborative Planning,
refer to Overview of XML on page C-2.

Collaborate with Customers
There are two types of collaboration business processes:
= Sales forecast collaboration
= Order forecast collaboration

Sales forecast collaboration is prevalent in the consumer goods industries, where
promotions by both retailers and manufacturers have direct impact on
end-consumer demand.

Order forecast collaboration is more common in manufacturing environments.
Customers provide demand forecasts, and suppliers provide supply commit
information based on their ability to meet the demand. Oracle Collaborative
Planning enables your customers to publish forecasts in Oracle Collaborative
Planning. You can then provide accurate supply commits based on those forecasts.

For more information about collaborating with customers, refer to Overview of
Forecasting on page 3-2.
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Collaborate with Suppliers

Collaborate with Suppliers

Collaboration with suppliers is similar to that with customers. With supplier
collaboration, however, you are in the customer role and the supplier takes on your
role. You must provide your suppliers with enough visibility to enable them to be
more responsive to your requirements, reduce material shortages, get early
visibility into constraints, and track performance. There are two types of
information collaborations:

m Sales forecast
m  Order forecast

For more information about collaborating with suppliers, refer to Overview of
Forecasting on page 3-2.

Multi-tier Collaborations

Oracle Collaborative Planning enables you to model any level of complexity in your
supply chain and promote a seamless flow of information and materials across your
extended supply chain. This enables you to provide visibility of your requirements
to all tiers of your supply chain so that you can have visibility of all issues and
constraints in your supply chain.

Multi-tier collaborations enable you to:

»  Communicate requirements to contract manufacturers and suppliers
»  Get visibility to supplier capacity and customer requirements

= Reallocate key components

= Make alternate sourcing decisions

Complete the following steps to establish a multi-tier collaboration:

= Come to consensus on demand with your customer.

= Involve your entire supply chain.

s Communicate the requirements for your contracted assemblies and
requirements for critical components to other tiers of the supply chain. This
enables you to simultaneously provide visibility into your plans to the entire
supply chain.

= Receive commitments from all tiers of the supply chain simultaneously,
providing you warn early about disruptions in the flow of material, and the
ability to pro actively identify contingency plans and alternate strategies.
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Oracle iSupplier Portal

= Provide accurate commitments to your customers that take into account an
up-to-date assessment of your supply chain capabilities.

Oracle iSupplier Portal

When Oracle iSupplier Portal and Oracle Collaborative Planning are licensed, they
can be combined in a unified portal (if they are deployed together in the same
database instance). This provides your suppliers with one point of entry for
planning and execution data.

The following image depicts how Oracle iSupplier Portal and Oracle Collaborative
Planning combine to a unified portal:

Oracle Collaborative
Planning

- Unified Portal

Oracle iSupplier
Portal

The unified portal of Oracle Collaborative Planning and Oracle iSupplier Portal
provides you with several capabilities. The following table lists those capabilities,
and which application provides them.

Capability Application

Orders Oracle iSupplier Portal
ASN (Advanced Shipment Notices) Oracle iSupplier Portal
Receipts Oracle iSupplier Portal
Invoices Oracle iSupplier Portal
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Oracle Collaborative Planning Functionality

Capability Application

Payments Oracle iSupplier Portal

Vendor Managed Inventory Oracle iSupplier Portal and Oracle
Collaborative Planning

Suppliers, products, order modifiers, Oracle iSupplier Portal and Oracle

approved supplier lists, sourcing Collaborative Planning

Exceptions Oracle Collaborative Planning

Forecasts Oracle Collaborative Planning

Capacity Oracle Collaborative Planning

Pegging Oracle Collaborative Planning

Waterfall Analysis Oracle Collaborative Planning

For more information about how to set up Oracle Collaborative Planning with
Oracle iSupplier Portal, refer to Overview of Setup on page 2-2.

Collaborate with Suppliers

Suppliers can respond to purchase orders and initiate purchase order change
requests directly through the Oracle iSupplier Portal. When this happens, Oracle
Collaborative Planning auto-creates (for the purposes of supply/demand tracking
and exception management within Oracle Collaborative Planning) a supplier sales
order containing the acknowledgement information. Suppliers can provide their
sales order reference information directly through Oracle iSupplier Portal. This not
only reduces overhead of maintaining documents in two separate places, but also
enables a more streamlined business process. For more information about
collaborating with suppliers, refer to Overview of Forecasting on page 3-2.

Oracle Collaborative Planning Functionality

Collaborative planning is accomplished using several functionalities. The following
table lists and describes the functionalities that facilitate collaboration:
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Exception Management

Function

Description

Collaborative Planning
and Forecasting

You can involve your customers in the forecasting process to
drive to consensus and improve forecast accuracy. After running
your internal planning process, you can communicate the output
of your supply chain plan to your suppliers. Your supplier’s
response to forecast information can be included in the planning
cycle.

Vendor Managed
Inventory

Vendor Managed Inventory enables you to automate the
replenishment process, lower inventory, improve supplier
performance, and drive out non-valued added costs. You can
provide suppliers all the information needed to manage
inventory they provide. It is integrated with the execution
system to allow any desired level of automation in the order
creation process.

For more information about Vendor Managed Inventory, refer to
Overview of Vendor Managed Inventory on page 4-2.

Oracle Supply Chain
Exception Management

Even as the frequency of planning increases, disruptions in
between planning runs are still inevitable. Oracle Collaborative
Planning enables you to adapt to disruptions in the supply chain
by using Supply Chain Exception Management. You can define
your own exceptions or use seeded exceptions. Workflow is
used to automate notifications and corrective action processes.

For more information about exceptions, refer to Overview of
Exceptions on page 6-2.

Collaborative Inventory
Visibility

Collaborative Inventory Visibility enables you to create groups
and share inventory among members of those group.

For more information about Collaborative Inventory Visibility,
refer to Overview of Collaborative Inventory Visibility on
page 5-2.

Time Buckets

Oracle Collaborative Planning uses time buckets to represent supply and demand
information. You can use time buckets to specify a duration for demand and supply
information, in terms of days, weeks, and months.

Exception Management

Any mismatches in supply and demand information are flagged using exception
messages. You can view each exception message in Oracle Collaborative Planning,
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Requests

or as a workflow notification. You can choose to view only those exceptions that are
of interest to you, and rank them according to your preference.

Exception Summary and Details

The Exceptions Summary window lists the exception types and number of
exceptions. From the Summary window you can navigate to the Exception Details
window. The Exception Details window displays each exception together with all
details pertinent to that exception and navigation into other windows to aid you
with the resolution process.

Exception Thresholds

An administrator can specify the tolerance for each exception type that can lead to
an exception. By setting appropriate tolerances, you can avoid exception overloads
and ensure that issues are flagged when required.

Supply Chain Event Manager

Requests

To generate exceptions and send notifications you must run the Supply Chain Event
Manager. To run this program your username must be assigned to the Advanced
Planning System Administrator responsibility. Contact your system administrator if
you do not have this responsibility.

Complete the following steps to run the Supply Chain Event Manager:
1. Log in under the Advanced Planning Administrator responsibility.
2. Navigate to Other > Supply Chain Event Manager.

3. Enter a value for each of the parameters.

Note: The default value is set to No.

4. Select OK.
5. Select Submit.

Whenever you load information into the system using Oracle Advanced Supply
Chain Planning, you receive a request ID. You can view the progress of your
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Requests

requests of any information you load in the Oracle Collaborative Planning system.
When you view your requests, the system displays whether the load was successful.

1. From the Home window of Oracle Collaborative Planning, select the Admin
tab.

Select View Requests.
In the Requests window select a status and then select Go.

To view specific request details, select Details.

o © Db

You can view the following information in the Request Details window:
= Summary

= Parameters

= Notifications

= Printing

s Diagnostics
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Requests
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2

Setup

This chapter describes setup procedures and implementation considerations for
Oracle Collaborative Planning. The following topics are addressed:

Overview of Setup on page 2-2

Deployment Configurations on page 2-2

Setup with Oracle e-Business Suite on page 2-4
Standalone Setup on page 2-21

Loading and Publishing Data on page 2-30
Run Data Collections on page 2-35

Orders on page 2-36

Order Types on page 2-38

Assign Planner Codes to Items on page 2-41

Security Rules on page 2-42
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Overview of Setup

Overview of Setup

Your implementation of Oracle Collaborative Planning depends on the
application(s) you integrate with. Depending on the system, if any, you integrate
Oracle Collaborative Planning with, you load data using different methods.
Consider whether the following apply to your implementation:

= Implementation with Oracle e-Business Suite

= Implementation with Oracle Advanced Planning and Scheduling
= Implementation with Legacy systems

= Standalone setup

The following table depicts the setup steps necessary to implement Oracle
Collaborative Planning, depending on your implementation type.

Oracle e-Business Suite or Oracle

Step Advanced Planning and Scheduling Standalone Setup
Set up Profile Options Required Required
Define customers, suppliers, Required Required

and sites

Define users and assign Required Required
responsibilities

Set up calendars Required Required

Set up items and other Required Required
entities

Set up Oracle iSupplier Optional Not applicable
portal

Deployment Configurations

Begin your setup process by deciding on your deployment hardware configuration.
Oracle Collaborative Planning supports one, two and three machine
implementations. These different deployment configurations enable planning
calculations to be performed on different machines than the machine that performs
transactions. This results in better system response.

The following are types of deployment configurations:

= Single Machine Implementation on page 2-3
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Deployment Configurations

= Two Machine Implementation on page 2-3

s Three Machine Implementation on page 2-3

Single Machine Implementation

For small implementations, source and destination can reside on the same machine
and in the same instance. The following image illustrates this configuration:

Concurrent Manager
Staging
ERP |4 »| Tables

Oracle Advanced Supply
Chain Planning/Qracle
Collaborative Planning

Two Machine Implementation

For larger implementations various instances can be deployed on separate
machines. The following image depicts a two machine implementation:

Concurrent Manager
Staging
ERP «+—p» | Tables

Oracle Advanced Supply
Chain Planning/Oracle
Collaborative Planning

Three Machine Implementation

A three-machine deployment allows for the manipulation of high-dimensionality,
large-scale demand planning data to occur on a machine separate from the planning
calculations done on the planning server. The following image depicts this type of
implementation:
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Setup with Oracle e-Business Suite

ERE ' Concurrent Manager

Staging
Tables

Oracle Advanced Supply
Chain Planning/Qracle

L egacy I Collaborative Planning

For all deployment configurations, a collection process brings data from the source
to the destination instance.

Setup with Oracle e-Business Suite

The setup for a deployment with the Oracle e-Business Suite or with Oracle
Advanced Planning and Scheduling requires the same steps.

1.

2
3
4.
5
6

Set up Profile Options on page 2-5

Define Customers, Suppliers, and Sites on page 2-7
Define Users and Assign Responsibilities on page 2-8
Set Up Calendar on page 2-16

Set Up Items on page 2-19

Setup Oracle iSupplier Portal on page 2-20

When you deploy Oracle Collaborative Planning with Oracle Advanced Supply
Chain Planning, or as part of the Oracle e-Business Suite:

Key entities are set up in source ERP instances

Oracle Advanced Planning and Scheduling collection programs are used to
enable setups in Oracle Collaborative Planning

Supplies and demands in the source instance are collected to Oracle
Collaborative Planning

Trading partner supplies and demands are uploaded using flat files
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Setup with Oracle e-Business Suite

Set up Profile Options

Set profile options to correctly use Oracle Collaborative Planning in your business.
For example, if you configure Oracle Collaborative Planning with Oracle iSupplier
Portal, you must set the MSC: Configuration profile option to include Oracle
Collaborative Planning and Oracle iSupplier Portal.

Complete the following steps to set up profile options:
1. Log in under the System Administrator responsibility.

2. Navigate to Profile > System. The following image depicts this navigational
path:

Functions | iBBEURERiS|

Profile:System

Update system profile options

+ Security Top Ten List

+ Concurrent 1. View All Concurrent Requests (&
- Profile
System
Personal ﬂ
+ Application
Install
Requests
Running Jobs
+ Workflow
Oracle Support

Lot [*ll) 0]+
1

[ | »

3. In the Find System Profile Values window, select Application. The following
image depicts the Find System Profile Values window:
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Setup with Oracle e-Business Suite

EEFind System Profile Values

Display

v Site

v Application Oracle Advanced Supply Chain Planning
Responsibility

User
« Profiles with Mo Yalues

Prafile |MSCY%|

4. Search and select Oracle Advanced Supply Chain Planning in the Application
field.

5. In the Profile field, enter MSC% and select Find.

6. On the System Profile Values window, set the necessary profile options. The
following table lists the profile options, their necessary values, and profile
option descriptions.

Profile Option Value Description

MSC: Configuration: APS & CP Indicates that the APS data model is
activated.

MSC: Operator Company  Your company Name issued by the company deploying

Name name Oracle Collaborative Planning.

MSC: Vertical View Default Yes Ensures that the vertical view displays a

Query default set of results.

MSC: VMI Default Query Yes Ensures that the VMI screen displays a

default set of results.
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Setup with Oracle e-Business Suite

Note: If Oracle Collaborative Planning and Oracle Advanced
Supply Chain Planning are installed on a different server than the
rest of your Oracle ERP applications, you must set two additional
profile options:

FND: Debug Log Enables = Blank or No
ICX: Session Timeout = Blank

The following image depicts the System Profile Values window:

Application Respaonsibility User
Profile Site |0racle Advanced { | |
.||I'I.I'ISC: Calculate Daily Average ,E |—| =
' IMSC: Configuration | APS 8 CP
. |I'I.I'ISC : Operator Company Nam|| |My Company

' [MSC: 64-bit Planner Platform | |
' [MSC: ATP Allocation Method  [Demand Priority |
' [MSC: ATP Debug Mode None |
. |I'H'ISC: Aggregate Resource Nam|2 |
|
|
|

' [MSC: Apply Lot Modifiers in We|
|I'H'ISC: Choice of item for which '|Fulluw item attribu

. |I'H'ISC: Class Hierarchy |Demand Class

7. Save your work.

For more information about the profile options used in Oracle Collaborative
Planning, refer to Profile Options on page A-2.

Define Customers, Suppliers, and Sites

Create customers, suppliers, and in the source instance, then collect them to Oracle
Collaborative Planning. After you set up your information in an Oracle ERP system,
the data is collected into Oracle Advanced Supply Chain Planning and Oracle
Collaborative Planning.
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Setup with Oracle e-Business Suite

Define Customers and Customer Sites

Customers are defined in Oracle Order Management, using the Customers —
Standard window. When defining a customer, enter the customer site in the location
column. After defining your customers, run a targeted trading partners data
collection to collect new customers into Oracle Collaborative Planning.

For more information about defining customers, refer to the Oracle Order
Management Implementation Suite.

Define Suppliers and Supplier Sites

Suppliers are defined in Oracle Purchasing using the Supply Base - Suppliers
window. When defining a supplier, enter the supplier site in the location column.
After defining your suppliers and their sites, run a targeted trading partners data
collection to collect new suppliers into Oracle Collaborative Planning.

For more information about defining suppliers, refer to the Oracle Payables User
Guide.

Define Users and Assign Responsibilities

The system administrator of the Oracle ERP system sets up new accounts for users.
You must specify the contact persons when defining customers in Oracle Order
Management or suppliers in Oracle Purchasing. After specifying the contact
persons the system administrator defines the user. Provide the following
information:

s Username
s Contact Person

»  Description

Define Users

You can define users that belong to your company, your supplier’s company, or
your customer’s company. You must set up supplier users as contacts for supplier
sites before they can be registered as users. Customer users must be setup as
contacts for customer sites before they can be registered as users. After establishing
the users in the Oracle ERP system, run a targeted user company association data
collection to collect new users. Select the option to create and enable user company
association.
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Setup with Oracle e-Business Suite

Using the System Administrator responsibility, in an Oracle application,
navigate to Security > User > Define. The following image depicts this
navigational path:

Functions I_
Security:User:Define
Define application user
. Security A Top Ten List
- lser 1. View All Concurrent Requests (S
e
onitor
ﬂ + Responsihility ﬂ
+ ORACLE -
& + AuditTrail
j Web PL/SOL hs
ﬂ + Concurrent
ﬂ + Profile
=/|+ Application
+ Install
+ Requests
Running Jobs =
+ Workflow - O [ "
( Qpen )

2, In the Users window, enter the username you created in the source instance and
assign the user the Supply Chain Collaboration Planner responsibility. The
following image depicts the Users window:
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User Mame Person |
Diescription | | Customer |
Supplier |

Password | E-Iail |

Password Explration Fax |
© Days [ Effective Dates
 Accesses [ From |I]3-.lﬂN.2IIIB
= plone Ta

Responsibilities

. Effective Dates
Secuwrily

Responsibility ~ Application  Group From T

I [ | I
| [
| |
| |

3. A user must be a member of your company or a member of an established
customer or supplier in the Oracle ERP system. Customers are maintained in
the Oracle Order Management system. You must have certain responsibilities to
create a new user. To establish a customer user in Oracle Collaborative
Planning, you must complete the following in the Oracle ERP system:

a. In Oracle Order Management, navigate to Order Management > Customer
> Summary. The following image depicts this navigational path:
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Order Management:Customers:Summary

Maintain Customers in Summary

|»

- Order Management
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+ Shipping
- Customers
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Quick
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Setup
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b. In the Customers - Summary window, search for a customer and select
Open. The following image depicts the Customers - Summary window:

Cugtormer Type Customer Marme

Prefin First Mame
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.l Parson
|

|l
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|

Relationships
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c. Inthe Customers window, enter a customer name and contact person. The
following image depicts the Customers window:

Customer Type :Psrsnn v| I Active Person Number |
Frefix [Mr. | First Marne [ Customer Nurmber |
Mididle Mame 7 Tax Regisiration Hum
Last Name [Smith Sufliz | Taupayer |0 |
Alemate Name | Accaunt Name | 1
[Aithesses) (Ciasfication (Grderianagement | (Warkeiing| (Telephones| Contacts - Telepnones | (Goiacta  Fales
Contact Name Number Job Refarence Active
Last First Title hlail Stop Ernail 11
| R e I __________________________________________ I ______________ R [
I I I I 5
Contact Telephones
Couniry Code
_] Area Code  Telephone Mumber _ Extension Type _ Primary  Active [ ]
] [ [ [ @ [ 1=
' I ' [
I B o [

d. Save your work.

e. Change the responsibility to System Administrator and navigate to Security
> User > Define.

f. In the Users window enter a user name, description, and contact person.
Supplier information is maintained in Oracle Purchasing.

To establish a supplier user in Oracle Collaborative Planning, enter the
following in your source instance:

a. In the Oracle Purchasing system, navigate to Purchasing > Supply Base >
Suppliers. The following image depicts this navigational path:
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Purchasing:Supply Base:Suppliers

Suppliers
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b. In the Suppliers window, search for Supplier Name and select Sites. The
following image depicts the Suppliers window:

Supplier flame |Office Supplies Supplier Mumber
Alternate Mame ]
Taxpayer D Tax Registration Mumber
Inactive Cn [[_ ]
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C.

In the Supplier Sites window, select the Contact tab and enter information
for a contact per
window:

son. The following image depicts the Supplier Sites

Sile Mame T - Alternate Mame [ .
Country |United States
Address | Alternate
| Address
|
City State Pastal Code
Province County
Language Inactive On [|— |
(General Cerfacts Accounting Control Payment Bank Ascounts EDI Inice Tax Wittheldng Tax
Name Prefix .
Mail
Last First I Title Telephone Stop Inactive On
| | (L ] \ \ 4
| | (L] ] \ \
| | (L L] \ \
\ | (L | L \ \ <
Alternate Contact Mame |
d. Save your work.
e. Switch to the System Administrator responsibility and navigate to Security
> User > Define.
f.  On the Users window, enter a user name, description, and assign the
Supply Chain Collaboration Planner responsibility.
9. Search and select a contact name. Oracle Collaborative Planning links the
contact supplier information to the new user.
4. If your implementation of Oracle Collaborative Planning exists on a separate

machine from the Oracle ERP system, then customer or supplier users must be
established in the Oracle Collaborative Planning system.

To establish a customer or supplier user in Oracle Collaborative Planning, you
must complete the following steps:

a. Define a new user by navigating to Security > User > Define. The System

Administrator creates new accounts.
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In the Users window, enter the same username you created in the Oracle
ERP system and assign the Supply Chain Collaboration Planner
responsibility.

Run a targeted data collection to collect company user association from the
Oracle ERP system into the Oracle Collaborative Planning system. Set the
flag on the Company User Association parameter to enable user company
association. For more information on running data collections, refer to Run
Data Collections on page 2-35.

Maintain the company site information in the Oracle ERP system and
collect data to Oracle Collaborative Planning.

Customers and suppliers can post their supplies and demands into the
Oracle Collaborative Planning system.

To create users and enable user company association:

a.

Switch to the Advanced Supply Chain Planner responsibility. Navigate to
Collections > Oracle Systems > Data Collection.

In the Planning Data Collections window, select the Parameters field.
In the Parameters window, complete the following fields:

Instance

Purge Previously Collected Data = No

Collection Method = Target Refresh

User Company Association = Create Users and Enable User Company
Association

Select OK.

Start data collections. After successfully collecting data to the Oracle
Collaborative Planning system, new users can log into Oracle Collaborative
Planning and view or create new transactions. For more information on
running data collections, Run Data Collections on page 2-35.

Assign Responsibilities

Reserve the Supply Chain Collaboration Administrator responsibility for a system
administrator who has responsibility for the whole deployment. The following table
lists the different types of users, which responsibilities you can assign to them, and
the responsibility description:
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Company Supplier Customer

Responsibility Users Users Users Responsibility Description

Supply Chain Yes Yes Yes Provides users access to planner

Collaboration tasks.

Planner

Supply Chain Yes Yes Yes Provides users access to planner

Collaboration and administrative tasks.

Manager

Supply Chain Yes No No Provides users access to planner

Collaboration and administrative tasks. The user

Administrator can create security rules that
apply to supplies and demands
posted by all companies.

Set Up Calendar

The calendar in Oracle Collaborative Planning is a 7-0 calendar, where all days are
workdays, the week begins on Monday, and the month begins on the first day of the
calendar month. Set up the calendar for Oracle Collaborative Planning by running
the concurrent program Build Collaborative Planning Calendar.

Complete the following steps to set up the calendar in Oracle Collaborative

Planning.

1. Log in using the Advanced Supply Chain Planner responsibility.

2. Navigate to Other > Request. The following image depicts this navigational

path:
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d

Functions I_

Other:Request
View All Concurrent Requests
Workflow Notifications Top Ten List
+ Supply Chain Plan 1. Change Instance/Organization
ﬂ + Collections 2. SCP Workbench
+ Sourcing 3. Define SCP Options
ﬂ + ATP ﬂ 4. Define Sourcing Rules - MSC
+ Setup 5. Define Bills of Distribution - MS(
E - Other - 6. Sourcing Assignments - MSC
7. Collection Workbench
ﬂ Profile 8. Planning Data Collection
ﬂ Change Instance/Organization
=/|+ Reports
View Work Dates
Al e [N

3. In the Find Requests window, select Submit a New Request. The following
image depicts the Find Requests window:

EEZFind Requests -0

“ My Completed Requests
My Requests In Progress
3 -

~ Specific Reguests

Request ID

Mame |
Date Submitted
Date Completed
Status |
FPhase |

Requestor

v Include Reguest Set Stages in Query
Crder By | Reqguest ID T|

Submit a MNew Request... ) Clear | Find
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4. On the Submit a New Request window, select Single Request and select OK.
The following image depicts the Submit a New Request window:

What type of request do you want to run?

This allows you to submit an individual request.

' Request Set

This allows you to submit a pre-defined set of
requests.

QK Cancel /I

5. In the Submit Request window select Build Collaborative Planning Calendar.
The following image depicts the Submit Request window:

Run this Request...
Copy...
WETEMIBuild Collahorative Planning Calenda |—
Parameters ‘
Language ‘American English
Languages...
At these Times...
‘As Soon as Possible Schedule...
Upon Completion...
v Save all Output Files
Natify ‘ Options..
Frint to ‘nuprinl
Help (B) Submit Cancel |

6. In the Parameters window, select OK. The following image depicts the
Parameters window:
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Calendar code CP-Mun-?I]

A T o

Qk | Qancel) Clearjl Help )I

7. In the Submit Request window, select Submit.

Set Up ltems

If you deploy Oracle Collaborative Planning with the Oracle e-Business Suite, you
create items in the Oracle ERP system and collect them into the Oracle Collaborative
Planning system.

Items are created in Oracle Inventory. Run an items data collection to receive items
into Oracle Collaborative Planning. You must run a data collection to collect any
new items that may be part of your collaboration with your customers and
suppliers.

Complete the following steps to set up items:
1. Log in using the Manufacturing and Distribution Manager responsibility.

2. In the Manufacturing and Distribution Manager window, navigate to Inventory
> [tems > Master Items.

3. In the Master Item window, enter your item information. For more information
about item setup, refer to the Oracle Inventory User’s Guide. The following image
depicts the Master Item window:
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4. Save your work.

5. Run a data collection to load the items into Oracle Advanced Supply Chain
Planning and Oracle Collaborative Planning. For more information on running
data collections, refer to Run Data Collections on page 2-35.

Setup Oracle iSupplier Portal

When you deploy Oracle iSupplier Portal and Oracle Collaborative Planning
together, your supplier users can access both applications through a combined
portal. This is accomplished by assigning supplier users the Supplier Collaboration
Full Access responsibility. After creating Supplier Collaboration responsibility, you
can then access a combined home page that features the functionality of both Oracle
iSupplier Portal and Oracle Collaborative Planning.

To setup Oracle iSupplier Portal and Oracle Collaborative Planning together, you
must install Oracle Collaborative Planning on the same instance as your Oracle ERP
system. You must have the System Administrator responsibility to assign
responsibility to users.

Complete the following steps to set up users for access to Oracle iSupplier Portal
and Oracle Collaborative Planning:

1. Log in under the Supplier User Management responsibility.
2. Navigate to supplier User Management > Register Supplier User.
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3. Provide registration details.

4, Save your work.

OEM User Setup

An OEM user is a member of your company that uses Oracle Collaborative
Planning. This person will have access to your company data. Complete the
following steps to create this type of user.

1. Log in under the System Administrator responsibility.
2. Navigate to Security > Users > Define.

3. Enter a username and assign the Supply Chain Collaboration Planner
responsibility. If the user already exists, add the Supply Chain Collaboration
Planner responsibility to the user and save your changes. If your
implementation of Oracle Collaborative Planning exists on a separate machine
from your Oracle ERP system, then you must create the user in the Oracle ERP
system first.

4. Switch responsibilities to Advanced Supply Chain Planner > Collections >
Oracle Systems > Data Collection

5. To perform a targeted collection, set the parameter value Purge Previously
Collected Data to No. Set all other values to No. Set the value for the User
Company Association parameter to Enable User Company Association.

6. Select Submit.

Standalone Setup

The following platforms are available for a standalone setup of Oracle Collaborative
Planning:

= Standalone collaboration platform
s Collaboration platform with legacy systems

If you are performing a standalone setup of Oracle Collaborative Planning, you
must load all of your data through flat file loads. You can bulk load the following;:

= Calendar information
= Calendar Exception Information

s Category Sets
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Company Users
Customer Items
Item Categories
Items

Planners

Shift Exceptions
Shift Times

Supplier Items
Supply/Demand Information
Trading Partners
Trading Partner Sites
Unit of Measure

Workday Patterns

To view specific information about each spreadsheet type, review the Readme
document contained in OATemplate.zip. You must load calendar information before
loading supply/demand information; specific dates, such as receipt dates, are used
in supply and demand transactions. You must load items and trading partners
before proceeding with customer items and supplier items.

To perform a standalone setup of Oracle Collaborative Planning, complete the
following steps:

1.

o g & 0D

Set Up the Legacy Instance on page 2-23

Set Up Profile Options on page 2-23

Define Customers, Suppliers, and Sites on page 2-26
Define Users and Assign Responsibilities on page 2-26
Set Up Calendar on page 2-27

Set Up Items and Other Entities on page 2-30
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Set Up the Legacy Instance

To set up Oracle Collaborative Planning as a standalone product, you must first set
up the legacy instance and then load planning organizations, customers, and
suppliers.

Complete the following steps to set up the legacy instance:

1.

N o a Db

Apply the legacy integration patch on the concurrent manager node on which
you installed Oracle Collaborative Planning. If you have multiple concurrent
manager nodes that are not NFS mounted, you must apply this patch on all the
nodes. The patch copies all the control files to the

$MSC_TOP /patch/115/import directory. You must enter the complete path of
this directory as a value for the Control Files Directory parameter of the flat file
load stage when you run the legacy system data collection.

Use steps 2 through 6 to create a partition for a new instance.

Log in using the System Administrator responsibility.

Select Requests > Run.

Select Single Request and select OK.

In the Name field, enter Create APS Partitions and select OK.

Enter the number of plan partitions and instance partitions and select OK.

Change to the Advanced Planning Administrator responsibility. Select Admin >
Instances.

Specify the Instance Code for the Legacy Instance and set the Instance Type as
Other. Leave the fields From Source to APS and From APS To Source blank. Fill
the other fields for the instance as specified in the on-line help.

You can now use the batch load solution. Upload the Calendar data for this
instance.

Note: The batch upload and legacy instance setup steps can occur
parallel to script for data upload creation. The instance code is
required to retrieving data files from the scripts.

Set Up Profile Options

Profile options setup for a standalone implementation is the same as for an
integrated implementation.
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Complete the following steps to set up profile options:
1. Log in under the System Administrator responsibility.

2. Navigate to Profile > System. The following image depicts this navigational
path:

Functions | iBBEURERiS|

Profile:System

Update system profile options

+ Security Top Ten List

+ Concurrent 1. View All Concurrent Requests (&
- Profile

System
Personal ﬂ
+ Application
Install
Requests
Running Jobs
+ Workflow
Oracle Support

Lot [*ll) 0]+
1

[ | »

3. In the Find System Profile Values window, select Application. The following
image depicts the Find System Profile Values window:
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Display
v Site

v Application Oracle Advanced Supply Chain Planning
Responsibility
User

W Profiles with Mo Yalues

Profile |MSCY%|

4. Search and select Oracle Advanced Supply Chain Planning in the Application
field.

5. In the Profile field, enter MSC% and select Find.

6. On the System Profile Values window, set the necessary profile options. The
following table lists the profile options, their necessary values, and profile
option descriptions.

Profile Option Value Description

MSC: Configuration: CP Indicates that collection programs are
used.

MSC: Operator Company  Your company Name issued by the company deploying

Name name Oracle Collaborative Planning.

MSC: Vertical View Default Yes Ensures that the vertical view displays a

Query default set of results.

MSC: VMI Default Query  Yes Ensures that the VMI screen displays a

default set of results.

The following image depicts the System Profile Values window:
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Application Respaonsibility Uszer
Profile Site Oracle Advanced !
l MSC : Calculate Daily Average m =
MSC : Configuration APS & CP
MSC : Operator Company Nami My Company

MSC: 64-hit Planner Platform

MSC: ATP Allocation Method  Demand Priority
MSC: ATP Debug Mode None

MSC: Aggregate Resource Nam 2

MSC: Apply Lot Modifiers in We

MSC: Choice of item for which - Follow itermn attribu

MSC: Class Hierarchy Demand Class -

7. Save your work.

For more information about the profile options used in Oracle Collaborative
Planning, refer to Profile Options on page A-2.

Define Customers, Suppliers, and Sites

For a standalone setup of Oracle Collaborative Planning, customers, suppliers, and
sites must be loaded using flat files. Use the flat file tradingpartner.dat to load
customers, and tradingpartnersite.dat to load customer sites. Use the flat file
tradingpartner.dat to load suppliers, and tradingpartnersite.dat to load supplier sites.
When defining sites, upload tradingpartner.dat and tradingpartnersite.dat in a single
zip file.

For more information about uploading data into Oracle Collaborative Planning
refer to Loading and Publishing Data on page 2-30.

Define Users and Assign Responsibilities

For a standalone setup of Oracle Collaborative Planning, define users and assign
responsibilities through flat file loads.
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Define Users

Upload the partnercontact.dat flat file to define contacts for trading partner sites. To
set up users, you must provide the following information:

s Username
= Customer or supplier information

For more information about uploading data into Oracle Collaborative Planning,
refer to Loading and Publishing Data on page 2-30.

Assign Responsibilities
You can assign the following responsibilities for a standalone setup:

= Supply Chain Collaboration Planner
= Supply Chain Collaboration Manager

The Supply Chain Collaboration Planner responsibility provides users with access
to planner tasks. The Supply Chain Collaboration Manager responsibility provides
users with access to planner and administrative tasks.

Set Up Calendar

The calendar in Oracle Collaborative Planning is a 7-0 calendar, where all days are
workdays, the week begins on Monday, and the month begins on the first day of the
calendar month. Set up the calendar for Oracle Collaborative Planning by running
the concurrent program Build Collaborative Planning Calendar.

Complete the following steps to set up the calendar in Oracle Collaborative
Planning.

1. Log in using the Advanced Supply Chain Planner responsibility.

2. Navigate to Other > Request. The following image depicts this navigational
path:
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Other:Request

View All Concurrent Requests

Workflow Notifications Top Ten List
+ Supply Chain Plan 1. Change Instance/Organization
ﬂ + Collections 2. SCP Workbench
+ Sourcing 3. Define SCP Options
ﬂ + ATP ﬂ 4. Define Sourcing Rules - MSC
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3. In the Find Requests window, select Submit a New Request. The following
image depicts the Find Requests window:

EEFind Reguests

~ My Completed Reguests

My Requests In Brogress

~ Specific Reguests
Request ID

Mame
Date Submitted
Date Completed
Status
Phase |

Requestar

v Include Reguest Set Stages in Query
Order By |Reguest ID T|

Submit a few Request... ) Clear | Find
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4. Inthe Submit a New Request window, select Single Request and select OK. The
following image depicts the Submit a New Request window:

" Thie allows y’D“L-I.tD submit an individual request.
' Request Set
This allows you to submit a pre-defined set of

regquests.

QK Cancel )I

5. In the Submit Request window select Build Collaborative Planning Calendar.
The following image depicts the Submit Request window:

Copy...
Pararneters |
Language |American English
Languages...
At these Times...
|As Soon as Possible Schedule. .
Upon Completion...
v Save all Cutput Files
Natify | Options...

Print to |noprint

Help (B) Submit | Cancel J
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6. In the Parameters window, select OK. The following image depicts the
Parameters window:

Calendar code |[Sg LTI

4 »

Cancel Clear Help

7. In the Submit Request window, select Submit.

Set Up Items and Other Entities

For a standalone setup of Oracle Collaborative Planning, defining items and other
entities is achieved using flat file loads. Upload the item.dat flat file to set up your
items. Upload the supplieritems.dat flat file to cross-reference a supplier item with
one of your items. Upload the customeritems.dat flat file to cross-reference a
customer item with one of your items.

For more information about uploading flat files, refer to Loading and Publishing
Data on page 2-30.

Loading and Publishing Data

You can load all of your setup data into the system if you are not using Oracle
Advanced Supply Chain Planning. If you are using Advanced Supply Chain
Planning in conjunction with Oracle Collaborative Planning, set up the majority of
your information in the system. You can, however, add files using flat file loads. You
can bulk load the following into the Oracle Collaborative Planning:

= Calendar Information

= Calendar Exception Information
n  Category Sets

s Company Users

s Customer Items

»  Item Categories
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s Jtems

= Planners

= Shift Exceptions

= Shift Times

= Supplier Items

= Supply/Demand Information
s Trading Partners

s Trading Partner Sites

s Unit of Measure

= Workday Patterns

For all collaborative processes and order types, demand and supply data are
uploaded through a flat file. Download this template in the Admin page of Oracle
Collaborative Planning.

Oracle Collaborative Planning supports flat file data loads for the following
supply/demand order types:

» Historical sales

=  Negotiated capacity
s Order Forecast

s Purchase order

s Supply Commit

s Purchase requisition
= Safety stock

= Sales forecast

= Sales order

= Sell through forecast
s Purchase order acknowledgement

During flat file uploads specify sync indicators to identify whether you are deleting
or inserting records. The following table lists the available sync indicators and their
definitions.
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Sync Indicator Definition

D (Delete) Enables you to delete rows that match the item, publisher,
publisher site, supplier, supplier site, order type, order number,
release number, line number, end order number, or end order
line number.

R (Replace) For a row in the upload file the system searches for all records in
Oracle Collaborative Planning that match the item, publisher,
publisher site, supplier, supplier site (or customer, customer site
for sales orders), order type, order number, release number, line
number, end order number, and end order line number and
delete them. This is done for each row in the uploaded file, at the
end of which the new rows are inserted into Oracle
Collaborative Planning.

To upload flat files into Oracle Collaborative Planning, complete the following
steps:

1. Access the Oracle Collaborative Planning application.
2. Select the Admin tab.

3. On the Admin page, select Load Setup Data link. The following image depicts
the Admin window in Oracle Collaborative Planning.
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4. Download the template.
5. View the Readme document to learn how to fill in the spreadsheet.
6. Complete the spreadsheet.
7. Upload the template on the Load Setup Data page.

Note: You must load trading partners (customers and suppliers)
before loading company users. Trading partners establish
companies, and company users assign specific users to their
companies. All companies in Oracle Collaborative Planning must
have a trading partner relationship with your company.
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Export Data

Oracle Collaborative Planning enables you to export either demand or supply
information. Oracle Collaborative Planning supports export transactions using a
tab-delimited flat file through XML.

Complete the following step to export data from Oracle Collaborative Planning.
1. Access the Oracle Collaborative Planning application.

2. Select the Planning tab.

3. From the Planning window, select Vertical View.

4. Search for and select your specific information (order type, item, customer).
5. Select Export to download a formatted spreadsheet.

For more information about XML transactions in Oracle Collaborative Planning,
refer to Overview of XML on page C-2.

Publish Data Using Oracle Advanced Supply Chain Planning

When Oracle Advanced Supply Chain Planning is installed, you can use with
Oracle Collaborative Planning to publish and receive order information. Generate
supply information using Oracle Advanced Supply Chain Planning prior to
publishing its contents to Oracle Collaborative Planning. Filters enable you to
publish information selectively to your trading partners. You can publish order
forecasts and supply commits, and receive supplier capacities.

Complete the following steps to publish or receive demand and supply information:
1. Log in using the Advanced Planning Administrator role.

2. Select Collaboration.

3. Select one of the following:

= Publish Order Forecast (if you are publishing an order forecast to your
suppliers)

s Publish Supply Commits (if you are publishing a supply commit to your
customers)

= Receive Supplier Capacity (if you are receiving a supplier capacity from your
suppliers)

4. In the Parameters window, complete any of the fields and select OK.
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5.

In the Publish Order Forecast, Publish Supply Commits, or Receive Supplier
Capacity window, enter any additional information.

6. Select Submit.

Publish Data Using Oracle Demand Planning

When Oracle Demand Planning is installed, you can use it with Oracle
Collaborative Planning to publish and receive sales forecasts to and from your
customers. Generate and commit to forecasts using Oracle Demand Planning prior
to publishing its contents to Oracle Collaborative Planning. Filters enable you to
publish information selectively to your customers.

Complete the following steps to publish or receive a sales forecast:

1.
2.
3.

Log in using the Advanced Planning Administrator role.

Select Collaboration.

Select one of the following:

Publish Forecast to Customer (if you are publishing a forecast)
Receive Forecast from Customer (if you are receiving a sales forecast)
In the Parameters window, complete any of the fields and select OK.

In the Publish Forecast to Customer or Receive Forecast from Customer
window, enter any additional information.

Select Submit.

Run Data Collections

To run data collections you must assign yourself the Advanced Supply Chain
Planner responsibility. To run data collections, complete the following steps:

1.

Change responsibilities to Advanced Supply Chain Planner. Navigate to
Collections > Oracle Systems > Data Collections.

On the Planning Data Collections window, select the Parameters field.

On the Parameters window you must enter information in several fields. The
following table identifies these fields and the values you must enter:
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Field Value

Instance Desired instance

Purge Previously Collected Data No

Collection Method Target Refresh

User Company Association Enable User Company

4. Select OK.

5. Start data collections. After the system loads the data to Oracle Collaborative

Planning, the new user can log into Oracle Collaborative Planning and view or
create new transactions.

For more information about running data collections, refer to the Advanced Supply
Chain Planning Implementation and User’s Guide.

Orders

This section discusses orders in Oracle Collaborative Planning. The following topics
are discussed:

Create an Order

Create an Order on page 2-36
Add Orders on page 2-37
View Order History on page 2-37

You can use the following method for posting demand or supply information. This
procedure is additional to uploading files. You edit demand or supply information
manually using the Enter Order Details page.

1.
2.
3.

From the Home page in Oracle Collaborative Planning, select the Planning tab.
Select Create Order.

In the Enter Order Details page, enter information in the following fields:
Orders

Item

Trading partners
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Add Orders

= Dates
= Shipping
s DPegging

s Comments

4. Select Add.

Note: To reference field definitions, select Hint.

In addition to bulk loading order information, you can add an order manually
within the system. You can only update or delete existing transactions by loading
the SupplyDemand.dat flat file. For an order, you can enter the following information:

s Orders

s Item

s Trading partners
s Dates

= Shipping

s Pegging

s Comments

You can access the Enter Order Details page by selecting Create Order from the
Planning tab in Oracle Collaborative Planning.

View Order History

Oracle Collaborative Planning enables you to view versions of an order, make
changes as necessary to current orders, and track those changes. You can make
changes to any planning (for example, sales or order forecasts) or execution (for
example, purchase or sales orders) documents you view in a vertical view. For
example, you might need to know what the previous quantity was for a particular
order. Oracle Collaborative Planning enables you to view that order information
and make any necessary revisions to your order. You changes any of the following
parts of an order:

s Quantity

Setup 2-37



Order Types

= Receipt date (for an execution document only)

= Revision date information (view only)

s Updated by information (view only)

= Comments

Complete the following steps to view an order history:

1. From the Home page of Oracle Collaborative Planning, select the Planning tab.
2.  On the Planning page, select Vertical View.

3. Enter your search criteria and select Search.

4. Choose an order and select View History in that order’s row.

5

On the Auditing Details page, view your order.

Order Types

This section discusses order types used in Oracle Collaborative Planning. The
following topics are discussed:

= Supported Order Types on page 2-38
s Renaming Order Types on page 2-40

Supported Order Types

Oracle Collaborative Planning comes seeded with several different order types. The
following table lists theses order types and their descriptions.

Order Type Description

Sales Forecast Expected future customer shipments. Suppliers can post
expected customer future shipments. Quantity and Comments
can be edited using vertical view.

Order Forecast Anticipated future customer orders for a specific item, period,
and location. Customers post when supplier should ship the
goods. Quantity and Comments can be edited using vertical
view.

Supply Commit Anticipated future supplier shipments to customers. Suppliers
post when customers should receive the goods. Quantity and
Comments can be edited using vertical view.
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Order Type

Description

Historical Sales

Actual customer sales for a specific item, period, and location.
Quantity and Comments can be edited using vertical view.

Sell through Forecast

Same as Sales Forecast. Quantity and Comments can be edited
using vertical view.

Negotiated Capacity

Supplier capability to produce quantities of an item for
particular period and location. Quantity and Comments can be
edited using vertical view.

Safety Stock

Supplier inventory quantity at present time or customer
inventory quantity at the present time. Quantity and Comments
can be edited using vertical view.

Allocated Onhand

Trading partner inventory quantity in stock. Stock is intended
for a specific supplier or customer. Quantity and Comments can
be edited using vertical view.

Unallocated Onhand

Trading partner's inventory quantity physically in stock that can
be designated for any request or order.Quantity and Comments
can be edited using vertical view.

Purchase Order

Customer commitment to procure an item from a supplier.
Customer can post when the supplier should make shipment.
You can edit Quantity, Requested Ship Date, Requested Receipt
Date, Original Promise Date, and Comments fields using vertical
view.

Purchase Order
Acknowledgment

Supplier's acceptance of the customer's purchase order. Also
supplier can post when the customer should receive the goods.
You can edit Quantity, Ship Date, Receipt Date, and Comments
fields using vertical view.

Purchase Requisition

Customer intent to procure an item from the supplier. If
purchase request is for a VMI item, the system submits the
requisition to an Oracle Purchasing requisition import manager.
You can edit Quantity, Requested Ship Date, Requested Receipt
Date, Original Promise Date, and Comments fields using vertical
view.

Replenishment Order Used for an order created through by either the customer or
supplier VMI to replenish a VMI item. A replenishment order
does not appear in the list of values on the manual order entry
page.

Sales Order Supplier response to the customer purchase order. The supplier

can post when the customer can expect to receive the goods. You
can edit Quantity, Ship Date - Promised, Receipt Date -
Promised, Requested, and Comments fields using vertical view.
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Order Type Description
ASN (Advanced Supplier posts when a shipment is coming for the customer.
Shipment Notice) Also supplier can post when the customer should expect the

goods. You can edit the Quantity, Ship Date - Actual, Receipt
Date - Planned, and Comments fields using vertical view.

Shipment Receipt Customer's physical acceptance of a shipment. You can edit the
Quantity, Delivery Date, and Comments fields in the vertical
view.

Work Order Your suppliers can provide you with visibility into their work in

process inventory. Suppliers can upload supplies of order type
Work Order and provide quantity, order number, start date, and
completion dates.

Purchase Order From Represents purchase orders that exist in the plan as of the

Plan publish process, with receipt date as displayed date. Order type
published through the Publish Order Forecast program.
Published whenever the program runs. Available for selection in
the horizontal view preference set. Available for search using
vertical view and horizontal view. Not part of the system default
preference set.

Released Planned Order Represents planned orders released in the Oracle Advanced
Supply Chain Planning plan as of the time of publishing.
Published only through the Publish Order Forecast program. Is
published anytime the program runs. Displays receipt date.
Cannot be uploaded manually through Ul or through flat file
loads. Is not included in the planned order quantity. Available
for selection in the horizontal view preference set. Available for
search using vertical view and horizontal view. Not part of the
system default preference set.

Planned Order Represents planned orders in Oracle Advanced Supply Chain
Planning as of publishing time. Published only through the
Publish Order Forecast program. Is published anytime the
program runs. Displays receipt date. Cannot be uploaded
manually through UI or through flat file loads. Is not included in
the planned order quantity. Available for selection in the
horizontal view preference set. Available for search using
vertical view and horizontal view. Not part of the system default
preference set.

Renaming Order Types

System Administrators can rename any seeded order type. This is completed at the
time of implementation. After an order type is renamed, all users within the system
see the renamed order type. Users can load renamed order types and view the data
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through the Planning and Exceptions tabs. If any data was entered using an old
order type, that data is displayed with the new order type. You can load data for a
renamed order type using any of the current loading methods.

Note: To rename an order type you must have the Advanced
Planning System Administrator responsibility assigned to your
username.

Complete the following steps to rename an order type:

1. Access the Oracle Applications System.

2. Login under the Advanced Planning Administrator responsibility.
3. In the Oracle Applications window, select Admin, then Lookups.
4

In the Oracle Manufacturing Lookups window, place your cursor on the Type
field and select the search icon.

In the Lookup Types search window, select MSC_X_ORDER_TYPE. Select OK.

a

6. In the Oracle Manufacturing Lookups window, you see the order types and
their descriptions. Select the order type you wish to change and edit the value
in the meaning column.

7. Save your changes.

You can return to Oracle Collaborative Planning and view the renamed order type.
You must now use the order type’s new name to load transactional data or create
orders.

Assign Planner Codes to ltems

Exception notifications are sent to the individuals who have been identified as
planners for a give item in an exception. The supplier or customer contact is also
notified. To assign planners to items, first create a planner in the organization. Next,
assign the planner to the item. You can set up planners in an organization as
follows:

1. Using the Manufacturing & Distribution responsibility, navigate to Inventory.
2. Navigate to Setup > Planners.

3. Select the organization in which your item exists.
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4. Create and save a planner code.

5. Save your work.

Complete the following steps to assign planners to items:

1. Using the Manufacturing & Distribution responsibility, navigate to Inventory.
Navigate to Items > Organization Items.

Query your item.

Navigate to the General Planning tab.

Assign a planner in the Planner field.

o g k& 0 b

Save your work.

Security Rules

You can define security rules to grant access of data to other trading partners. You
can create, edit, and view security rules. A security rule has three components:

= Objects that identify the set of transactions on which the security rule applies
= Grantee to whom the access is given by the security rule

= Scope in which the security rule is applicable

Create Security Rules

You can create security rules related to transactions owned by your company.
Administrators can create any security rules within the scope of their company.

Complete the following steps to create security rules:
1. Log in to Oracle Collaborative Planning.

2. Select the Admin tab.The following image depicts the Admin tab in Oracle
Collaborative Planning:
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3. From the Admin tab, select View /Define Security Rules. The following image
depicts the View Security Rules window in Oracle Collaborative Planning:
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4. Select Create New Rule.

5. Enter the required information in the Add Security Rule window. The following
fields are required:

s Access Given By

s Privilege

s Access Given To

= Assigned To

The following image depicts the Add Security Rule window:
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6. Select Submit.

Edit Security Rules

You can edit security rules as transactions change with your trading partners. You
can edit only those rules for which you have authority. You can enable or disable
any of the security rules by editing the effective From Date and the Effective To
Date. Administrators can edit all security rules.

Complete the following steps to edit security rules:

1. Select View/Define Security Rules from the Admin window.
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2. Enter your search criteria and select Search.
3. Select a security rule you want to edit and select Edit.

4. On the Edit Security Rule window, complete or update the required fields and
select Submit. The following fields are required:

= Access Given By
s Privilege

m  Access Given To
= Assigned To

5. Select Submit.

Edit Effective Dates
Complete the following steps to edit effective dates:

1. Select View /Define Security Rules in the Admin window.

2. Enter your search criteria and select Search.

3. Select the security rule you want to edit and edit the following fields:
= Effective From Date

= Effective To Date

4. Select Apply Changes.

View Security Rules

You can view security rules to monitor existing rules within the scope of your
company. Administrators can view all security rules.

Complete the following steps to view security rules:
1. Select View /Define Security Rules in the Admin window.
2. Enter your search criteria and select Search.

3. Review your security rule(s) in the View Security Rules section.
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Forecasting

This chapter discusses collaboration and forecasting. The following topics are
addressed:

Overview of Forecasting on page 3-2
The Collaboration Cycle on page 3-4
Forecast Versioning on page 3-5
Collaborate with Customers on page 3-6

Collaborate with Suppliers on page 3-9
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Overview of Forecasting

There are two types of collaborative business processes associated with forecasting:
sales forecast collaboration and order forecast collaboration. Sales forecast
collaboration is prevalent in the consumer goods industries, where promotions by
both retailers and manufacturers influence consumer demand. The purpose of sales
forecast collaboration is to come to a consensus on what end-consumer demand will
be. Order forecast collaboration is more universal. Order forecast collaboration
occurs when the customer provides a forecast of demand, and the supplier provides
its supply commitment indicating its ability to meet that demand.

Customers and suppliers collaborate as trading partners and can post their
statements of demand and supply in Oracle Collaborative Planning. This enables
them to communicate their needs. A customer can post its order forecast to a
supplier who can, in turn, respond with a supply commitment to meet the forecast.
When discrepancies occur between supply and demand, Oracle Collaborative
Planning computes exceptions and sends notifications identifying issues and
expediting resolutions. Oracle Collaborative planning works across trading partners
to provide an efficient means to communicate requirements and changes in
requirements to resolve issues across the extended supply chain. Better
collaboration results in fewer disruptions in the supply chain.

In sales forecast collaboration you exchange a sales forecast with your customers for
demand planning purposes. By using Oracle Demand Planning in conjunction with
Oracle Collaborative Planning, you can receive and publish sales forecasts using the
Receive Forecast From Customer and Publish Forecast to Customer programs.

Program Order Type Capability

Receive Forecast Sales Forecast Receive a sales forecast from Oracle

From Customer Collaborative Planning into Oracle Demand
Planning as a custom data stream.

Publish Forecastto  Sales Forecast Publish the result of a demand plan as a sales

Customer forecast from Oracle Demand Planning into

Oracle Collaborative Planning.

In order forecast collaboration, you collaborate with both your customers and
suppliers for demand and supply planning purposes. Using Oracle Demand
Planning and Oracle Advanced Supply Chain Planning in conjunction with Oracle
Collaborative Planning, you can:

= Receive an order forecast from your customer and respond with a supply
commit
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s Publish an order forecast to your suppliers and receive their supply commits as
supplier capacity for supply chain planning

Program Order Type Capability
Receive Forecast Order Forecast Receive an order forecast posted by your
From Customer customer from Oracle Collaborative Planning

into Oracle Demand Planning as a custom
data stream.

Publish Forecastto ~ Order Forecast Publish the result of a supply chain plan as an

Customer order forecast from Oracle Advanced Supply
Chain Planning to Oracle Collaborative
Planning.

Receive Supplier Supply Commit Receive supply commits posted by your

Capacity suppliers from Oracle Collaborative Planning
into Oracle Advanced Supply Chain
Planning,.

Publish Supply Supply Commit Respond to your customer's order forecast

Commit with a supply commit from Oracle Advanced

Supply Chain Planning to Oracle
Collaborative Planning.

To access the programs listed you must have the Advanced Planning Administrator
responsibility. You can select the appropriate program from the Collaboration menu
option of the Advanced Planning Administrator responsibility.

Using Oracle Collaborative Planning, you can view your supplies or demands in
several ways. The following table outlines how you can view your supply and
demand:

Viewing Capability Description

Horizontal View When you view your plan horizontally, the system
assembles your plan data over a period of time. You can
also graph your information.

Vertical View When you view your plan vertically, you filter your search
criteria to view plan data. You can view information for an order
type, due date, or quantity.

Custom View You can set up a custom view that suits your business needs.
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Viewing Capability Description
Vendor Managed You can view inventory quantities that your supplier is
Inventory responsible for. You can also view current in-transit shipment

information. With VMI, you can respond to replenishment needs
of your items quickly while creating requisitions to fulfill those
requirements.

Forecast Comparison You can post forecasts to and from the system. You can also

compare versions of forecasts on the system. For more
information about forecast comparison, refer to Overview of
Waterfall Analysis on page 7-2.

The Collaboration Cycle

Collaboration consists of the following several steps:

Your customer publishes an order forecast.

You receive your customer’s forecast.

You publish your forecast to your supplier.

Your supplier publishes a supply commit based on your forecast.
You receive your supplier’s capacity.

You run your ASCP plan.

You publish your supply commits to your customer.

The following image depicts the collaboration cycle:
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Forecast Versioning

As a demand planner, you may want to involve your trading partners in your
forecasting process to improve forecast accuracy. You run a supply chain plan in
Oracle Advanced Supply Chain Planning and publish your planned orders to your
suppliers as an order forecast. Suppliers review the order forecast, build their
supply chain plans, and post their supply commits to Oracle Collaborative
Planning. You can make changes to your forecast and publish it to Oracle
Collaborative Planning as a new version. Oracle Collaborative Planning enables you
to compare two or more versions of a forecast. To facilitate a collaborative demand
planning process, you can do the following:

Publish forecasts to Oracle Collaborative Planning.

Share demand data with trading partners.

Provide designators when publishing forecasts.

Provide a version when submitting a demand plan.

Provide start and end dates when publishing plans.

Use filters when publishing data.

Perform forecast comparison using two or more streams of data.

Compare two data streams.
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Collaborate with Customers

This section discusses collaboration with customers. The following topics are
addressed:

s Publish Forecasts
s Publish Supply Commits
= Receive Forecasts in Oracle Demand Planning

s Customer Collaboration Automation

Publish Forecasts

You can publish forecasts from Oracle Demand Planning to your customers using
the Publish Forecast to Customer program. Complete the following steps to publish
forecasts to your customers:

1. Run the Publish Forecast to Customer program
2. Provide forecast name and scenario as parameters

Your customers must complete the following steps to load forecasts into Oracle
Collaborative Planning;:

1. Download supplydemand.dat

2. Prepare the template

= Item = enter a valid item number

s Order Type = Order forecast

»  Publisher = enter a valid publisher name
»  Publisher Site = enter the publisher site

= Supplier = enter a valid supplier

= Supplier Site = enter a valid supplier site
= Receipt Date = enter a valid date

= Bucket End Date = enter a valid date

= Bucket Type = enter a valid type

= Designator: An optional field that is used to denote the name of the forecast

= Version: An optional field that is used to denote the version of the forecast
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3. Save and upload the flat file

Publish Supply Commits

When publishing supply commits to your customers, you can embed any supplies
that are pegged to customer sales orders. A supply commit statement that includes
supplies pegged to sales orders provides your total supply picture for a given time
horizon to your customers.

If customers only share with you their planned orders (not including requisitions
and purchase orders), you would not include any supplies that are pegged to
customer sales orders. The Publish Supply Commits process is launched as an SRS
concurrent request

You can publish supply commits to your customers by completing the following
steps:

1. Run the Publish Supply Commit program

2. Provide plan name and version as parameters

Receive Forecasts in Oracle Demand Planning

To receive customer forecasts in Oracle Demand Planning complete the following
steps:

1. Run the Receive Forecast from Customer program. Provide the forecast name as
a parameter (Navigation: APS Administrator > Collaboration)

2. Setup your demand plan, using order forecasts from customers as an input
parameter (Navigation: DP System Administrator > Demand Plans).

3. Build the demand plan.

4. Demand planners compare customer forecast to internally generated forecast
and adjust internal forecast if appropriate.

5. Collect data from demand planners.
6. Upload the Oracle Demand Planning scenario to the planning server.

The following image depicts the steps for receiving forecasts in Oracle Demand
Planning:
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Customer Collaboration Automation

Oracle Collaborative Planning enables you to automate your customer
collaborations. When a customer uploads or enters a forecast into Oracle
Collaborative Planning and then selects Send Forecast to Supplier in the Admin tab,
the Receive Forecast From Customer concurrent process automatically runs. This
reads the customer forecast into the seeded Oracle Demand Planning data stream
Order Forecast From Customers with a forecast name of CP_ORDER_FORECAST.
Any demand plan that uses Order Forecast From Customers as an input parameter
can then be updated with the new customer forecast data via the Download Data
From Planning Server batch process. The Quick download option enables the
download of just fact data from the selected input parameters.

The capabilities of customer collaboration automation include:
s Customer posts an order forecast to Oracle Collaborative Planning

= Automatic launch of Supply Chain Event Manager (SCEM) to compute
material excess and shortage exceptions and send notifications

= Customer notifies you that a new forecast has been uploaded
= Trigger to launch receive forecast from customer

s Publish Supply Commit to Customer
= Option to publish supply commit from ASCP Planner Workbench
= Automatic launch of SCEM to compute exceptions

Complete the following steps to enable automatic customer collaboration in Oracle
Collaborative Planning:
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Set profile options

MSC: SCEM Engine Launch Events

= None: Do not launch SCEM automatically

= Load: Automatically start SCEM when an order forecast data load occurs

= Publish: Automatically start SCEM when a Publish order forecast (from
ASCP plan) occurs

= All: Automatically start SCEM when either a Publish or a data load occurs
MSC: Configuration
s Setto APS & CP

Customer posts an order forecast to you, which starts workflow to compute
exceptions.

Customer notifies you that a new order forecast has been posted
Workflow launches Receive Forecast From Customer program
Forecast Name defaulted to CP_ORDER_FORECAST

Publish Supply Commit to Customer from PWB

Collaborate with Suppliers

This section discusses collaboration with suppliers. The following topics are
discussed:

Supplier Collaboration Automation
Publish Order Forecasts

Receive Supplier Capacity

Respond to and Edit Purchase Orders
On-hand Inventory Visibility

Access the Planner Workbench

Supplier Collaboration Automation

Oracle Collaborative Planning enables you to automate your supplier collaboration.
When a supplier uploads or enters a forecast into Oracle Collaborative Planning
and then selects Send Supply Commit to Customer in the Admin tab, the Receive
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Supplier Capacity concurrent process automatically runs. This reads the supplier’s
supply commit into the supplier capacity records on the ASCP planning server.
After that, if the profile option MSC: New Supply Commit Auto Plan contains a
valid ASCP plan name, that plan is automatically launched.

The capabilities of supplier collaboration automation include:
»  Publish Order Forecast to Supplier
= Option to publish an order forecast from ASCP Planner Workbench

= Automatic launch of SCEM to compute material excess and shortage
exceptions and send notifications

= Supplier posts a Supply Commit to Collaborative Planning

= Automatic launch of SCEM to compute material excess and shortage
exceptions and send notifications

= Supplier Notifies You That a New Supply Commit has been Uploaded
s Trigger to launch Receive Capacity from Supplier
= Automatic launch of supply chain plan in constrained mode
Complete the following steps to enable supplier collaboration automation:
1. Set profile options.
= MSC: SCEM Engine Launch Events
= None: Do not launch SCEM automatically
= Load: Automatically start SCEM when an order forecast data load occurs

= Publish: Automatically start SCEM when a publish order forecast (from
ASCP plan) occurs

= All: Automatically start SCEM when either a publish or a data load occurs
= MSC: Configuration

s Setto APS & CP
= MSC: New Supply Commit Auto Plan

= Enter a valid plan name

For more information about profile options associated with Oracle
Collaborative Planning, refer to Profile Options on page A-2.
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2, Post an order forecast to your suppliers from the Planner Workbench. This
launches SCEM to compute exceptions.

3. Supplier posts a supply commit; launches SCEM to compute exceptions.
4. Supplier notifies you that a new supply commit has been posted.
s Trigger to launch Receive Supplier Capacity program.

5. Constrained plan runs automatically.

Publish Order Forecasts

You can publish forecasts from Oracle Advanced Supply Chain Planning to your
suppliers using the Publish Order Forecast program. Complete the following steps:

1. Run the Publish Order Forecast program
2. Provide plan name and version as parameters

In addition to publishing planned orders to your suppliers, you can also embed
purchase requisitions and/or purchase orders within the order forecast. This order
forecast will provide your total demand statement for a given time horizon to your
suppliers.

The publish order forecast transaction selects data from MSC_SUPPLIES to be sent
to suppliers in Oracle Collaborative Planning. This is accomplished by:

s The Publish Order forecast program selects all planned orders sourced from
suppliers. The user has the option of including the following order types:

s Purchase Orders

s POin Receiving

s Purchase Requisitions
s Intransit Shipments

s Intransit Receipts

s The receipt date communicated to Oracle Collaborative Planning must be a
valid workday as per the delivery calendar in the ASL for the item/org record
being published. Oracle Advanced Supply Chain Planning ensures that the
dock date for orders sourced from suppliers is a valid day on the delivery
calendar. There are two conditions under which the publish program will apply
the delivery calendar logic:

= ASCP does not provide a dock date
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s The order is firmed in the Planner's workbench.

Supply commits should be published after the supplier collaboration cycle; this
accounts for constraints imposed by suppliers. Your suppliers must complete the
following steps to publish forecasts in Oracle Collaborative Planning;:

1. Download supplydemand.dat

2, Prepare the template

s Order Type = Supply commit

s Item = enter a valid item number

s Publisher = enter a valid publisher name
»  Publisher Site = enter the publisher site
= Supplier = enter a valid supplier

= Supplier Site = enter a valid supplier site
= Ship Date = enter a valid date

= Bucket End Date = enter a valid date

= Bucket Type = enter a valid type

= Designator: An optional field that is used to denote the name of the supply
commit

= Version: An optional field that is used to denote the version of the supply
commit

3. Save and upload the flat file.

Receive Supplier Capacity

You can receive supplier capacity using the Receive Supplier Capacity program.
Complete the following steps:

1. Run the Receive Supplier Capacity program

2. Provide parameters

Respond to and Edit Purchase Orders

Suppliers can respond to purchase orders and initiate purchase order change
requests directly through the Oracle iSupplier Portal. When this happens, Oracle
Collaborative Planning auto-creates (for the purposes of supply/demand tracking
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and exception management within Oracle Collaborative Planning) a supplier sales
order containing the acknowledgement information. Suppliers can provide their
sales order reference information directly through Oracle iSupplier Portal. This not
only reduces overhead of maintaining documents in two separate places, but also
enables a more streamlined business process.

Oracle Advanced Supply Chain Planning refers to the promised date on a purchase
order as the dock date. If a promised date is not provided, then the dock date is
recognized as the need by date.

If the supplier provides a promised date and any sales order information (sales
order and line for each PO shipment), Oracle Collaborative Planning creates a Sales
Order order type that is pegged to the purchase order shipment. Suppliers can
provide a sales order line number for each purchase order shipment number.

If the sales order number and the sales order line number are not provided by the
supplier, Oracle Collaborative Planning creates a sales order with the same number
as the purchase order and line number. For example, if the PO # is 1174, line 1,
shipment 1, the sales order will be SO1174, line 1.

If the supplier provides the sales order number and the sales order line number
through Oracle iSupplier Portal at a later date, all previously existing sales orders
that were system created will be deleted for that PO/Line/Shipment. Instead, the
new sales order will be created and pegged to the purchase order.

If the supplier later changes the sales order number and line number for the
purchase order, line, shipment, then Oracle Collaborative Planning replaces the
previous sales order number with the new one. The following table depicts possible
supplier responses on a purchase order acknowledgement and what the
corresponding sales order would show in Oracle Collaborative Planning:

Supplier Response on Purchase Order

Acknowledgement Sales Order in Oracle Collaborative Planning
Promise Date: Null or Jan 15, 2003 Need By Date: Null or Jan 15, 2003
Sales Order Number: Null or 1125 Order Number: (SO + PO + Line) or 1125

Sales Order Line Number: Null or 001 Line Number: (SO + PO SHIPMENT) or 001

On-hand Inventory Visibility

You can collect on-hand inventory records from all inventory organizations and
view them in Oracle Collaborative Planning. On-hand inventory associated with a
supplier and supplier site will be displayed in Oracle Collaborative Planning as
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allocated on-hand. If the inventory is not identified with a supplier and supplier
site, Oracle Collaborative Planning will display the record as unallocated on-hand.
If the inventory organization is associated with a supplier, all on-hand records will
be displayed as allocated on-hand.

The following image is for reference in example for this section:

VISION CORPORATION

M1 Organization SUP2 (supplier modeled as an
organization)

Allocated Unallocated Allocated Unallocated
25 75 35
Example 1

Let’s say that supplier 1 is responsible for replenishing inventory to Vision/M1
(VMI). Oracle Collaborative Planning will collect the allocated onhand and use that
quantity (25) in the VMI calculation.

Example 2

If we want to display it the unallocated quantity, Oracle Collaborative Planning
collects it and displays it as unallocated on-hand and ensures that the VMI engine
does not use it in the VMI calculation.

Example 3

In this case, supplier SUP2 is modeled as an organization in Vision. SUP2 posts the
on-hand inventory in his warehouse into org SUP2 using EDL. It is collected over to
Oracle Collaborative Planning and displayed there as Allocated On-hand.

If Vision and SUP2 want to use VMI, then the following must occur:
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= Vision will set up a local ASL, with the owning org as M1 and supplier as SUP2,
in order to enable VML

Access the Planner Workbench

You can provide your suppliers with view-only access to the Oracle Advanced
Supply Chain Planning Planner Workbench through Oracle Collaborative Planning.
If you have modeled the supplier as an organization, the supplier will have access
to supply/demand information for that organization. If you have not modeled the
supplier as an organization, the supplier will have access to the supply/demand
information restricted to that supplier.

To access the Planner Workbench from Oracle Collaborative Planning, complete the
following steps:

1. Select the Planning tab in Oracle Collaborative Planning. The following image
depicts the Planning tab in Oracle Collaborative Planning:

OQACI_G. Home Logout Help Preferences

Exceptions Planning Admin

Create Order Flanner Wy

Search
ltern | ,,'{ Customer I ,,,{
Customer ltem | ,,5? Supplier I ,,5‘?
Supplier Iterm | ,,5? Order Type I ,,5‘?

( search ) Advanced Search
Display Using Preference Set E Edit Preference ) Search J

2. Select Planner Workbench.

The Planner Workbench sub-tab is visible only to users who belong to a company

that has a supplier role (the supplier can be modeled either as an Org or not as an
Org).

When you launch the Planner Workbench from the Planning tab, only the plans that
meet both the following criteria will display:

s The plans that are marked Production

s The plans for which the supplier is included. Examples of this include:
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= For suppliers modeled as Orgs, their Org should be one of the planned Orgs
in the plan

s For suppliers not modeled as Orgs the Supplier should be included in the
Sourcing Rule used by the plan.
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Vendor Managed Inventory

This chapter discusses how Vendor Managed Inventory is used in Oracle
Collaborative Planning. The following topics are addressed:

Overview of Vendor Managed Inventory on page 4-2
Order Types on page 4-3

User Setup and Process on page 4-4

Monitor and Replenish Inventory on page 4-7
Exceptions on page 4-9

VMI Replenishment Engine on page 4-10
Notifications on page 4-10
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Overview of Vendor Managed Inventory

Vendor Managed Inventory enables you to share on-hand, supplies, and forecast
information with suppliers, transfer replenishment responsibility to suppliers, and
automate replenishment processes.

Oracle Collaborative Planning uses Vendor Managed Inventory to automate the
replenishment process, lower inventory, improve supplier performance, and drive
out non-valued added costs. You can provide suppliers necessary information to
manage inventory they provide. Vendor Managed Inventory is integrated with the
execution system to enable any desired level of automation in fulfillment.

With VM], all planning activities can be monitored in the system. You can view the
following:

= Forecasts you provided for your suppliers.
s Current onhand inventory quantities for materials shipped by your suppliers.

= Suggested replenishment quantity (calculated in Oracle Collaborative Planning)
when available inventory is below the specified minimum. The suggested
replenishment quantity is calculated by taking the difference between the
maximum quantity and the available inventory. Available inventory is
calculated using the following equation:

Allocated onhand + Requisitions + Purchase Orders + ASNs + Receipts

= Replenishment quantity. Replenishment quantity is the amount of an item that
is requested by the user. The default value of this column is less than or equal to
the suggested replenishment quantity minus in-process quantity. You can
choose to release a quantity less than the suggested replenishment quantity.

= In-process quantity which is the replenishment quantity released since the last
VMI engine run. It is set to zero after each VMI engine run.

= Current open quantities on purchase orders and requisitions.
s Current quantities received, but not delivered into inventory.

s Current in-transit shipment information that your VMI supplier is responsible
for managing.

You can enable vendor managed inventory through approved supplier lists. With
approved suppliers lists. you can:

= Set up local or global approved supplier lists. If you want a supplier site to
manage inventory for an item at two or more inventory organizations, each
with its own replenishment parameters, you can set up a local approved
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supplier lists. If the supplier site will manage the item at several inventory
organizations, all with the same replenishment parameters, you can set up a
global approved supplier list.

s Specify in approved supplier lists an indicator describing the supplier or
supplier site responsible for managing your replenishments.

= Select a replenishment method. If you select the Automatic replenishment
method, the system will calculate replenishment quantity. If you select the
Manual replenishment method, Oracle Collaborative Planning will generate
material shortage exception, but will not suggest a replenishment quantity. You
must also use manual replenishment processes to order more material.

= Select approval levels. The following table depicts how replenishment orders
can be released.

Approval By Description

Buyer Only a user within the customer company releases a
replenishment order.

Buyer/supplier Users from both companies can release a replenishment order.

None After a replenishment order is created the system automatically

releases it.

= Use replenishment points in the form of minimum/maximum reorder planning
points.

»  Create replenishments or requisitions for your plan.
= Integrate replenishments with your ERP system.

Vendor Managed Inventory enables you to initiate replenishments when available
inventory falls below minimum levels. You can:

= Send notification to the planner of specific item

= Suggest a replenishment quantity that equals maximum available inventory

Order Types
Vendor managed inventory uses the following order types:
= ASN (from supplier)

= Requisition (from buyer)
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Purchase Order (from buyer)
Receipt (from buyer)
Allocated Onhand (from buyer)

Order forecast (optional from buyer)

To learn more about the order types supported by Oracle Collaborative Planning,
refer to Order Types on page 2-38.

User Setup and Process

The user setup and process for Vendor Managed Inventory consists of the following
several steps:

1.
2

5.
6.

Create Blanket Purchase Agreements (performed in Oracle Purchasing).

Define Vendor Managed Inventory Parameters in approved supplier lists
(performed in Oracle Purchasing).

Collect Approved Supplier Lists and available inventory for each
item/supplier.

Schedule and Run the VMI Replenishment EngineSchedule and run the VMI
replenishment engine.

Generate Replenishments and start requisition import.

Submit Advance Shipment Notices (performed in Oracle iSupplier Portal).

The following image depicts the user setup flow for Vendor Managed Inventory:
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Create blanket purchase Define Vendor Managed
agreement — Inventory parameters
in Oracle Purchasing in Approved Supplier Lists
Schedule and run Vendor Collect approved supplier
Managed Inventory +—| lists and available inventory
Replenishment Engine for each item/supplier
Generate replenishments Submit Advanced Shipping
automatically, start —» Notices using Oracle
requisition import iSupplier Portal

Create Blanket Purchase Agreements

Blanket purchase agreements are defined in Oracle Purchasing. For more
information about setting up blanket purchase agreements, refer to the Oracle
Purchasing User Guide.

Define Vendor Managed Inventory Parameters

Vendor Managed Inventory parameters are defined in approved supplier lists. You
can create approved supplier lists in Oracle Purchasing. Use approved supplier lists
to perform the following:

= Enable an item, supplier, and supplier site for Vendor Managed Inventory.

» Indicate whether Vendor Managed Inventory parameters apply to a specific
inventory organization.

Use global Approved Supplier Lists when Vendor Managed Inventory parameters
apply across all of your organizations.

You must complete the following mandatory steps when you set up approved
supplier lists:

= Select replenishment method
= Specify minimum and maximum inventory levels

s Automatic allowed:
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= Suggested replenishment quantity is calculated
= Quantity can be released automatically, by the buyer, or the buyer/supplier
= Notifications sent to item planner and supplier contact

= Automatic not allowed:

= Replenishment quantity is not calculated and has to be determined by the
buyer or supplier

= Exceptions generated when supply is less than minimum inventory

For more information about creating approved supplier lists, refer to the Oracle
Purchasing User’s Guide.

Collect Approved Supplier Lists

Collections are scheduled in Oracle Advanced Supply Chain Planning. Schedule
collections to retrieve approved supplier lists and supply information.

For more information about scheduling collections, refer to the Oracle Advanced
Planning and Scheduling Implementation and User Guide.

Schedule and Run the VMI Replenishment Engine

To schedule the Vendor Managed Inventory Replenishment Engine, provide a
Replenishment Time Fence multiplier. A time fence multiplier of 1 (default) denotes
that the VMI engine will calculate available inventory over one times the processing
lead time of the vendor managed inventory item.

Generate Replenishments

After you schedule and run the VMI replenishment engine, you can view
replenishments in Oracle Collaborative Planning. The following columns are
specific to VMI:

= Replenishment Date. This date appears as the Need By Date on purchase
requisitions/purchase orders.

= Suggested Replenishment Quantity.
= Replenishment Quantity.

= In-process quantity.
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For more information about these fields, refer to Monitor Inventory Status on
page 4-7.

Submit Advance Shipment Notices

A supplier creates an Advanced Shipment Notice (ASN) to communicate that
material has shipped. Advance shipment notices are created using Oracle iSupplier
Portal. The following information is required:

Quantity
Ship Date - Actual
Receipt Date - Planned

Comments (optional)

Monitor and Replenish Inventory

Monitor Inventory Status

Your suppliers monitor inventory levels using the inventory status screen.

Complete the following steps to access the Inventory Status window in Oracle
Collaborative Planning:

1.
2

From the Home page in Oracle Collaborative Planning, select the Planning tab.

Under the Planning tab, select VMI. The Inventory Status window displays. The
following image depicts the Inventory Status window:
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In the Inventory Status window you can view the replenishment information. The
following table describes pertinent columns you can view in the Inventory Status

window:

Column Description

Replenishment Date Date when replenishment is necessary. This is calculated by
adding item processing lead time to the VMI Engine run date.

Suggested Quantity Oracle Collaborative Planning recommends for

Replenishment Quantity =~ replenishment.

Replenishment Quantity Quantity you wish to release. This number must be less than or
equal to the suggested replenishment quantity,

In-process quantity Quantity released for replenishment. This number is set to zero
after each replenishment engine run.
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Replenish Inventory

Exceptions

In Vendor Managed Inventory (VMI), a supplier is responsible for managing
inventory replenishment at a customer location. The customer posts onhand
inventory information and the supplier posts in-transit information. This results in
available quantity. Available quantity is the sum of the following:

= Onhand inventory

= Open purchase requisitions
= Open purchase orders

s In-transit shipments

= Receipts awaiting delivery

When the available quantity at the customer location is less than a specified
minimum (the replenishment trigger point) Oracle Collaborative Planning notifies
the customer and supplier. The supplier can then replenish the necessary inventory.

Inventory shortage and excess exceptions are generated for VMI items only when
Manual is the replenishment method (Automatic Allowed is unchecked). You can
access the detail information by selecting the Exceptions tab in Oracle Collaborative
Planning.

For VMI, material shortage exceptions have two notices:

= VMl item shortage at your site

= VMl item shortage at your customer's site, replenishment required
For VMI, material excess exceptions have two notices:

s VMlitem excess at your site

s VMIitem excess at your customer's site

These exceptions are generated to assist you in identifying which vendor managed
inventory items have material shortages or excess inventory. For more information
about exceptions, refer to Overview of Exceptions on page 6-2.
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VMI Replenishment Engine

To generate VMI exceptions and send notifications you must run the VMI
Replenishment Engine. To run the VMI Replenishment Engine you must have the
Advanced Planning System Administrator responsibility assigned to your
username.

To schedule the VMI replenishment engine you must provide a replenishment time
fence (RTF) multiplier. Supplies that fall within the time period (RTF x multiplier)
are considered as available inventory.

To run the VMI replenishment engine, complete the following steps:
1. Log into under the Advanced Planning Administrator responsibility.
2. Navigate to Other > VMI Replenishment Engine.

3. Enter a value for the Replenishment Time Fence multiplier and select OK.

Note: The replenishment time fence is the point in time that marks
a boundary within which supplies should be considered before
triggering replenishments. This boundary is calculated by taking
the sum of the processing lead time and the VMI engine run date.
This time fence would allows you to specify time horizons of
supply for items, which may have very short/long in-transit times.

4. Select Submit.

Notifications

4-10

To view notifications, log onto the system. The main Collaborative Planning Home
page displays any outstanding notifications that relate to your vendor managed
inventory items. Alternatively, you can select the Exceptions tab to view any
relevant exceptions.

Note: You must run the VMI Replenishment Engine to generate
exceptions and send notifications.
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Collaborative Inventory Visibility

This chapter discusses collaborative inventory visibility and how it used in Oracle
Collaborative Planning. The following topics are addressed:

Overview of Collaborative Inventory Visibility on page 5-2
Setup on page 5-2

Create Groups on page 5-2

Define Group Members on page 5-3

Define Security Rules on page 5-3

Upload Unallocated On-hand Inventory on page 5-4

Search for Inventory on page 5-5
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Overview of Collaborative Inventory Visibility

Collaborative Inventory Visibility enables you to share inventory levels at key
locations with your strategic trading partners.

With Collaborative Inventory Visibility, you can:

Setup

Create trading partner groups with whom you share inventory levels

Create security rules that enable member companies to view your inventory
levels

Maintain a supply of unallocated inventory at strategic locations

The following steps outline the setup for Collaborative Inventory Visibility:

Create groups

Define member companies of groups
Create security rules

Upload unallocated on-hand inventory
Enable customer search for inventory

Configure descriptive flexfields (this step is optional)

The step to configure the descriptive flexfields is required only when you want to
support non-standard columns in an upload file. For more information about
descriptive flexfields, refer to the Oracle Applications AOL Manual.

Create Groups

Use group.dat to define you group. To create a group, complete the following steps:

1.

2
3
4.
5

Navigate to the Load Setup Data window.
Select Download templates.

Open group.dat.

Enter the group name.

Enter the group type Private (use the type Public only when other companies
use the group).
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6. Enter the source instance code (your specific instance code).

7.

Save the file.

8. Return to the Load Setup Data window and upload group.dat.

Define Group Members

Use groupcompany.dat to define group members. To define group members,
complete the following steps:

1.

@ o » W N

Open groupcompany.dat from the previously downloaded templates.
Enter the group name.

Enter the company names.

Enter the source instance code (your specific instance code).

Save the file.

Navigate to the Load Setup Data window and upload groupcompany.dat.

Define Security Rules

Define security rules that enable group members to view your unallocated on-hand
inventory. The following fields are required:

Access Given By
Privilege

Access Given To

Complete the following steps to define security rules:

1.
2.
3.

Navigate to Create New Rule window.
Enter your company name in the Access Given By field.

Enter the order type. For example, if you want group members to view your
unallocated on-hand inventory, enter Unallocated On-hand.

Enter the item number (this step is optional, if you do not enter item number, all
items will be considered for the security rule).

Select one of the following privileges for your group members:

View
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= Update

6. Select one of the following for Access Given To:
s Company

s User

= Responsibility

s Group

»  Global

7. Enter the Assigned To field.
8. Select effective dates.

9. Select Submit.

Upload Unallocated On-hand Inventory

Complete the following steps to upload unallocated on-hand inventory. You can
skip steps 1 and 2 if you have already downloaded the templates.

1. Navigate to the Load Supply/Demand window.
Select Download templates.

Open supplydemand.dat.

Enter the Synch Indicator.

Enter the Item Name.

@ o » w N

Enter the Order Type.

Note: For the Unallocated On-hand order type, do not enter
customer or supplier name.

7. Enter the Quantity.

8. Enter the UOM.

9. Enter the Publisher Company.
10. Enter the Publisher site.

11. Save your work.
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12. Return to the Load Supply/Demand window and upload your file.

Search for Inventory

Your customers can now search for your inventory using Vertical View. Complete
the following steps to search for and find inventory:

1. Navigate to the Vertical View window.

2. Enter information in at least one of the following fields:
s Item

s Order Type

= Select search.

3. Choose an item from the results.
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Exceptions

This chapter discusses exceptions and how they are used in Oracle Collaborative
Planning. The following topics are addressed:

Overview of Exceptions on page 6-2

Supply Chain Event Management Engine on page 6-2
View Exceptions on page 6-3

Seeded Exceptions on page 6-3

Custom Exceptions on page 6-12

Exception Thresholds on page 6-17

Pegging on page 6-18
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Overview of Exceptions

Exceptions are notifications that identify issues that need resolution. Oracle
Collaborative Planning generates an exception whenever an actual process does not
match the required process. For example, if you and your supplier's forecasts do not
match, Oracle Collaborative Planning generates a forecast mismatch exception.
Exceptions ensure that the decision-making process remains focused, occurs in a
timely manner, and makes the supply chain more responsive.

Oracle Collaborative Planning exceptions are grouped into several categories that
correspond to supply chain problems. The categories are:

= Late orders

= Early orders

= Potential late orders

= Material shortage

= Material excess

= Forecast mismatch

= Response required

s Change orders

» Forecast accuracy

s Performance below target

Exception notifications for an item are sent to the supply chain collaboration
planner for the item. If no planner is specified for an item, notification is sent to an
Administrator. Any planner can view an exception through the Exceptions tab. You
can also view counts for a given exception type.

Supply Chain Event Management Engine

The Supply Chain Event Management engine computes exceptions on a net change
basis. Exceptions are computed only for every transaction that has received
additional information since the last Supply Chain Event Management Engine run.

The Supply Chain Event Management Engine is a background process which
usually runs at a specified frequency. Your Advanced Planning administrator can
change this frequency.
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View Exceptions

Complete the following steps to view exceptions in Oracle Collaborative Planning:

1.
2.

From the Oracle Collaborative Planning application, select the Exceptions tab.

On the Exceptions Summary page, select the exception type you want to view
and then select Show Details.

You will see the details of the selected exceptions. You can perform a search on
this page.

Seeded Exceptions

Late Orders

Late order exceptions occur when either you or your supplier are late in meeting a
required date for an order. For example, if the Need By Date of a purchase order is
07/12/2003 and the system date is 07/22/2003, a late order exception is generated.
The following late order exceptions are generated in Oracle Collaborative Planning:

Late Replenishment to Customer
= You see this exception as the supplier of an item.

= This exception is triggered when the receipt date on your sales order is later
than the receipt date on the customer’s purchase order and the threshold.

Late Replenishment from Supplier
= You see this exception as the customer of an item.

= This exception is triggered when the receipt date on the supplier's sales

order is later than the receipt date on your purchase order and the
threshold.

= By selecting this exception, you can navigate to the details of the purchase
order that caused the exception (and related sales orders from the
suppliers).

Replenishment to Customer is Past Due
= You see this exception as the supplier of an item.

= This exception is triggered when the system date is later than the receipt
date on the customer’s purchase order adjusted by the threshold.
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= Replenishment From Supplier is Past Due
= You see this exception as the customer of an item.

s This exception is triggered when the system date is later than the receipt
date on your purchase order and threshold.

= By selecting this exception, you can navigate to the details of the purchase
orders that caused the exception.

The details you can view of the purchase orders or sales orders that caused the
exception include number of days the order is late by, exception types, order types,
order numbers, release numbers, line numbers, items, quantities, order schedule
dates (receipt date for the sales order, receipt date for the purchase order), order
creation dates, and threshold days.

Material Shortage

Material shortage exceptions are discrepancies between your initial demand or
supply and the corresponding supply or demand from your trading partner. The
following Material Shortage exceptions are generated in Oracle Collaborative
Planning:

= Supply Commit is Less Than Customer Order Forecast
= You see this exception as the supplier of an item.

= This exception is generated when the order forecast of a customer is more
than your supply commit, adjusted to the threshold. The threshold is
defined as percentage of order forecast.

s Supplier's Supply Commit is Less Than Order Forecast
= You see this exception as the customer of an item.

= This exception is generated when supplier's supply commit is less than
your order forecast, adjusted to threshold. Threshold for this exception is
defined as percentage of order forecast.

= Short Supply for Customer Purchase Order
= You see this exception as the supplier of an item.

s This exception is triggered when the quantity on your sales order is less
than the quantity on the customer's purchase order.

= By selecting this exception, you can navigate to the details of the sales
orders that caused the exception (and related purchase orders).
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= Short Supply from Supplier for Purchase Order
= You see this exception as the customer of an item.

= This exception is triggered when the quantity on the supplier's sales order
is less than the quantity on your purchase order.

= By selecting this exception, you can navigate to the details of the purchase
orders that caused the exception (and related sales orders).

= VMI Item Shortage at Customer Site, Replenishment Required
= You can see this exception as the supplier of a VMI item.

= This exception is generated only for items which are enabled for VMI in the
Approved Supplier List (ASL).

s This exception is generated when the total quantity of on-hand,
requisitions, purchase orders, ASN (in-transit), and receipts for the item is
less than the minimum quantity set for it.

= VMI Item Shortage at Your Site
= You can see this exception as the customer of a VMI item.
s This exception is generated for items those are marked as VMI in the ASL.

s This exception is generated when the total quantity of On hand,
Requisitions, Purchase orders, ASN, Receipts is below the minimum
quantity set for the item.

From all these exceptions, you can navigate to the underlying transaction records,
and review details.

Material Excess

Material excess exceptions occur when a quantity demanded is less than a supply
provided. The following Material Excess exceptions are generated in Oracle
Collaborative Planning:

= Supply Commit Exceeds Customer Order Forecast
= You see this exception as the supplier of an item

s This exception is generated when supply commit is more than the order
forecast, adjusted to the threshold. Threshold in this exception is defined as
percentage of order forecast.

s Supplier Supply Commit Exceeds Order Forecast
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= You see this exception as the customer of an item.

= This exception is generated when supply commit is more than the order
forecast, adjusted to the threshold. The threshold in this exception is
defined as percentage of order forecast.

= Excess Replenishment for Customer Purchase Order
= You see this exception as the supplier of an item.

s This exception is triggered when the item quantity on your sales order is
greater than the item quantity on the customer's purchase order, adjusted to
threshold.

s Excess replenishment from supplier for purchase order
= You see this exception as the customer of an item.

= This exception is triggered when the quantity on the supplier's sales order
is more than the quantity on your purchase order, adjusted to threshold.

= VMI Item Excess at the Customer Site
= You see this exception as the supplier of an item.

= This exception is generated when supplies for an item, the total of on-hand,
requisitions, purchase orders, ASNs, and receipts is greater than the
maximum limit set for this item.

s VMIItem Excess at Your Site
= You see this exception as the customer of an item.

= This exception is generated when supplies for an item, the total of on-hand,
requisitions, purchase orders, ASNs, and receipts, is greater than the
maximum limit set for this item.

s To take resolution action for this exception, you can navigate to the VMI
details screen from exceptions screen.

Response Required: Response to Trading Partner Required

Response to Trading Partner Required exceptions occur when responses to
transactions by your trading partners are not posted within an acceptable time
limit. Oracle Collaborative Planning generates these exceptions when the
appropriate threshold is crossed. In this category, the following exceptions are
generated in Oracle Collaborative Planning:

s Response Required for Customer Purchase Order
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= You see this exception as the supplier of an item.

s This exception is triggered when a sales order does not exist for a purchase
order posted by the customer within the threshold number of days.

= Response Required for Supplier Sales Order

= You see this exception as the customer of an item. The customer receives the
sales order from a supplier.

s This exception is triggered when a purchase order does not exist for a sales
order posted by the supplier within a threshold number of days.

Response Required: Trading Partner Response Required

Response to Trading Partner Required exceptions occur when your trading partners
do not post responses to your transactions within acceptable time limit. In this
category, the following exceptions are generated:

»  Supplier Response Required for Purchase Order
= You see this exception as the customer of an item

s This exception is triggered when a sales order does not exist for a purchase
order posted by you.

s Customer Purchase Order Does Not Exist for Your Sales Order
= You see this exception as the supplier of an item.

= This exception is triggered when a purchase order does not exist for a sales
order for your supplier.

From the Exceptions Details window you can navigate to view the details of the
purchase orders or sales orders that caused the exception.

Potential Late Orders

Potential Late Order exceptions demonstrate the ability of Oracle Collaborative
Planning to process information across multiple supply chain tiers. The evaluation
requires Oracle Collaborative Planning to check every possible order against all
sales orders, purchase orders, and multiple orders. The following potential late
order exceptions are generated in Oracle Collaborative Planning:

= Potential Late Order Due to Upstream Lateness

= You can view this exception as any trading partner (customer or supplier)
of an item.
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s This exception is triggered when a sales order from supplier is late
compared to the purchase order anywhere in the pegging tree. For example,
PO1 is pegged to SO1, SO1 is pegged to PO2, and PO2 is pegged to SO2. If
SO2 is going to be late when compared to PO2, a potential late order is
raised for PO1.

= From this exception, you can navigate to the underlying transactions and its
pegging tree to review details and take actions for resolution.

s Purchase Order Compresses Lead Time
= You can view this exception as the customer of an item.

= This exception is triggered when the time duration between the receipt date
on your purchase order and the creation date of the purchase order is less
than the item lead time specified by the supplier.

= By selecting this link, you can view the details of the purchase orders that
caused the exception.

s Customer Purchase Order Compresses Lead Time
= You see this exception as the supplier of an item.

s This exception is triggered when the time duration between the receipt date
on the customer's purchase order and the creation date of the purchase
order is less than the item lead time specified by you.

»  Sales Order Requires Lead Time Compression
= You can view this exception as the supplier of an item.

s This exception is triggered when the time duration between the ship date
on your sales order and the creation date of the sales order is less than the
item lead time specified by you.

Forecast Mismatch

A forecast mismatch exception is a discrepancy between you and your trading
partner’s forecast. Forecast mismatch exceptions pertain mostly to the horizontal or
bucketed view. The following forecast mismatch exceptions are generated in Oracle
Collaborative Planning:

m  Customer Sales Forecast Exceeds Your Sales Forecast

= You see this exception as the supplier of an item.
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Early Orders

This exception is triggered when sales forecast provided by your customer
exceeds the sales forecast posted by you, adjusted with threshold, for an
item in a bucket.

m  Customer Sales Forecast is Less than Your Sales Forecast

You see this exception as the supplier of an item.

This exception is generated when sales forecast provided by your customer
is less than the sales forecast posted by you, adjusted by threshold, for an
item in a bucket.

= Supplier Sales Forecast Exceeds Your Sales Forecast

You see this exception as the customer for an item.

This exception is generated when sales forecast posted by your supplier
exceeds the sales forecast posted by you adjusted with threshold for an item
in a bucket.

= Supplier Sales Forecast is Less Than Your Sales Forecast

You see this exception as the supplier for an item.

This exception is generated when sales forecast provided by the supplier is
less than the sales forecast provided by you adjusted with threshold, for an
item in a bucket.

Early orders exceptions occur when either your supplier or customer are scheduled
to receive a shipment before the intended need-by date. You receive the following
early orders exceptions:

= Early Replenishment to Customer

You see this exception as the supplier of an item.

This exception is triggered when the receipt date on the sales order is earlier
than the receipt date on the customer’s purchase order, adjusted by the
threshold.

= Early Replenishment from Supplier

You see this exception as the customer of an item.

This exception is triggered when the receipt date on the supplier's sales
order is earlier than the receipt date on your purchase order and the
threshold set for the exception.
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Change Orders

Change order exceptions let you know that there is a change to your purchase
order. You receive the following change order exceptions:

s Customer Purchase Order has been Cancelled
= You can see this exception as the supplier of an item.

s This exception is triggered when purchase order placed by the customer to
you is cancelled.

s Your Customer's Purchase Order to You is Rescheduled
= You can see this exception as supplier of an item.

= This exception is triggered when the receipt date of a purchase order placed
to you is changed.

Forecast Accuracy

Forecast accuracy exceptions enable you to see whether your forecast is greater than
previous or current sales. You receive the following forecast accuracy exceptions in
Oracle Collaborative Planning:

s Customer Sales Forecast Exceeds Actual Sales
= You can see this exception as the supplier of an item.

s This exception is triggered when the sum of your historical sales forecast
provided by customer, increased by the threshold percentage, exceeds
actual sales (historical sales) for last three months.

»  Sales Forecast Exceeds Actual Sales
= You can see this exception as the customer of an item.

s This exception is triggered when your sales forecast, increased by the
threshold percentage, exceeds actual sales (historical sales) provided by the
supplier for last three months

s Customer Order Forecast Exceeds Actual Orders
= You can see this exception as the supplier of an item.

s This exception is triggered when the order forecast provided by customer,
increased by the threshold percentage, exceeds total of purchase orders for
last three months

s Order Forecast Exceeds Actual Orders
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You can see this exception as the customer of an item.

This exception is triggered when your order forecast, increased by the
threshold percentage, exceeds total of purchase orders placed for the item
to the supplier for last three months

Performance Measure Below Target

Performance Measure Below Target exceptions measure performance. Performance
is a calculation such as forecast error (forecast minus actual sales divided by the
forecast), inventory turns, number of stock-outs, or fill rates. The period over which
performance is measured is three months. For example, number of stock-outs is
counted over the last three months. The resultant number is compared to threshold
value, and then a notification is sent to a planner. The following Performance
Measure Below Target exceptions are available in Oracle Collaborative Planning;:

Customer Forecast Error Exceeds the Threshold

You can see this exception as the supplier of an item.

This exception is generated when the mean average percentage of error
(MAPE) for the forecast in a given period exceeds the acceptable limit set by
the threshold. By default, MAPE is calculated over a period of three
months. A deviation of actual sales from forecast is considered as an error
in the forecast.

Forecast Error Exceeds the Threshold

You can see this exception as the customer of an item.

The condition for this exception is same as the Customer Forecast Error
Exceeds the Threshold exception; the only difference is that it is visible to
the customer of an item.

You Have Exceeded a Stock Out Threshold

You can see this exception as the supplier of an item.

A zero on hand quantity is considered as stock out. So when the number of
stock outs over last three months exceeds the acceptable limit (set by
threshold), this exception is triggered.

Supplier On-Time Performance is Below Threshold

You can see this exception as the customer of an item.

If the actual receiving date of a purchase order is on or before the need by
date, then the order is considered as on-time. Otherwise it is not on-time. If
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number of such violations from a supplier for an item exceeds a pre-set
acceptable limit (set by threshold), this exception is triggered.

= On-time Delivery Performance is Below Threshold
= You can see this exception as the supplier of an item.

s Condition for this exception is the same as condition for Supplier On-Time
Performance is Below Threshold exception. The only difference is that this
exception is visible to the supplier.

s Inventory Turns for VMI Item Below Threshold
= You can see this exception as the customer of an item.

= Inventory turn is calculated by dividing the actual sales of an item with the
average on-hand inventory. Inventory turn is calculated for a period of
three months, and if it is less than the acceptable inventory turn limit set by
the threshold, then this exception is generated.

s Customer Inventory Turns for VMI Item Below Threshold
= You can see this exception as the supplier of an item.

= Condition for this exception is same as the Inventory Turns for VMI Item
Below Threshold exception, except that it is visible to the supplier of an
item.

Custom Exceptions

To prevent disruptions in the supply chain you must monitor and identify
problems, determine the severity of issues to recognize when action is required,
determine the appropriate corrective action, and measure performance to ensure
appropriate actions are being taken. Custom exceptions enable you to define
conditions that identify potential problems in the supply chain, receive notifications
as problems are identified, and control the sensitivity of conditions by associating
exception thresholds.

Oracle Collaborative Planning enables you to create business-specific custom
exceptions. You can only edit the exceptions you created. When an exception

condition is met an exception is generated, and a notification alerts you to the
problem.

For custom exception definition, data is represented by three different views such as
Company view, Supplier view, and Customer view. Attributes from these views are
identified by the corresponding prefixes.
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You must complete the following steps to create a custom exception:
= Name the Exception on page 6-13

= Define Exception Scope on page 6-13

= Define Exception Condition on page 6-14

= Define Exception Output Attributes on page 6-15

s Define Schedule on page 6-15

= Specify Recipients on page 6-15

= Save on page 6-16

Name the Exception

Choose a name by which you will recognize and understand your exception. In this
window you also can enter a description of your exception.

Define Exception Scope

You can limit the scope of a custom exception by entering filtering criteria. By
limiting the scope, you are restricting the number of records to be evaluated for the
exception condition. Setting proper scope helps improve performance of the
exception generation process.

You can limit the scope of the exception by entering the following attributes and
dates:

»  Limit Supply/Demand Attributes
s Company and/or Company Site
= Supplier and/or Supplier Site
n  Customer and/or Customer Site
» Item and/or Owner Item
= Supplier Item and/or Customer Item
s Order Number
s Order Type Description
= Release Number

»  Limit Supply/Demand Dates
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= Date Type

= Date Range

= Rolling Time Period
= Period to Date

While entering dates, you can use any of the date attributes present in the
transaction by selecting suitable date type. You can define the range of dates as date
range, rolling time period, or period to date which starts or ends on the current
system date.

Define Exception Condition

This is the heart of the exception definition. Depending on the complexity of the
exception definition, you can use Simple or Advanced conditions to model the
exception condition.

Simple Condition

When defining an exception condition, verify that when the condition is true it
results in an exception. Select whether to generate the exception when all the
conditions are met, or when any of the conditions are met. Define the exception
using the following criteria:

»  Attribute
s Operator
= Value (from)
s Value (to)

While defining simple condition, you can also specify for this exception whether
you want all the conditions required, or any of the conditions required. This is
accomplished by selecting one of the following options:

s When all of the conditions are met

= When any of the conditions are met

Advanced Condition

If the Simple Condition window does not meet your exception definition, use the
Advanced Condition definition window. In this window you use SQL to define
conditions. In advanced condition, you can define conditions using attributes from
three views such as Company, Customer, and Supplier.
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Define Exception Output Attributes

Select the columns to display in your exception output by selecting attributes from
the Available Attributes list. There are number of attributes available from all the
three views. Carefully select the attributes required for your exception definition.

Define Schedule

You can schedule your custom exception to run independently or along with
standard exceptions. If you decide to run the custom exception independently, then
indicate when the system should start and how often it will evaluate the exception
condition. Enter the following information:

s Start Date
s Recurrence

If you decide to run it along with standard exceptions, it will be evaluated along
with other seeded exceptions (with the frequency of Supply Chain Event
Management engine).

Specify Recipients
In this step, you can perform the following major tasks:
= Configure notification heading
= Specify workflow

»  Specify recipient for the notification

Configure Notification Heading

In this step, you enter the text of the notification heading. You also can select from
the output attributes by using tokens. For example, if one of your output attributes
is Item Number, and you select this as token in notification header, the token will be
substituted with the actual item number when the exception is generated.

Specify Workflow

By default, custom exceptions are governed by MSC:User Defined Workflow, and
the User Defined Exception Workflow process. This workflow and workflow
process generates the notification for each custom exception, and sends to the right
users. You can customize this workflow, and workflow process, or add a new
workflow process under the parent workflow, or add a new workflow to model
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your resolution procedure. If you have multiple workflows or workflow processes
you can select the most appropriate workflow for a particular exception in this
screen. For more information about workflows and how they are used in Oracle
Collaborative Planning, refer to Using Oracle Workflow in Oracle Collaborative
Planning on page 9-2.

Specify Recipients

Recipients can be specified as user, responsibility, item planner, or an e-mail
address. For example, if you select recipient type as user, then the list of values for
recipient will contain list of users in your instance. If you select item planner, the
actual planner for the item will receive notification when the exception is generated.

You can enter whether to give access to the exception by enabling access to the
Oracle Collaborative Planning exceptions window, by sending notification, or both
by selecting appropriate check boxes.

Save

In the final step of custom exception creation you can review all of the setup data
for your exception before saving it. After reviewing your exception and correcting
any errors, select Submit.

Edit Custom Exception
Complete the following steps to edit a custom exception:
1. From Oracle Collaborative Planning Home page, select Admin tab
2. Select Define Custom Exceptions from under Planner Tasks.
3. Search for your exception and select Go.
4

Select the exception you want to edit.

Copy Custom Exception
Complete the following steps to copy a custom exception:

1. From the Custom Definition Search window in Oracle Collaborative Planning,
find the exception you want to copy and select Copy.

2. On the Copy Exception page, enter a new exception name and description.

3. Select Submit.
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4, If the system copied the exception successfully, select OK.

Exception Thresholds

An exception threshold is a control limit placed on an exception condition. The
administrator user sets thresholds to adjust the sensitivity to a supply or demand
problem. For example, a sales order is considered late when the ship date is later
than the receipt date on the purchase order. The threshold describes the degree of
lateness, so that if the ship date is more than five days past the receipt date the
planner is notified of the problem. In this example, the threshold is set at five days
or greater.

Define Exception Thresholds

Complete the following steps to define an exception threshold:
1. From the Home page in Oracle Collaborative Planning select the Admin tab.

2. Select Define Exception Thresholds. You can also access Define Exception
Thresholds link from the Oracle Collaborative Planning Home page.

3. On the Define Exception Thresholds page, select an exception you want to edit
and select Edit. You can define thresholds for both predefined and custom
exceptions.

4. On the Define Exception Threshold Values page, select Add Another Row.
5. Select a value for the Assigned To field.

Note: The values in the Assigned To field are in order from least
restrictive to the most restrictive. For example, if you select All
Item-All Orgs-All Customers, the system assigns the notification to
all items for all organizations, for all customers. If you select
Item-Org-Customer Site, the system only assigns the notification to
a specific item, for a specific organization, for a specific customer
site.

6. Select an Item, Organization, Customer, Customer Site, and then enter a
Threshold Value.

7. Select Save.
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Note: If you define multiple thresholds for one exception, where
one threshold is a subset of another, Collaborative Planning
generates the exception for the more granular threshold.

Delete Exception Thresholds

Complete the following steps to delete an exception threshold:

1. From the Admin tab in Oracle Collaborative Planning, select Define Exception
Thresholds.

2. Select the exception you want to delete and select Edit.
3. Choose the threshold you want to delete and select Delete.

4. On the Warning page, select Yes to delete the threshold or No to return to the
Define Exception Threshold Values window.

Pegging
Supply and demand orders that are interrelated can be pegged or linked together.
The Pegging window enables you to track orders from your customer's purchase
order through your supplier's sales order to the supplier shipment and the
shipment's receipt at the customer site. By using pegging, you connect supply and
demand information through your orders.

Enter Pegging Information

To link two orders in Oracle Collaborative Planning you must specify the parent or
end-order’s information. The following list identifies and describes which end
order-related details should be specified on the new order:

= End order’s order type: Specify purchase order, sales order, order forecast, etc.
as appropriate.

s End order number: Enter the end order’s order number.

= End order publisher and publisher’s site: Enter the publisher of the end order
and the publisher’s site.

s Line number of the end order: Enter the line number on the end order if
applicable.
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= End order's release number (if applicable): If the end order has a release, specify
it in this field.

Note: If the end order line number is not set, Oracle Collaborative
Planning assumes that the item in the document is the same as the
one being referenced in the end order document. The pegging tree
shows all the lines associated with this item in the end order release
number.

Access Pegging Information

Complete the following steps to access the Pegging window:
1. From the Home page of Oracle Collaborative Planning, select the Planning tab.

2. On the Planning page, select Vertical View.

Note: You can also access pegging information from the
Exceptions tab, or by selecting an exception notification from the
Home page of Oracle Collaborative Planning. Select an exception
and then select Pegging to view end order information.

3. Search for your order.
4. Select your order and select the order number.

The Supply Chain Hierarchy describes the order’s genealogy, information, and
other pertinent information. The system displays such as the schedule impact,
receipt date, and quantity. Select the plus icon to view the end order’s information.

You can expand or contract the pegging information by selecting Expand All or
Collapse All, respectively.

View Pegging Information

The Pegging window can be used to track orders up and down the pegging tree.
For example, a user can peg up to the customer's purchase order to the end
manufacturer, and down to the supplier's shipment.

The applicable information is displayed for each order that is in the pegging tree.
The orders are automatically pegged to each other based on the end order numbers.
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From the pegging window, customers can infer how far their purchase order
information has traversed through the supply chain. For example, if there is no
supplier sales order displayed, a customer could infer that the supplier has not yet
committed to meeting the customer's demand.

Throughout the supply chain, customers can detect any date or quantity
mismatches against their purchase orders. They are able to track whether their
order shipped on time, whether it arrives by the need-by date, and whether the
right quantity shipped.
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Waterfall Analysis

This chapter discusses waterfall analysis and how it used in Oracle Collaborative
Planning. The following topics are addressed:

Overview of Waterfall Analysis on page 7-2
Setup on page 7-2
Upload Customer Forecasts on page 7-3

Search For and Compare Forecasts on page 7-3
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Overview of Waterfall Analysis

Setup

Waterfall analysis is a graphical and tabular display of successive iterations of a
forecast, generated at different points in time for comparison and analysis. You can
compare forecast to see how it has changed over time and examine the accuracy of
the forecast as it evolved. For example, waterfall analysis allows you to compare
and analyze a 6-month forecast generated in consecutive periods or months such as
January, February, and March. The following order types can be used in a waterfall
analysis: Sales forecast, Order forecast, and Supply commit.

The waterfall analysis capabilities Oracle Collaborative Planning enable you to:
s Retrieve and compare previous forecasts
» Track forecast changes over time

Forecast names can be used to indicate when forecasts were generated or the type of
forecast.

Examples of waterfall analysis include the following:

= You want to compare how a customer’s sales and order forecasts have changed
over time.

= You want to compare how a supplier’s supply commits have changed over
time.

To use waterfall analysis, the following steps must be completed:
1. Your customer publishes a forecast

2. Your customer revises and republishes the forecast with a different name (if
your customer republishes with the same name, the old file is overwritten)

3. You navigate to the Forecast comparison page on the Planning tab and search
for and select forecasts for comparison

4. You select, tabulate and graph forecasts to identify changes

The following image depicts the steps that must be completed to use waterfall
analysis:
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Customer publishes Customer revises
forecast and republishes
forecast
Tabulate and graph Search for and select
forecasts to identify |[~— forecasts for
changes comparison

Upload Customer Forecasts

Your customers can upload forecasts by completing the following steps:

1.
1.

2
3.
4

Navigate to the Load Supply/Demand page on the Admin tab.
Download supplydemand.dat

Prepare the template

Save and upload the flat file

Repeat these steps for the second forecast.

Search For and Compare Forecasts

To retrieve forecasts for comparison navigate to the Forecast Comparison page
(Oracle Collaborative Planning Home > Planning tab > Forecast Comparison) and
enter any of the following criteria in the Search window:

Item
Customer
Supplier
From Date
To Date
Order Type
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Select the forecasts you want to compare from the search results. After selecting
Compare Forecast, you can view a graphical comparison of the forecasts you chose.
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Horizontal and Advanced Horizontal View

This chapter discusses advanced horizontal view and how it used in Oracle
Collaborative Planning. The following topics are addressed:

Advanced Horizontal View Overview on page 8-2
Setup Advanced Horizontal View on page 8-2
Create Workbooks on page 8-3

Share Workbooks on page 8-4

View Workbooks on page 8-5

Horizontal View on page 8-5

Edit Order Quantities on page 8-7

Available Columns on page 8-8
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Advanced Horizontal View Overview

A horizontal view displays planning data over time. With advanced horizontal
view, you can select specific items using the search functionality. Advanced
horizontal view also enables you to graphically view your supply and demand
information.

Advanced Horizontal View enables you to do the following:

= Use Oracle Discoverer to query Oracle Collaborative Planning data
s Customize data display

»  Perform user-defined calculations

= Define end-user queries (administrators only)

= View and navigate reports and graphs

Advanced horizontal view enables you to manipulate display data using Oracle
Discoverer. You can group and aggregate your planning data in different ways and
define custom calculations for supplies and demands. The calculation is created in
terms of order types and the sum of the quantities of those order types. After a
custom view is created you can edit or delete any portion of your custom view. You
must be assigned the Supply Chain Collaboration Administrator responsibility to
set up a custom view. Advanced horizontal view enables you to:

= Search over the time horizon to view details or summaries of planning data.
= Search on items for collaboration information.

= Search organizations and sites for collaboration information.

Setup Advanced Horizontal View

To set up advanced horizontal view, your administrator must complete the
following steps:

»  Create new workbooks and specify report format

»  Select and arrange data elements

s Customize the workbooks and define filters and calculations
= Manage and share workbooks with other users

The following image depicts the administrator setup flow for advanced horizontal
view.
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Create new workbook and Select and arrange data
specify report format elements
Manage and share workbook Customize workbook, define
with other users filters and calculations

Create Workbooks

Complete the following steps to create a workbook:

1.
2.

© ®» N O

11.

From the Home page in Oracle Collaborative Planning, select the Admin tab.

In the Admin page, select Define Custom Bucketed View.

Note: When you select Custom View, the system launches Oracle
Discoverer.

In the Workbook Wizard, select Create a new workbook.
Select the type of view you want for the workbook.

Select the columns to display by choosing from the Available column.

Note: You can move an element back to the Available column
from the Selected column. After you select an element, you can
rearrange elements for your specific business needs.

Select Next.
Define your query conditions.
Select Next.

On the Format page, you can format data and your heading as well as editing
the heading.

. Select Next.

On the Conditions page, you can create a conditional statement. Select New.
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Note: Your conditional statement will limit information. Select OK
after completing your statement.

12. Select Next.

13. In the Calculations page, you can create a calculation for your condition. To
define calculations, enter information in the following fields:

» Calculation Name
= Show
s Calculation

Repeat this procedure for every calculation you want in your workbook.
14. Select Next.
15. On the Percentage page, you can create a percentage for your condition.
16. Select Next.
17. On the Totals page, you can summarize the results of your calculations.
18. Select Next.

19. On the Parameters page, you can enter parameters for your conditional
statement.

20. Select Finish. The system will now load your new workbook.

Share Workbooks

Workbooks can be shared with all users, including customers and suppliers. The
following information is required to share a workbook:

s Workbook name
s User(s) who will access the workbook

After you create a workbook you can share your workbook. To share your
workbook, complete the following steps:

1. With your new workbook open in Oracle Discoverer, navigate to Sharing under
Manage Workbooks.

2. Select users who you want to view the workbook.
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View Workbooks

Complete the following steps to view a workbook:

1.
2.

From the Home page in Oracle Collaborative Planning, select the Planning tab.

Select Custom View.

Note: Oracle Discoverer automatically launches when you select
Custom View.

Select the workbook you want to view.

To enter or change parameters for limiting a query over a time horizon, select
Options.

Enter the following information in the options window:
Query governor

Worksheets

Summary data

Fan-trap detection

End user layer access

Locale selection

Select Apply.

View the report.

Horizontal View

The seeded horizontal view enables you to view supply and demand information
over time. In order to use the horizontal view, you must create a preference set.

Preference Sets

Before you can view your supply and demand information in the horizontal view,
you must determine how to display the data. In Oracle Collaborative Planning, you
can create or edit a preference set that enables you to view your data in various
ways. For example, you can create a preference set to view data horizontally for
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only purchase orders and replenishments. A preference set enables you to do the
following:

Set aggregation with your company and trading partners
Display or hide order types
Arrange order types in the display

Specify time periods (time horizons) over which data is viewed and time
buckets

Arrange preference sets

Note: When Oracle Collaborative Planning passes information to
the horizontal view from different pages, the default preference set
you create filters that information. For example, if an order type
from Vendor Managed Inventory doesn't exist in your preference
set, then you cannot view that information in the horizontal view.

Complete the following steps to create a preference set:

1.

2
3.
4

From the Home page in Oracle Collaborative Planning, select the Admin tab.
Select Define User Preferences.

Select Create New Preference Set.

Enter information in the following required fields:

Preference Set Name

Company Aggregation

Trading Partner Aggregation

Graphing Options

Display Buckets

Select any order type(s) from the Available Order Types column and select
Move or Move All.
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8.

Note: The Sales Forecast order type can be used as standalone or
implicit pair with a trading partner's Sales Forecast. Customers and
suppliers can post this order type. You have the option of rendering
a response to a trading partner's sales forecast if your trading
partner has posted one to you. When the option is enabled, then the
horizontal view renders a Sales Forecast row. If the option is
disabled, then the horizontal view will not render the Sales Forecast
row.

In the Selected Order Types column, you can arrange your order types in
whatever order you wish. Select an order type and select either the up or down
arrows to move the order type within the column.

To set your preference as the default, select the set as the default preference set
option. You can make the preference step a public preference set. A public
preference set will be available to all users and cannot be made a default
preference set.

Select Save.

Complete the following steps to edit a preference set:

1.

2
3.
4

Select a preference set from the Preference Set Details window.
Select Go.
Edit your preference set.

Select Save.

Running Totals of Supply and Demand

You can tailor your horizontal plan preference set to enable the display of running
total demand and running total supply rows. When you do so, you must also
choose to display the Order Forecast and Supply Commit order types. Company
and trading partner aggregation is respected when displaying the running total
rows. Row totals are displayed after the last time period in the horizon.

Edit Order Quantities

You can edit order quantities in the horizontal view for orders your company
publish. The following order types can be edited in the horizontal view:
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= Sales forecast

= Sell through forecast
s Order forecast

= Supply commit

= Negotiated capacity
= Historical sales

If an order forecast is published by a customer to its supplier, the supplier will see a
rendered supply commit row (if it has not yet published a supply commit
response). The rendered supply commit row is editable, enabling the supplier to
acknowledge an order forecast by accepting the values in the supply commit row or
by modifying the values and saving changes.

Available Columns

There are several columns displayed using horizontal view. The following table lists
those columns and their descriptions:

Column Description

Items Items are set up using Oracle Inventory. For more information
about item setup, refer to Overview of Setup on page 2-2.

Customer (Sites) For more information about customer and customer site setup,
refer to Overview of Setup on page 2-2.

Supplier (Sites) For more information about supplier and supplier site setup,
refer to Overview of Setup on page 2-2.

Order Type For more information about supported order types in Oracle
Collaborative Planning, refer to Overview of Setup on page 2-2.

Net Forecast A calculated column that displays when Display Net Forecast
and Total Supply Commit is checked.

Net forecast in a bucket = [Order forecast - (PO + Requisitions +
ASNs] in a bucket.

Total Supply Commit A calculated column that displays when Display Net Forecast
and Total Supply Commit is checked. Net forecast in a bucket =
[Supply commit + sales orders)] in a bucket.
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Workflow

This chapter discusses the workflows associated with Oracle Collaborative
Planning. The following topics are addressed:

Using Oracle Workflow in Oracle Collaborative Planning on page 9-2
Setting Up Oracle Workflow in Oracle Collaborative Planning on page 9-2
Extending Workflows in Oracle Collaborative Planning on page 9-2
Viewing Processes in Oracle Workflow Builder on page 9-5

Seeded Data Files on page 9-6

Item Types on page 9-10

Workflow Processes Used In Oracle Collaborative Planning on page 9-28

Functions on page 9-43
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Using Oracle Workflow in Oracle Collaborative Planning

Oracle Workflow manages activities, executes functions, sends notifications,
maintains completed activity history, detects errors, and initiates error processes.

This appendix provides details about how Oracle Workflow is used in Oracle
Collaborative Planning to best meet your business needs. This appendix also
provides detailed information regarding the workflow processes that come seeded
with Oracle Collaborative Planning.

For information regarding implementation and setup of Oracle Workflow, refer to
the Oracle Workflow Guide.

Setting Up Oracle Workflow in Oracle Collaborative Planning

The Oracle Workflow Guide provides a list of setup steps for Oracle Workflow, and

explains the setup necessary for all modules. For example, the guide explains that
an access level of 100 in Oracle Workflow Builder is necessary. Do not change this
access level.

Warning: Oracle Corporation does not provide support if the
access level of 100 is changed.

For more information about extending the seeded Oracle Collaborative Planning
workflow processes, refer to.

For more information about setting up Oracle Workflow, refer to the Oracle Workflow
Guide.

Extending Workflows in Oracle Collaborative Planning

Overview

This section provides guidelines for extending the Oracle Collaborative Planning
seeded workflow processes to meet your business needs. Oracle Corporation
supports the extension of workflows. Extensions include using existing seeded
subprocesses and functions to build new workflow processes and modifying
parameters of a subprocess without changing process logic.

If the Oracle Collaborative Planning seeded workflows do not meet your business
processing needs, you can create new flows by using any of the following methods:
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Customizations

Copy a seeded workflow, change its internal name, display name, and
description in the Oracle Workflow Builder. Change the definition as desired.

Use the seeded flows as examples to create new flows using the seeded
functional processes in the Oracle Workflow Builder.

Use the seeded flows as examples to create new flows using the seeded
functional subprocesses and include your own custom activities in the Oracle
Workflow Builder.

Warning! Oracle Corporation provides support only for its
seeded activities, processes, and the types of extensions described
in this manual. Oracle Corporation does not provide support for
your custom activities and processes.

A customization changes the logic of the core application. Oracle Corporation does
not support customizations to seeded workflows. Examples of customizations
include:

Changing the basic logic of a seeded process. Adding or deleting activities from
a seeded process alters seeded data. However, you can however copy and
rename a process and then insert a notification function activity.

Modifying the integration of Oracle Collaborative Planning with another
application.

Warning! Customization refers to the modification of the logic
of a process or subprocess, and is not supported by Oracle
Corporation.

Exceptions
The following exceptions to customization are supported by Oracle Corporation:

You may change the item attribute OM WF Administrator to another
responsibility (it defaults as SYSADMIN).

You may tailor message bodies on seeded messages to meet your business
needs.
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= You can set the default error process of RETRY_ONLY on any new functions,
processes or flows that you define.

Note: The RETRY_ONLY error process supports retrying only of
the activity in an error state. RETRY_ONLY does not support
aborting the flow or skipping the activity in an error state. Do not
specify any other error process. Do not leave the error process field

empty.

For more information about extending workflows or to learn how to create your
own workflows, refer to the Oracle Workflow Guide.

Extending Workflow

When extending existing workflows to meet your business needs, always copy the
seeded process and rename both the internal and display names before modifying
the workflow. This process ensures that you do not modify seeded data. It also
prevents patches containing the.wft files (which contain all the seeded flows and
related information) from overriding your modifications.

Warning! If you modify any of Oracle Corporation’s seeded
workflow data, your changes are not supported. Any changes to
the seeded workflow data are overwritten when a patch
containing the.wft file is applied.

For example, you should not directly change a subprocess by adding or deleting
activities from it. Copy and rename what you want to change before making
modifications. Do not modify predefined data; this includes all function activities,
subprocesses, processes, and item attributes.

Always modify a copy of a subprocess instead of function activities. The subprocess
is designed to handle exceptions, and it may perform other functions as well.

Guidelines

When extending workflow processes to meet your business needs, stay within the
following guidelines:

= Always specify RETRY_ONLY as the default error process for any workflow
activity you define.
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Viewing Processes in Oracle Workflow Builder

For more details on creating and extending workflows refer to the Oracle Workflow
Guide.

Viewing Processes in Oracle Workflow Builder

From within the Oracle Workflow Builder you can view the different workflow
processes discussed in this appendix and their associated functions, messages,
subprocesses, notifications, and properties.

To view processes in Oracle Workflow Builder, complete the following steps:

1. Within Oracle Workflow Builder, select Open from the File menu, and connect
to the database.

2. Expand the data source, then select the item type branch within that data
source.

3. Expand the processes branch within your item type and select a process activity
to display the diagram of the process in a Process window.

The following image depicts the Oracle Workflow Builder:
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Seeded Data Files
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Seeded Data Files

Each of the Oracle Collaborative Planning seeded workflows and their associated
activities are contained in the following seeded data files:

»  mscxewf.wft
»  mscxudex.wft
= mscxnet.wft

»  mscxvmir.wft
»  mscxdprf.wft
»  mscxpbof.wft
»  mscxpbsc.wft
»  mscxresc.wft

»  mscxscem.wft
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Seeded Data Files

= mscxascp.wft

Seeded Data File mscxewf.wft

Item Types

The seeded data file mscxewf.wft contains the following item type:

= Workflows for Oracle Collaborative Planning Item Type on page 9-26

Processes
The seeded data file mscxewf.wft contains the following process:

=  Error Notifications for Excel Import of Forecast/Supply Process on page 9-29

Seeded Data File mscxudex.wft

Item Types
The seeded data file mscxudex.wft contains the following item type:

s MSC: User Define Exception Workflow Item Type on page 9-13

Processes
The seeded data file mscxudex.wft contains the following process:

»  User Define Exception Workflow Process on page 9-30

Seeded Data File mscxnet.wift

Item Types
The seeded data file mscxnet.wft contains the following item type:

= Supply/Demand Mismatch Item Type on page 9-24

Processes
The seeded data file mscxnet.wft contains the following process:

= Supply/Demand Mismatch Process on page 9-31
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Seeded Data Files

Seeded Data File msexvmir.wift

Item Types

The seeded data file mscxvmir.wft contains the following item type:

s Oracle Collaborative Planning VMI Replenishment Item Type on page 9-11

Processes
The seeded data file mscxvmir.wft contains the following process:

s Oracle Collaborative Planning VMI Replenishment Process on page 9-33

Seeded Data File mscxdprf.wft

Item Types
The seeded data file mscxdprf.wft contains the following item type:

= DP Receive Forecast Item Type on page 9-27

Processes
The seeded data file mscxdprf.wft contains the following process:

= DP Receive Forecast Process on page 9-36

Seeded Data File mscxpbof.wft

Item Types
The seeded data file mscxpbof.wft contains the following item type:

s Publish Order Forecast Item Type on page 9-23

Processes
The seeded data file mscxpbof.wft contains the following process:

s Publish Order Forecast Process on page 9-38
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Seeded Data Files

Seeded Data File mscxpbsc.wft

Item Types
The seeded data file mscxpbsc.wft contains the following item type:

= Publish Supply Commit Item Type on page 9-24

Processes
The seeded data file mscxpbsc.wft contains the following process:

s Publish Supply Commit Process on page 9-39

Seeded Data File mscxresc.wft

Item Types

The seeded data file mscxrcsc.wft contains the following item type:

»  Start Receive Supplier Capacity Item Type on page 9-23

Processes
The seeded data file mscxscem.wft contains the following process:

»  Start Receive Supplier Capacity Process on page 9-40

Seeded Data File mscxscem.wft

Item Types

The seeded data file mscxscem.wft contains the following item type:

»  Start SCEM Engine Item Type on page 9-23

Processes
The seeded data file mscxscem.wft contains the following process:

= Start SCEM Engine Process on page 9-42
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Seeded Data File mscxascp.wft

Item Types
The seeded data file mscxascp.wft contains the following item type:

»  Start ASCP Engine Item Type on page 9-22

Processes
The seeded data file mscxascp.wft contains the following process:

»  Start ASCP Engine Process on page 9-35

Item Types

The following section discusses the different item types used in Oracle
Collaborative Planning seeded workflows. Oracle Collaborative Planning contains
the following item types:

= Oracle Collaborative Planning VMI Replenishment Item Type on page 9-11
s MSC: User Define Exception Workflow Item Type on page 9-13

s Start ASCP Engine Item Type on page 9-22

s Start SCEM Engine Item Type on page 9-23

s Publish Order Forecast Item Type on page 9-23

= Start Receive Supplier Capacity Item Type on page 9-23

= Publish Supply Commit Item Type on page 9-24

= Supply/Demand Mismatch Item Type on page 9-24

= Workflows for Oracle Collaborative Planning Item Type on page 9-26

s DP Receive Forecast Item Type on page 9-27

= Standard

The different items types are contained in different seeded data workflow files.

To learn more about the Standard item type, refer to the Oracle Workflow Guide.
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Item Types

Oracle Collaborative Planning VMI Replenishment ltem Type

Currently there is one process associated with Oracle Collaborative Planning VMI
Replenishment:

s Oracle Collaborative Planning VMI Replenishment Process on page 9-33

The Oracle Collaborative Planning VMI Replenishment item type has several
attributes associated with it. These attributes reference information in the Oracle
Collaborative Planning application tables. The attributes are used and maintained
by function activities and notification activities throughout the process. The
following table lists the Oracle Collaborative Planning VMI Replenishment item
type attributes:

Length/Format/Lookup

Display Name Description Type Type/Frame Target

Replenish Time Fence The replenishment time fence Number None
multiplier.

Auto Release Flag Number None

Inventory Item ID The inventory identification Number None
number for the item.

Organization ID The organization identification Number None
number for the item.

Seller Name The selling company’s name. Role None

Buyer Name The buying company’s name. Role None

Plan ID Identification number of your Number None
plan.

Sr Instance ID Identification number of the SR~ Number None
Instance.

Supplier ID Identification number for the Number None
supplier.

Supplier Site ID Identification number for the Number None
supplier site.

Allocation Percent Allocation percent number. Number None

Order Quantity Quantity ordered. Number None

Total Allocated Onhand The total amount of allocated Number None
on-hand inventory.

Item Name The name of the item. Text None
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Length/Format/Lookup

Display Name Description Type Type/Frame Target

Requisition Transaction ID Identification number of the Number None
requisition transaction.

SCE Organization ID Identification number of the SCE  Number None
organization.

SCE Supplier ID Identification number of the SCE  Number None
supplier.

SCE Supplier Site ID Identification number of the SCE  Number None
supplier site.

Customer Name The customer’s name. Text None

Customer Site Name The name of the customer site. Text None

Supplier Name The name of the supplier. Text None

Supplier Site Name The name of the supplier site. Text None

Replenishment Transaction ID  Identification number of the Number None
replenishment.

Supplier Item Name Name of an item provided by the Text None
supplier.

Customer Item Name Name of an item provided by the Text None
customer.

Item Description A text description of an item. Text None

Allocated Onhand Quantity The amount of allocated on-hand Number None
inventory.

Minimum MinMax Quantity =~ The minimum amount of an item Number None
required in inventory before
replenishment is necessary.

Maximum MinMax Quantity =~ The maximum amount of Number None
inventory that can be held or
replenished.

Customer UOM Code The customer’s code for units of  Text None
measure.

Supplier UOM Code The supplier’s code for units of ~ Text None

measure.
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MSC: User Define Exception Workflow Item Type

Currently there is one process associated with MSC: User Define Exception

Workflow:

= User Define Exception Workflow Process on page 9-30

The MSC: User Define Exception Workflow item type has several attributes
associated with it. These attributes reference information in the Oracle Collaborative
Planning application tables. The attributes are used and maintained by function
activities and notification activities throughout the process. The following table lists
the MSC: User Define Exception Workflow item type attributes:

Length/Format/Lookup

Display Name Description Type Type/Frame Target

Exception Group The assigned group for the Text 80
user-defined exception.

Exception Name The user-assigned name of the Text 80
exception.

Exception Type The type of the user-defined Number None
exception.

Exception Detail ID Identification number of the Number None
user-defined exception detail.

Transaction ID Identification number of the Number None
transaction.

Customer Transaction ID The customer’s transaction Number None
identification number.

Supplier Transaction ID The supplier’s transaction Number None
identification number.

Details URL The URL for the exception URL Full Window
details.

Notification Title The title assigned to the Text 2000
exception.

Exception Exist Indicates whether any exceptions Number None
exist.

Company: Days Early Days early at the company. Number None

Company: Days Late Days late for the company. Number None

Company: Quantity Excess Quantity excess for the company. Number None
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Length/Format/Lookup

Display Name Description Type Type/Frame Target

Company: Quantity Shortage  Quantity shortage for the Number None
company.

Customer: End Order Release End order release number for the Text 240

Number customer.

Customer: Order Number Customer order number. Text 240

Company: Average Annual Average annual demand for the =~ Number None

Demand company.

Company: Bill Of Lading The company’s bill of lading. Text 30

Company: Bucket Type The bucket type for the company. Text 20

Company: Carrier Code The carrier code for the company. Text 30

Company: Category The category for the company. Text 200

Company: Need By Date The need by date for the Date None
company.

Company: Published Date The published date for the Date None
company.

Company: Document Owner  The document owner site for the  Text 40

Site company.

Company: Receipt Date The receipt date for the company. Date None

Company: Request Date The request date for the company. Date None

Company: Container Quantity The container quantity for the Number None
company.

Company: Container Type The container type for the Text 20
company.

Company: Customer Address The customer address for the Text 240
company.

Customer: Item Description The item description for the Text 240
customer.

Company: Customer Item The customer item for the Text 240
company.

Company: Customer Site The customer site for the Text 40
company.

Customer: Average Annual The average annual demand for =~ Number None

Demand

the customer.
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Item Types

Length/Format/Lookup

Display Name Description Type Type/Frame Target

Customer: Bill Of Lading The bill of lading number for the = Text 30

Number customer.

Customer: Bucket Type The bucket type for the customer. Text 10

Customer: Carrier Code The carrier code for the customer. Text 30

Customer: Container Quantity The container quantity for the Number None
customer.

Customer: Container Type The container type for the Text 20
customer.

Customer: Designator The designator for the customer. ~ Text 100

Customer: End Order Line The end order line number for Text 20

Number the customer.

Customer: End Order Number The end order number for the Text 240
customer.

Customer: End Order The end order publisher name for Text 255

Publisher Name the customer.

Customer: End Order The end order publisher site Text 30

Publisher Site Name name for the customer.

Customer: Inventory Status The inventory status for the Text 20
customer.

Customer: Item Category The item category for the Text 250
customer.

Customer: Line Code The line code for the customer. Text 30

Customer: New Schedule Date The new schedule date for the Date None
customer.

Company: Order Placement The order placement date for the Date None

Date company.

Customer: Order Line The order line number for the Text 20

Number customer.

Company: Originally The original promise date for the Date None

Promised Date company.

Customer: Owning Site The owning site for the customer. Text 30

Customer: Planner Code The planner code for the Text 10

customer.
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Length/Format/Lookup

Display Name Description Type Type/Frame Target

Customer: Planning Group The planning group for the Text 30
customer.

Customer: Posting Party The posting party for the Text 255
customer.

Customer: Primary Quantity =~ The primary quantity for the Number None
customer.

Customer: Primary UOM The primary unit of measure for ~ Text 3
the customer.

Customer: Project Number The project number for the Text 30
customer.

Company: Customer Quantity The customer quantity for the Number None
company.

Customer: Receipt Date The receipt date for the customer. Date None

Customer: Order Release The order release number for the Text 20

Number customer.

Customer: Release Status The release status for the Number None
customer.

Customer: Request Date The request date for the customer. Date None

Customer: Serial Number The serial number for the Text 255
customer.

Company: Ship Date The ship date for the company. Date None

Customer: Ship From Address The ship from address for the Text 240
customer.

Customer: Ship From Party The ship from party for the Text 255
customer.

Customer: Ship From Party The ship from party site for the ~ Text 30

Site customer.

Customer: Shipping Method ~ The shipping method for the Text 30
customer.

Customer: Ship To Address The ship to address for the Text 240
customer.

Customer: Ship To Party The ship to party for the Text 255
customer.
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Length/Format/Lookup

Display Name Description Type Type/Frame Target

Customer: Ship To Party Site  The ship to party site for the Text 30
customer.

Customer: Task Number The task number for the Text 30
customer.

Customer: Trading Partner The trading partner unit of Text 3

UOM Code measure code for the customer.

Customer: Tracking Number  The tracking number for the Text 100
customer.

Customer: Unit Number The unit number for the Text 30
customer.

Customer: UOM Code The unit of measure code for the  Text 3
customer.

Customer: Vehicle Number The vehicle number for the Text 30
customer.

Customer: Document Version The document version for the Text 40
customer.

Company: Customer The company’s customer. Text 250

Company: Designator The company’s designator. Text 100

Company: End Order Line The end order line number for Text 20

Number the company.

Company: End Order Number The end order number for the Text 240
company.

Company: End Order The end order publisher name for Text 255

Publisher Name the company.

Company: End Order The end order publisher site Text 30

Publisher Site Name name for the company:.

Company: End Order Release = The end order release number for Text 20

Number the company.

Company: Inventory Status The company’s inventory status.  Text 20

Company: Item Description The company’s item description.  Text 240

Notification Body The body text of the notification = Text 4000
being sent.

Company: Line Code The line code for the company. Text 30
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Length/Format/Lookup

Display Name Description Type Type/Frame Target

Company: Line Number The line number for the company. Text 240

Company: Order Number The order number for the Text 240
company.

Company: Release Number The release number for the Text 20
company.

Company: Owner Item The owner item description for Text 240

Description the company.

Company: Owner Item The owner item for the company. Text 250

Company: Owning Site Name The owning site name for the Text 30
company.

Company: Planner Code The company’s planner code. Text 30

Company: Planning Group The planning group for the Text 30
company.

Company: Posting Party The company’s posting party’s Text 255

Name name.

Company: Project Number The project number for the Text 30
company.

Company: Publisher Address The publisher address for the Text 240
company.

Company: Document Owner  The company’s document owner. Text 255

Company: Order Type Desc The company’s order type Text 80
description.

Company: Quantity The quantity for the company:. Number None

Company: Release Status The release status for the Number None
company.

Company: Serial Number The serial number for the Text 40
company.

Company: Ship From Address The ship from address for the Text 240
company.

Company: Shipping Party The shipping part for the Text 255
company.

Company: Ship from party site The ship from party site for the Text 40

company.
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Length/Format/Lookup

Display Name Description Type Type/Frame Target

Company: Ship Method The ship method for the Text 30
company.

Company: Ship To Address The ship to address for the Text 240
company.

Company: Ship To Party The ship to party for the Text 255
company.

Company: Ship to Party site The ship to party site for the Text 40
company.

Supplier: Average Annual The average annual demand for =~ Number None

Demand the supplier.

Supplier: Bill Of Lading The bill of lading for the supplier. Text 30

Number

Supplier: Bucket Type The bucket type for the supplier.  Text 10

Supplier: Carrier Code The carrier code for the supplier.  Text 30

Supplier: Item Category The item category for the Text 250
supplier.

Supplier: Container Quantity ~ The container quantity for the Number None
supplier.

Supplier: Container Type The container type for the Text 20
supplier.

Supplier: Designator The designator for the supplier. ~ Text 100

Supplier End Order Number = The end order number for the Text 240
supplier.

Supplier: End Order Line The end order line number for Text 20

Number the supplier.

Supplier: End Order Publisher The end order publisher name for Text 255

Name the supplier.

Supplier: End Order Publisher The end order publisher site Text 30

Slte Name name for the supplier.

Supplier End Order Release The end order release number for Text 20

Number the supplier.

Supplier: Full Lead time The full lead time for the Text 20
supplier.
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Length/Format/Lookup

Display Name Description Type Type/Frame Target

Supplier: Inventory Status The inventory status for the Text 20
supplier.

Supplier: Line Code The line code for the supplier. Text 30

Supplier: New Schedule Date  The new schedule date for the Date None
supplier.

Supplier: Order Number The order number for the Text 240
supplier.

Supplier: Order Line Number The order line number for the Text 20
supplier.

Supplier: Originally Promised The original promise date for the Date None

Date supplier.

Supplier: Owning Site Name  The owning site name for the Text 30
supplier.

Supplier: Planner Code The planner code for the supplier. Text 10

Supplier: Planing Group The planning group for the Text 30
supplier.

Supplier: Posting Party The posting party for the Text 255
supplier.

Supplier: Primary Quantity The primary quantity for the Number None
supplier.

Supplier: Primary UOM The primary unit of measure for ~ Text 3
the supplier.

Supplier: Project Number The project number for the Text 30
supplier.

Supplier: Supplier Quantity The supplier quantity for the Number None
supplier.

Supplier: Receipt Date The receipt date for the supplier. Date None

Supplier: Release Order The release order number for the Text 20

Number supplier.

Supplier: Release Status The release status for the Number None
supplier.

Supplier: Request Date The request date for the supplier. Date None
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Length/Format/Lookup

Display Name Description Type Type/Frame Target

Supplier: Serial Number The serial number for the Text 255
supplier.

Supplier: Ship Date The ship date for the supplier. Date None

Supplier: Ship From Address  The ship from address for the Text 240
supplier.

Supplier: Ship From Party The ship from party for the Text 255
supplier.

Supplier: Ship From Party Site The ship from party site for the =~ Text 30
supplier.

Supplier: Ship Method The ship method for the supplier. Text 30

Supplier: Ship To Address The ship to address for the Text 240
supplier.

Supplier: Ship To Party The ship to party for the supplier. Text 255

Supplier: Ship To Party Site The ship to party site for the Text 30
supplier.

Supplier: Task Number The task number for the supplier. Text 30

Supplier: Trading Partner The trading partner unit of Text 3

UOM Code measure for the supplier.

Supplier: Tracking number The tracking number for the Text 100
supplier.

Supplier: Unit Number The unit number for the supplier. Text 30

Supplier: UOM Code The unit of measure code for the = Text 3
supplier.

Supplier: Vehicle Number The vehicle number for the Text 30
supplier.

Supplier: Document Version =~ The document version for the Text 40
supplier.

Company: Supplier Address  The supplier address for the Text 240
company.

Supplier: Item Description The item description for the Text 240
supplier.

Company: Supplier Item The supplier item for the Text 250
company.

Workflow 9-21



Item Types

Length/Format/Lookup

Display Name Description Type Type/Frame Target
Company: Supplier The company’s supplier. Text 255
Company: Supplier Site The company’s supplier’s site. Text 30
Company: Task Number The company’s task number. Text 30
Company: Trading Partner The company’s trading partner ~ Text 240
Item Description item description.
Company: Trading Partner The company’s trading partner Text 3
UOM unit of measure.
Company: Tracking Number  The tracking number for the Text 240

company.
Company: Order Type The order type for the company. ~ Number None
Company: UOM The unit of measure used by the = Text 3

company.
Company: Vehicle Number The company’s vehicle number.  Text 30
Company: Version The version for the company. Text 240
Company: Unit Number The company’s unit number. Text 30

Start ASCP Engine ltem Type

This item type manages the Start ASCP Engine workflow process.

Currently there is one process associated with Start ASCP Engine:

= Start ASCP Engine Process on page 9-35

The Start ASCP Engine item type has one attribute associated with it. This attribute
references information in the Oracle Collaborative Planning application tables. The
attribute is used and maintained by function activities and notification activities
throughout the process. The following table lists the Start ASCP Engine item type

attribute:
Length/Format/Lookup
Display Name Description Type Type/Frame Target
Constrained Plan Flag The constrained plan flag Number None

number.
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Start SCEM Engine Item Type

Currently there is one process associated with Start SCEM Engine:
= Start SCEM Engine Process on page 9-42
The Start SCEM Engine item type has no attributes associated with it.

Publish Order Forecast ltem Type

Currently there is one process associated with Publish Order Forecast:
»  Publish Order Forecast Process on page 9-38

The Publish Order Forecast item type has one attribute associated with it. This
attribute references information in the Oracle Collaborative Planning application
tables. The attribute is used and maintained by function activities and notification
activities throughout the process. The following table lists the Publish Order
Forecast item type attribute:

Length/Format/Lookup
Display Name Description Type Type/Frame Target
Plan ID The identification number for the Number None

plan.

Start Receive Supplier Capacity ltem Type

Currently there is one process associated with Start Receive Supplier Capacity:
»  Start Receive Supplier Capacity Process on page 9-40

The Start Receive Supplier Capacity item type has several attributes associated with
it. These attributes reference information in the Oracle Collaborative Planning
application tables. The attributes are used and maintained by function activities and
notification activities throughout the process. The following table lists the Start
Receive Supplier Capacity item type attributes:

Length/Format/Lookup
Display Name Description Type Type/Frame Target
Start Date The specified start date. Date None
End Date The specified end date. Date None

Workflow 9-23



Item Types

Length/Format/Lookup

Display Name Description Type Type/Frame Target
Supplier ID The identification number for the Number None

supplier.
Notification to Trading Partner The notification issued to a Text None

trading partner.
Trading Partner Name The name of your trading Text None

partner.
Notification Recipient Role The role of the assigned recipient Text None

of a notification.
Request ID The identification number of the ~ Number None

request.

Publish Supply Commit Iltem Type

Currently there is one process associated with Publish Supply Commit:
s Publish Supply Commit Process on page 9-39

The Publish Supply Commit item type has one attribute associated with it. This
attribute references information in the Oracle Collaborative Planning application
tables. The attribute is used and maintained by function activities and notification
activities throughout the process. The following table lists the Publish Supply
Commit item type attribute:

Length/Format/Lookup
Display Name Description Type Type/Frame Target
Plan ID The identification number of the  Number None

specified plan.

Supply/Demand Mismatch Item Type
Currently there is one process associated with Supply /Demand Mismatch:
= Supply/Demand Mismatch Process on page 9-31

The Supply/Demand Mismatch item type has several attributes associated with it.
These attributes reference information in the Oracle Collaborative Planning
application tables. The attributes are used and maintained by function activities and
notification activities throughout the process. The following table lists the
Supply/Demand Mismatch item type attributes:
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Length/Format/Lookup
Display Name Description Type Type/Frame Target
Salute Salute Text None
Slogan Slogan Text None
Company ID The company’s identification Number None
number.
Company Name The company’s name. Text None
Company Site ID The identification number of the  Number None
company site.
Company Site Name The company site name. Text None
Supplier ID The supplier’s identification Number None
number.
Supplier Name The supplier’s name. Text None
Supplier Site ID The supplier site identification Number None
number.
Supplier Site Name The name of the supplier site. Text None
Supplier Item Name The supplier’s name of the item.  Text None
Customer ID The customer’s identification Number None
number.
Customer Name The customer’s name. Text None
Customer Site ID The identification number of the  Number None
customer site.
Customer Site Name The name of the customer site. Text None
Customer Item Name The customer’s name of the item. Text None
Item ID The item identification number. Number None
Item Name The item name. Text None
Item Description The item description. Text None
Exception Type The type assigned to the Number None
exception.
Quantity The item quantity. Number None
Quantityl Number None
Quantity2 Number None
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Length/Format/Lookup
Display Name Description Type Type/Frame Target
Transaction ID1 Number None
Transaction ID2 Number None
Threshold Number None
Lead Time The specified necessary lead time. Number None
Item Min Qty Minimum item quantity Number None
Item Max Qty Maximum item quantity Number None
Datel The actual date Date None
Date2 Date None
Date3 Date None
Order Creation Datel Date None
Order Creation Date2 Date None
Forward To Username The planner’s username. Text 100
Notification Message Name The name of the notification Text None
message to be sent.

Event Name The name of the event. Text None
Item Key The item key. Text None
Exception Description The description of the exception.  Text None
Order Number The order number. Text None
Release Number The release number. Text None
Line Number The line number. Text None
End Order Number The end order number. Text None
End Order Release Number The end order release number. Text None
End Order Line Number The end order line number. Text None
Planner The planner name. Text None

Workflows for Oracle Collaborative Planning ltem Type

Currently there is one process associated with Workflows for Oracle Collaborative
Planning:
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= Error Notifications for Excel Import of Forecast/Supply Process on page 9-29

The Workflows for Oracle Collaborative Planning item type has several attributes
associated with it. These attributes reference information in the Oracle Collaborative
Planning application tables. The attributes are used and maintained by function
activities and notification activities throughout the process. The following table lists
the Workflows for Oracle Collaborative Planning item type attributes:

Length/Format/Lookup

Display Name Description Type Type/Frame Target
Forward to Username The planner’s username. Text 100
Error message The name used for the error Text 240

message.
Document Creation Date The date of the document Date None

creation.
Error list String containing the errors for Text 4000

the planner.
Transaction type The transaction type. Text 100
Plan name The name of the plan. Text 240
Number of Planners Contains the number of planners Number None

in an organization.
Partner Site ID The identification number of the  Number None

partner site.
Header ID Parent header identification Number None

number.
Number of visits The number of visits Number None
Publisher's organization The publisher’s organization. Text 255
File to Upload Name of the file to be uploaded.  Text 80

DP Receive Forecast ltem Type

Currently there is one process associated with DP Receive Forecast:
s DP Receive Forecast Process on page 9-36

The DP Receive Forecast item type has several attributes associated with it. These
attributes reference information in the Oracle Collaborative Planning application
tables. The attributes are used and maintained by function activities and notification
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activities throughout the process. The following table lists the DP Receive Forecast
item type attributes:

Length/Format/Lookup

Display Name Description Type Type/Frame Target
Customer ID The customer identification Number None

number.
Start Date The workflow start date. Date None
Notification to Trading Partner The notification text sent to the Text None

trading partner.
Trading Partner Name The name of the trading partner ~ Text None
Notification Recipient Role The role of the notification’s Text None

recipient.
Horizon Days The amount of days on the Number None

horizon.
Request ID The request identification Number None

number.

Workflow Processes Used In Oracle Collaborative Planning

Oracle Collaborative Planning comes seeded with the following workflow
processes:

= Error Notifications for Excel Import of Forecast/Supply Process on page 9-29
s User Define Exception Workflow Process on page 9-30

= Supply/Demand Mismatch Process on page 9-31

s Oracle Collaborative Planning VMI Replenishment Process on page 9-33

= Start ASCP Engine Process on page 9-35

s DP Receive Forecast Process on page 9-36

»  Publish Order Forecast Process on page 9-38

s Publish Supply Commit Process on page 9-39

= Start Receive Supplier Capacity Process on page 9-40

= Start SCEM Engine Process on page 9-42
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Error Notifications for Excel Import of Forecast/Supply Process

This process sends notification when you conduct flat file or XML loads to Oracle
Collaborative Planning and when loading a supply/demand flat file or loading an
XML file adhering to 000_sync_forecast_001.dtd.

The Error Notifications for Excel Import of Forecast/Supply process is contained in
the Seeded Data File mscxewf.wft on page 9-7 and is associated with the Workflows
for Oracle Collaborative Planning Item Type on page 9-26.

Summary of the Error Notifications for Excel Import of Forecast/Supply Process

To view the properties of the Error Notifications for Excel Import of
Forecast/Supply process, select the process in the navigator tree and then select
Properties from the Edit menu. This process is runnable, which indicates that it can
be assigned to a transaction type.

The Details property page of the process activity indicates that Error Notifications
for Excel Import of Forecast/Supply has an error item type of WFERROR. This item
type is associated with the RETRY_ONLY error process. The purpose of this error
handling process is to alert an administrator when an error occurs in a process and
prompt the administrator to retry the process in error. This error process is initiated
only when an unexpected error with Oracle Workflow is encountered in the process.

When you display the Process window for the Error Notifications for Excel Import
of Forecast/Supply, you see that the process consists of 3 unique activities, which
comprise the 3 nodes that appear in the workflow diagram. The following diagram
depicts the Error Notifications for Excel Import of Forecast/Supply. Each node of
this process is numbered for referencing.
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Send notification Matify Planner End

The Error Notifications for Excel Import of Forecast/Supply workflow begins at
node 1 with the Send Notification event.
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The workflow then proceeds to the Notify Planning notification activity in node 2.
After notification is sent, the process continues on to the End activity in node 3 on
page 9-52.

Error Notifications for Excel Import of Forecast/Supply Activities

The following table provides descriptions of each activity in Error Notifications for
Excel Import of Forecast/Supply.

For more information about the individual activities, refer to Functions on

page 9-43.
Activity Function Result Type Required
End on page 9-52 WF_STANDARD.NOOP None Yes

User Define Exception Workflow Process

In this process, a user-defined custom exception is run and generates a number of
results (exceptions). For each generated exception, a notification is sent to the
recipient of the exception. The workflow is called for each generated exception. The
recipients and subject of the notification can be specified in the Custom Exceptions
recipients page.

The User Define Exception Workflow process is contained in the Seeded Data File
mscxudex.wft on page 9-7 and is associated with the MSC: User Define Exception
Workflow Item Type on page 9-13.

Summary of the User Define Exception Workflow Process

To view the properties of the User Define Exception Workflow process, select the
process in the navigator tree and then select Properties from the Edit menu. This
process is runnable.

The Details property page of the process activity indicates that User Define
Exception Workflow has an error item type of WFERROR. This item type is
associated with the RETRY_ONLY error process. The purpose of this error handling
process is to alert an administrator when an error occurs in a process and prompt
the administrator to retry the process in error. This error process is initiated only
when an unexpected error with Oracle Workflow is encountered in the process.

When you display the Process window for the User Define Exception Workflow,
you see that the process consists of 3 unique activities, which comprise the 3 nodes
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that appear in the workflow diagram. The following diagram depicts the User
Define Exception Workflow. Each node of this process is numbered for referencing.

7 ¥ 7
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Start Send Exceplion End
Motification

The User Define Exception Workflow workflow begins at node 1 with the Start
activity on page 9-53.

The workflow then proceeds to the Send Exception Notification activity in node 2
on page 9-46. After the activity is complete, the process continues on to the End
activity in node 3 on page 9-52.

User Define Exception Workflow Activities

The following table provides descriptions of each activity in User Define Exception
Workflow.

For more information about individual activities, refer to Functions on page 9-43.

Activity Function Result Type Required
Start on page 9-53 WE_STANDARD.NOOP None Yes

Send Exception MSC_X_USER_EXCEP_GEN.SEND_ None Yes
Notification on page 9-46 NTF

End on page 9-52 WEF_STANDARD.NOOP None Yes

Supply/Demand Mismatch Process

This process is the Supply Chain Event Manager Exceptions notification workflow.

The Supply/Demand Mismatch process is contained in the Seeded Data File
mscxnet.wft on page 9-7 and is associated with the Supply /Demand Mismatch Item
Type on page 9-24.
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Summary of the Supply/Demand Mismatch Process

To view the properties of the Supply/Demand Mismatch process, select the process
in the navigator tree and then select Properties from the Edit menu. This process is
runnable.

The Details property page of the process activity indicates that Supply/Demand
Mismatch has an error item type of WFERROR. This item type is associated with
the RETRY_ONLY error process. The purpose of this error handling process is to
alert an administrator when an error occurs in a process and prompt the
administrator to retry the process in error. This error process is initiated only when
an unexpected error with Oracle Workflow is encountered in the process.

When you display the Process window for the Supply/Demand Mismatch, you see
that the process consists of 3 unique activities, which comprise the 3 nodes that
appear in the workflow diagram. The following diagram depicts the

Supply /Demand Mismatch workflow. Each node of this process is numbered for
referencing.
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event

The Supply/Demand Mismatch workflow begins at node 1 with the Netting
Exception Event.

The workflow then proceeds to the Send Out Exceptions activity in node 2 on
page 9-50. After the activity is complete, the process continues on to the End activity
in node 3 on page 9-52.

Supply/Demand Mismatch Activities

The following table provides descriptions of each activity in Supply/Demand
Mismatch.

For more information about individual activities, refer to Functions on page 9-43.
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Activity Function Result Type Required
Start on page 9-53 WE_STANDARD.NOOP None Yes

Send Out Exceptions on ~ WF_STANDARD.NOTIFY None Yes

page 9-50

End on page 9-52 WEF_STANDARD.NOOP None Yes

Oracle Collaborative Planning VMI Replenishment Process

This process is the workflow for the VMI replenishment engine.

The Oracle Collaborative Planning VMI Replenishment process is contained in the
Seeded Data File mscxvmir.wft on page 9-8 and is associated with the Oracle
Collaborative Planning VMI Replenishment Item Type on page 9-11.

Summary of the Oracle Collaborative Planning VMI Replenishment Process

To view the properties of the Oracle Collaborative Planning VMI Replenishment
process, select the process in the navigator tree and then select Properties from the
Edit menu. This process is runnable.

The Details property page of the process activity indicates that Oracle Collaborative
Planning VMI Replenishment has an error item type of WFERROR. This item type
is associated with the RETRY_ONLY error process. The purpose of this error
handling process is to alert an administrator when an error occurs in a process and
prompt the administrator to retry the process in error. This error process is initiated
only when an unexpected error with Oracle Workflow is encountered in the process.

When you display the Process window for Oracle Collaborative Planning VMI
Replenishment, you see that the process consists of 9 unique activities, which
comprise the 9 nodes that appear in the workflow diagram. The following diagram
depicts the Oracle Collaborative Planning VMI Replenishment. Each node of this
process is numbered for referencing.
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The Oracle Collaborative Planning VMI Replenishment workflow begins at node 1
with the Start activity on page 9-53.

The workflow then proceeds to the Create Replenishment activity at node 2 on
page 9-44. After the activity is complete, the process continues to the Can Seller
Approve? activity at node 3 on page 9-44. If there is a Yes result, the process moves
to the End activity at node 4 on page 9-45. If there is a No result, the process moves
to the Request for Approval message activity at node 5. If approval is granted, the
process moves to Release Replenishment at node 8 on page 9-46, then moves on to
the End activity in node 9 on page 9-52. If the request is rejected, the process moves
to the Reject Replenishment at node 6 on page 9-45, and then to the End activity in
node 9 on page 9-52.

Oracle Collaborative Planning VMI Replenishment Activities

The following table provides descriptions of each activity in Oracle Collaborative
Planning VMI Replenishment.

For more information about individual activities, refer to Functions on page 9-43.

Activity Function Result Type Required
Start on page 9-53 WF_STANDARD.NOOP None Yes
Create Replenishment on MSC_X_REPLENISH.VMI_ None Yes

page 9-44 REPLENISH

Can Seller Approve? on ~ MSC_X_REPLENISH.IS_SELLER_ Yes/No Yes

page 9-44 APPROVE

9-34 Oracle Collaborative Planning Implementation and User’s Guide



Workflow Processes Used In Oracle Collaborative Planning

Activity Function Result Type Required
Is Auto Release? on MSC_X_REPLENISH.IS_AUTO_ Yes/No Yes

page 9-45 RELEASE

Release Replenishment MSC_X_REPLENISH.VMI_RELEASE None Yes

on page 9-46

Reject Replenishment on  MSC_X_REPLENISH.VMI_REJECT  None Yes

page 9-45

End on page 9-52 WEF_STANDARD.NOOP None Yes

Start ASCP Engine Process

This process facilitates the automation of launching an ASCP plan after receiving an
order forecast or supply commit from Oracle Collaborative Planning.

The Start ASCP Engine process is contained in the Seeded Data File mscxascp.wft
on page 9-10 and is associated with the Start ASCP Engine Item Type on page 9-22.

Summary of the Start ASCP Engine Process

To view the properties of the Start ASCP Engine process, select the process in the
navigator tree and then select Properties from the Edit menu. This process is
runnable.

The Details property page of the process activity indicates that Start ASCP Engine
has an error item type of WFERROR. This item type is associated with the RETRY_
ONLY error process. The purpose of this error handling process is to alert an
administrator when an error occurs in a process and prompt the administrator to
retry the process in error. This error process is initiated only when an unexpected
error with Oracle Workflow is encountered in the process.

When you display the Process window for the Start ASCP Engine, you see that the
process consists of 3 unique activities, which comprise the 3 nodes that appear in
the workflow diagram. The following diagram depicts the Start ASCP Engine. Each
node of this process is numbered for referencing.
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The Start ASCP Engine workflow begins at node 1 with the Start activity on
page 9-53.

The workflow then proceeds to the Launch ASCP Engine activity in node 2 on
page 9-47. After the activity is complete, the process continues on to the End activity
in node 3 on page 9-52.

Start ASCP Engine Activities
The following table provides descriptions of each activity in Start ASCP Engine.

For more information about individual activities, refer to Functions on page 9-43.

Activity Function Result Type Required
Start on page 9-53 WE_STANDARD.NOOP None Yes
Launch ASCP Engine on MSC_X_CP_FLOW.LAUNCH_ None Yes

page 9-47 ASCP_ENGINE

End on page 9-52 WEF_STANDARD.NOOP None Yes

DP Receive Forecast Process

This process facilitates receiving forecasts from Oracle Demand Planning into
Oracle Collaborative Planning.

The DP Receive Forecast process is contained in the Seeded Data File mscxdprf.wft
on page 9-8 and is associated with the DP Receive Forecast Item Type on page 9-27.

Summary of the DP Receive Forecast Process

To view the properties of the DP Receive Forecast process, select the process in the
navigator tree and then select Properties from the Edit menu. This process is
runnable.
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The Details property page of the process activity indicates that DP Receive Forecast
has an error item type of WFERROR. This item type is associated with the RETRY_
ONLY error process. The purpose of this error handling process is to alert an
administrator when an error occurs in a process and prompt the administrator to
retry the process in error. This error process is initiated only when an unexpected
error with Oracle Workflow is encountered in the process.

When you display the Process window for the DP Receive Forecast, you see that the
process consists of 3 unique activities, which comprise the 3 nodes that appear in
the workflow diagram. The following diagram depicts DP Receive Forecast. Each
node of this process is numbered for referencing.
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The DP Receive Forecast workflow begins at node 1 with the Start activity on
page 9-53.

The workflow then proceeds to the Launch DP Receive Forecast activity in node 2
on page 9-52. After the activity is complete, notification is sent at node 3. The
process then continues on to the End activity in node 4 on page 9-52.

DP Receive Forecast Activities
The following table provides descriptions of each activity in DP Receive Forecast.

For more information about individual activities, refer to Functions on page 9-43.

Activity Function Result Type Required
Start on page 9-53 WF_STANDARD.NOOP None Yes
Launch DP Receive MSC_X_CP_FLOW.DP_Receive_ None Yes
Forecast on page 9-52 Forecast

End on page 9-52 WEF_STANDARD.NOOP None Yes
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Publish Order Forecast Process

This process facilitates the automatic launch of the Publish Order Forecast program
from Planner Workbench.

The Publish Order Forecast process is contained in the Seeded Data File
mscxpbof.wft on page 9-8 and is associated with the Publish Order Forecast Item
Type on page 9-23.

Summary of the Publish Order Forecast Process

To view the properties of the Publish Order Forecast process, select the process in
the navigator tree and then select Properties from the Edit menu. This process is
runnable.

The Details property page of the process activity indicates that Publish Order
Forecast has an error item type of WFERROR. This item type is associated with the
RETRY_ONLY error process. The purpose of this error handling process is to alert
an administrator when an error occurs in a process and prompt the administrator to
retry the process in error. This error process is initiated only when an unexpected
error with Oracle Workflow is encountered in the process.

When you display the Process window for the Publish Order Forecast, you see that
the process consists of 3 unique activities, which comprise the 3 nodes that appear
in the workflow diagram. The following diagram depicts Publish Order Forecast.
Each node of this process is numbered for referencing.
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The Publish Order Forecast workflow begins at node 1 with the Start activity on
page 9-53.

The workflow then proceeds to the Launch Publish Order Forecast on page 9-48
activity in node 2. After the activity is complete, the process continues to the End
activity at node 3 on page 9-52.
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Publish Order Forecast Activities
The following table provides descriptions of each activity in Publish Order Forecast.

For more information about individual activities, refer to Functions on page 9-43.

Activity Function Result Type Required
Start on page 9-53 WE_STANDARD.NOOP None Yes
Launch Publish Order MSC_X_CP_FLOW.PUBLISH_ None Yes
Forecast on page 9-48 ORDER_FORECAST

End on page 9-52 WEF_STANDARD.NOOP None Yes

Publish Supply Commit Process

This process facilitates the automatic launch of the Publish Supply Commit
program from the Planner Workbench.

The Publish Supply Commit process is contained in the Seeded Data File
mscxpbsc.wft on page 9-9 and is associated with the Publish Supply Commit Item
Type on page 9-24.

Summary of the Publish Supply Commit Process

To view the properties of the Publish Supply Commit process, select the process in
the navigator tree and then select Properties from the Edit menu. This process is
runnable.

The Details property page of the process activity indicates that Publish Supply
Commit has an error item type of WFERROR. This item type is associated with the
RETRY_ONLY error process. The purpose of this error handling process is to alert
an administrator when an error occurs in a process and prompt the administrator to
retry the process in error. This error process is initiated only when an unexpected
error with Oracle Workflow is encountered in the process.

When you display the Process window for the Publish Supply Commit, you see that
the process consists of 3 unique activities, which comprise the 3 nodes that appear
in the workflow diagram. The following diagram depicts the Publish Supply
Commit. Each node of this process is numbered for referencing.
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The Publish Supply Commit workflow begins at node 1 with the Start activity on
page 9-53.

The workflow then proceeds to the Launch Publish Supply Commit on page 9-49
activity in node 2. After the activity is complete, the process continues on to the End
activity in node 3 on page 9-52.

Publish Supply Commit Activities

The following table provides descriptions of each activity in Publish Supply
Commit.

For more information about individual activities, refer to Functions on page 9-43.

Activity Function Result Type Required
Start on page 9-53 WF_STANDARD.NOOP None Yes
Launch Publish Supply =~ MSC_X_CP_FLOW.PUBLISH_ None Yes
Commit on page 9-49 SUPPLY_COMMITS

End on page 9-52 WEF_STANDARD.NOOP None Yes

Start Receive Supplier Capacity Process

This process facilitates the automatic start of the Receive Supplier Capacity program
when a supply commit is loaded into Oracle Advanced Supply Chain Planning.

The Start Receive Supplier Capacity process is contained in the Seeded Data File
mscxresc.wit on page 9-9 and is associated with the Start Receive Supplier Capacity
Item Type on page 9-23.
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Summary of the Start Receive Supplier Capacity Process

To view the properties of the Start Receive Supplier Capacity process, select the
process in the navigator tree and then select Properties from the Edit menu. This
process is runnable.

The Details property page of the process activity indicates that Start Receive
Supplier Capacity has an error item type of WFERROR. This item type is associated
with the RETRY_ONLY error process. The purpose of this error handling process is
to alert an administrator when an error occurs in a process and prompt the
administrator to retry the process in error. This error process is initiated only when
an unexpected error with Oracle Workflow is encountered in the process.

When you display the Process window for the Start Receive Supplier Capacity, you
see that the process consists of 4 unique activities, which comprise the 4 nodes that
appear in the workflow diagram. The following diagram depicts the Start Receive
Supplier Capacity. Each node of this process is numbered for referencing.
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The Start Receive Supplier Capacity workflow begins at node 1 with the Start
activity on page 9-53.

The workflow then proceeds to the Launch Receive Supplier Capacity activity in
node 2 on page 9-48. After the activity is complete, notification is sent at node 3. The
process continues on to the End activity in node 4 on page 9-52.

Start Receive Supplier Capacity Activities

The following table provides descriptions of each activity in Start Receive Supplier
Capacity.

For more information about individual activities, refer to Functions on page 9-43.
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Activity Function Result Type Required
Start on page 9-53 WEF_STANDARD.NOOP None Yes
Launch Receive Supplier MSC_X_CP_FLOW.RECEIVE_ None Yes
Capacity on page 9-48 SUPPLIER_CAPACITY

End on page 9-52 WF_STANDARD.NOOP None Yes

Start SCEM Engine Process

This process facilitates the automatic launch of the supply chain event manager
when an order forecast or supply commit is loaded into Oracle Collaborative
Planning.

The Start SCEM Engine process is contained in the Seeded Data File mscxscem.wft
on page 9-9 and is associated with the Start SCEM Engine Item Type on page 9-23.

Summary of the Start SCEM Engine Process

To view the properties of the Start SCEM Engine process, select the process in the
navigator tree and then select Properties from the Edit menu. This process is
runnable.

The Details property page of the process activity indicates that Start SCEM Engine
has an error item type of WFERROR. This item type is associated with the RETRY_
ONLY error process. The purpose of this error handling process is to alert an
administrator when an error occurs in a process and prompt the administrator to
retry the process in error. This error process is initiated only when an unexpected
error with Oracle Workflow is encountered in the process.

When you display the Process window for the Start SCEM Engine, you see that the
process consists of 3 unique activities, which comprise the 3 nodes that appear in
the workflow diagram. The following diagram depicts the Start SCEM Engine
workflow. Each node of this process is numbered for referencing.
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The Start SCEM Engine workflow begins at node 1 with the Start activity on
page 9-53.

The workflow then proceeds to the Launch SCEM Engine activity in node 2 on
page 9-47. After the activity is complete, the process continues on to the End activity
in node 3 on page 9-52.

Start SCEM Engine Activities
The following table provides descriptions of each activity in Start SCEM Engine.

For more information about individual activities, refer to Functions on page 9-43.

Activity Function Result Type Required
Start on page 9-53 WEF_STANDARD.NOOP None Yes
Launch SCEM Engine on MSC_X_CP_FLOW.LAUNCH_ None Yes

page 9-47 SCEM_ENGINE

End on page 9-52 WF_STANDARD.NOOP None Yes

The following section discusses the functions contained in the workflow processes
used by Oracle Collaborative Planning. The functions are discussed according to
their associated item types:

Workflow 9-43



Functions

Oracle Collaborative Planning VMI Replenishment Functions

Can Seller Approve?

The Can Seller Approve? activity is a Workflows for Oracle Collaborative Planning
activity that determines whether a seller can approve a VMI replenishment.

The Can Seller Approve? activity calls the PL/SQL procedure named MSC_X_
REPLENISH.IS_SELLER_APPROVE.

The Can Seller Approve? has a result type of Yes/No. The result of this activity will
be either Yes or No.

The following image depicts the Can Seller Approve? activity:

Can Seller &pprove?

The Can Seller Approve? activity is contained in the Seeded Data File mscxvmir.wft
on page 9-8, and is associated with the Oracle Collaborative Planning VMI
Replenishment Item Type on page 9-11.

Create Replenishment

The Create Replenishment activity is a Oracle Collaborative Planning VMI
Replenishment activity that creates a VMI replenishment.

The Create Replenishment activity calls the PL/SQL procedure named MSC_X_
REPLENISH.VMI_REPLENISH.

The following image depicts the Create Replenishment activity:

%*

Create
Replenishment
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The Create Replenishment activity is contained in the Seeded Data File
mscxvmir.wft on page 9-8, and is associated with theOracle Collaborative Planning
VMI Replenishment Item Type on page 9-11.

Is Auto Release?

The Is Auto Release? activity is a Oracle Collaborative Planning VMI
Replenishment activity that determines whether an VMI replenishment is eligible
for auto release.

The Is Auto Release? activity calls the PL/SQL procedure named MSC_X_
REPLENISH.IS_ AUTO_RELEASE.

Is Auto Release? has a result type of Yes/No. The result of this activity will be either
Yes or No.

The following image depicts the Is Auto Release? activity:

Iz &uto Release?

The Is Auto Release? activity is contained in the Seeded Data File mscxvmir.wft on
page 9-8, and is associated with the Oracle Collaborative Planning VMI
Replenishment Item Type on page 9-11.

Reject Replenishment

The Reject Replenishment activity is a Oracle Collaborative Planning VMI
Replenishment activity that rejects a VMI replenishment request.

The Reject Replenishment activity calls the PL/SQL procedure named MSC_X_
REPLENISH.VMI_REJECT.

The following image depicts the Reject Replenishment activity:

%

Reject
Replenishment
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Reject Replenishment activity is contained in the Seeded Data File mscxvmir.wft on
page 9-8, and is associated with the Oracle Collaborative Planning VMI
Replenishment Item Type on page 9-11.

Release Replenishment
The Release Replenishment activity is a Oracle Collaborative Planning VMI
Replenishment activity that releases a VMI replenishment.

The Release Replenishment activity calls the PL/SQL procedure named MSC_X_
REPLENISH.VMI_RELEASE.

The following image depicts the Release Replenishment activity:

|

Release
Replenizhrment

The Release Replenishment activity is contained in the Seeded Data File
mscxvmir.wft on page 9-8, and is associated with the Oracle Collaborative Planning
VMI Replenishment Item Type on page 9-11.

MSC: User Define Exception Workflow Functions

Send Exception Notification

The Send Exception Notification activity is a MSC: User Define Exception activity
that sends an exception notification.

The Send Exception Notification activity calls the PL/SQL procedure named MSC_
X_USER_EXCEP_GEN.SEND_NTF .

The following image depicts the Send Exception Notification activity:

Send Exception
Motification
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The Send Exception Notification activity is contained in the Seeded Data File
mscxudex.wft on page 9-7, and is associated with the MSC: User Define Exception
Workflow Item Type on page 9-13.

Start ASCP Engine Functions

Launch ASCP Engine

The Launch ASCP Engine activity is a Start ASCP Engine activity that launches the
ASCP Engine.

The Launch ASCP Engine activity calls the PL/SQL procedure named MSC_X_CP_
FLOW.Launch_ASCP_Engine.

The following image depicts the Launch ASCP Engine activity:

%

Launch A5CP
Engire

The Launch ASCP Engine activity is contained in the Seeded Data File
mscxascp.wft on page 9-10, and is associated with the Start ASCP Engine Item Type
on page 9-22.

Start SCEM Engine Functions

Launch SCEM Engine
The Launch SCEM Engine activity is a Start SCEM Engine activity that launches the
SCEM Engine.

The Launch SCEM Engine activity calls the PL/SQL procedure named MSC_X_CP_
FLOW.Launch_SCEM_Engine.

The following image depicts the Launch SCEM Engine activity:
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L

Launch SCEM
Engine

The Launch SCEM Engine activity is contained in the Seeded Data File
mscxscem.wft on page 9-9, and is associated with the Start SCEM Engine Item Type
on page 9-23.

Publish Order Forecast Functions

Launch Publish Order Forecast

The Launch Publish Order Forecast activity is a Publish Order Forecast activity that
publishes an order forecast.

The Launch Publish Order Forecast activity calls the PL/SQL procedure named
msc_x_cp_flow.publish order_forecast.

The following image depicts the Launch Publish Order Forecast activity:

%

Launch Publish
Order Forecast

The Launch Publish Order Forecast activity is contained in the Seeded Data File
mscxpbof.wft on page 9-8, and is associated with the Publish Order Forecast Item
Type on page 9-23.

Start Receive Supplier Capacity Functions

Launch Receive Supplier Capacity

The Launch Receive Supplier Capacity activity is a Start Receive Supplier Capacity
activity that launches the SCEM Engine.
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The Launch Receive Supplier Capacity activity calls the PL/SQL procedure named
msc_x_cp_flow.Receive_Supplier_Capacity.

The following image depicts the Launch Receive Supplier Capacity activity:

%

Launch Receive
Supplier Capacity

The Launch Receive Supplier Capacity activity is contained in the Seeded Data File
mscxresc.wit on page 9-9, and is associated with the Start Receive Supplier Capacity
Item Type on page 9-23.

Publish Supply Commit Functions

Launch Publish Supply Commit
The Launch Publish Supply Commit activity is a Publish Supply Commit activity
that publishes a supply commit to Oracle Collaborative Planning.

The Launch Publish Supply Commit activity calls the PL/SQL procedure named
msc_x_cp_flow.publish_supply_ commits.

The following image depicts the Launch Publish Supply Commit activity:

%
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The Launch Publish Supply Commit activity is contained in the Seeded Data File
mscxpbsc.wft on page 9-9, and is associated with the Publish Supply Commit Item
Type on page 9-24.

Workflow 9-49



Functions

Supply/Demand Mismatch Functions

Send Out Exceptions

The Send Out Exceptions activity is a Supply /Demand Mismatch activity that
sends out exceptions.

The Send Out Exceptions activity calls the PL/SQL procedure named WF_
STANDARD.NOTIFY.

The following image depicts the Send Out Exceptions activity:

%

Send Out Exceptions

The Send Out Exceptions activity is contained in the Seeded Data File mscxnet.wft
on page 9-7, and is associated with the Supply/Demand Mismatch Item Type on
page 9-24.

Workflows for Oracle Collaborative Planning Functions

Build Error Message

The Build Error Message activity is a Workflows for Oracle Collaborative Planning
activity that builds an error message for a planner.

The Build Error Message activity calls the PL/SQL procedure named MSC_SCE_
WF .BUILD_ERR_MSG.

The following image depicts the Build Error Message activity:

%

Build Error Meszage
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The Build Error Message activity is contained in the Seeded Data File mscxewf. wft
on page 9-7, and is associated with the Workflows for Oracle Collaborative Planning
Item Type on page 9-26.

Clean Up

The Clean Up activity is a Workflows for Oracle Collaborative Planning activity that
closes all open cursors.

The Clean Up activity calls the PL/SQL procedure named MSC_SCE_WF .CLOSE_
CURSOR.

The following image depicts the Clean Up activity:

%

Clean up

The Clean Up activity is contained in the Seeded Data File mscxewf.wft on page 9-7,
and is associated with the Workflows for Oracle Collaborative Planning Item Type
on page 9-26..

Determine Planners

The Determine Planners activity is a Workflows for Oracle Collaborative Planning
activity that determines the planners corresponding to a party.

The Determine Planners activity calls the PL/SQL procedure named MSC_SCE_
WF . DETERMINE_PLANNERS.

The following image depicts the Determine Planners activity:

%

Build Error Meszage

The Determine Planners activity is contained in the Seeded Data File mscxewf.wft
on page 9-7, and is associated with the Workflows for Oracle Collaborative Planning
Item Type on page 9-26..
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DP Receive Forecast Functions

Launch DP Receive Forecast

The Launch DP Receive Forecast activity is a DP Receive Forecast activity that
receives an Oracle Demand Planning forecast into Oracle Collaborative Planning.

The Launch DP Receive Forecast activity calls the PL/SQL procedure named MSC_
X_CP_FLOW.DP_Receive_Forecast.

The following image depicts the Launch DP Receive Forecast activity:

%

Launch DF Receive
Forecast

The Launch DP Receive Forecast activity is contained in the Seeded Data File
mscxdprf.wft on page 9-8, and is associated with the DP Receive Forecast Item Type
on page 9-27.

Standard Functions

Oracle Workflow provides some generic activities you can use to control your
processes. The activities are associated with the Standard item type but can be used
with any process you define. The Standard item type is automatically installed on
your Oracle Workflow server. The following are the Standard activities used by
Oracle Collaborative Planning. For more information about the Oracle Workflow
Standard activities, refer to the Oracle Workflow Guide.

End

The End activity marks the end of a process and does not perform any action. You
can use it to return a result for a completed process by specifying a Result Type for
the activity. Although it is not necessary, you may include it in your process
diagram to visually mark the end of your process as a separate node.

The following image depicts the End activity:
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@

End
The End activity calls the PL/SQL procedure named WF_STANDARD . NOOP.
Start
The Start activity marks the start of a process and does not perform any action.

Although it is not necessary, you may include it in your process diagram to visually
mark the start of a process as a separate node.

The following image depicts the Start activity:

Start

The Start activity calls the PL/SQL procedure named WF_STANDARD . NOOP.
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Profile Options

This appendix lists the profile options associated with Oracle Collaborative
Planning. The following topics is addressed:

= Profile Options on page A-2

Profile Options A-1



Profile Options

Profile Options

The following table lists the profile options used by Oracle Collaborative Planning.
Valid values, default values and profile option descriptions are also listed in the

table.
Default

Profile Option Valid Values  Value Description

MSC: CP Debug Debug-Off/ Debug - Controls the level of detail in the

Level Debug-On/ High concurrent program log messages for

Debug-High Collaborative Planning. Off = no

debug messages are generated; On =
short debug messages are generated;
High = detailed debug messages are
generated.

MSC: SCEM None/Load/ All Launches the Supply Chain Event

Engine Launch Publish/All Manager when data is loaded,

Events published, or both.

MSC: New Supply A valid ASCP  Null ASCP plan launched when a supplier

Commit Auto Plan Plan provides supply commits to Oracle
Collaborative Planning. This should be
a constrained plan.

MSC: Launch Yes/No Yes Determines if notification messages are

Workflow-Enabled sent when an Oracle Collaborative

Exception Message Planning exception is generated.

Notifications

MSC: New A valid ASCP  Null ASCP plan launched when a customer

Forecast Auto Plan Plan provided forecast into Oracle
Collaborative Planing. This plan
should be unconstrained.

MSC: APS/APS & APS Indicates whether Oracle Collaborative

Configuration CP/CP Planning is deployed. If it is deployed
together with an Oracle ERP instance
use APS & CP. If it is standalone use
CP.

MSC: Operator Your company Not Provides the name of the company that

Company Name name Applicable deployed Collaborative Planning. All

subsequent supply and demand
records loaded for this company
should use this value.

A-2 Oracle Collaborative Planning Implementation and User’s Guide



Profile Options

Default
Profile Option Valid Values Value Description
MSC: Vertical View Yes/No Yes Used by Oracle Collaborative Planning
Default Query to determine whether default results
are displayed for the vertical view.
MSC: VMI Default Yes/No Yes Used by Oracle Collaborative Planning
Query to determine whether default results
are displayed in the vendor managed
inventory window.
MSC: Purchase Promise Promise Date Determines the date used by planning
Order Dock Date Date/Need By as the dock date of a purchase order.
Calculation Date
Preference
MSC: ATP Demand Enables you to decide which allocation
Allocation Method  Priority /User- method to use.
Defined
Allocation
Percentage
MSC: Class Demand Class
Hierarchy
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Troubleshooting

This appendix discusses common errors you might encounter when using Oracle
Collaborative Planning. The following topics are addressed:

Loading Data on page B-2

Vertical View on page B-3

Vendor Managed Inventory on page B-3
Horizontal View on page B-4

Security Rules on page B-4

Exceptions on page B-4

XML Gateway on page B-5
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Loading Data

Loading Data

The following table lists issues you might encounter while loading data and their

solutions.

Problem

Solution

You successfully uploaded an order
forecast using supplydemand.dat, but you
cannot view data in any Oracle
Collaborative Planning screens.

Run the Build Collaborative Planning Calendar
concurrent program. Without this calendar file,
uploads in weekly or monthly buckets fail.

You attempted to upload an order
forecast using supplydemand.dat but
received a Publisher is Not Valid error
message.

The system cannot find a match between the
value for publisher and valid customer and
supplier values. Verify that MSC:Operator
Company Name matches the Publisher value.
Verify that Customer Name in Oracle Order
Management or Supplier Name in Oracle
Purchasing matches the Publisher value.

You uploaded supplydemand.dat and
received a Publisher Site is Not Valid
error message.

The system cannot find an exact match between
the publisher site value and a valid inventory
organization, customer site, or supplier site.
Verify that Customer Site in Oracle Order
Management or Supplier Site in Oracle
Purchasing matches the value used for
publisher site.

You uploaded supplydemand.dat with sync
indicator D to delete records. The records
still appear in the vertical view.

For each record that you want to delete, you
must provide: item, publisher, publisher site,
supplier, supplier site (or customer, customer
site for sales orders), and order type.

For purchase orders, sales orders and ASNSs,
you must also provide:

s Order number

= Release number

= Key date

= Line number

=  End order number

s End order line number
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Vendor Managed Inventory

Problem

Solution

You successfully uploaded
supplydemand.dat with allocated onhand
records. After uploading serialnumber.dat,
you are unable to navigate to the serial
number screen in Oracle Collaborative
Planning.

Your item must be serial-controlled. Verify that
you have set the serial controlled flag to Yes in
the item master.

Vertical View

The following table lists issues you might encounter while using vertical view in
Oracle Collaborative Planning. Solutions are also listed in the table.

Problem

Solution

You are unable to update the date or
quantity for a record in the vertical view.

You can only update a record in the vertical
view if your company is the publisher of the
record or if the publisher of the record provides
you with update privileges. Update privileges
are granted using security rules.

Your customer successfully published an
order forecast but you are unable to view
any records in Oracle Collaborative
Planning.

The system is unable to determine which
company’s user you are. The system
administrator must run collections with the
Enable User-Company Association parameter
set to Yes.

Vendor Managed Inventory

The following table lists issues you might encounter while using vendor managed
inventory in Oracle Collaborative Planning. Solutions are also listed in the table.

Problem

Solution

Purchase order releases were created in
Oracle Purchasing for Vendor Managed
Inventory items, but they do not appear
on the Vendor Managed Inventory screen.

Only Vendor Managed Inventory-enabled items
appear in the Vendor Managed Inventory
screen. Verify whether the item is Vendor
Managed Inventory- enabled in the Approved
Supplier List.

New purchase orders appear only after the
collections program runs.
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Problem Solution

You set up a blanket purchase order fora You must associate a planner with the Vendor
Vendor Managed Inventory item but no Managed Inventory item. Define planners in
purchase releases are created after you Oracle Inventory.

approved replenishments in the Vendor

Managed Inventory screen.

Horizontal View

The following table lists issues you might encounter while using horizontal view in
Oracle Collaborative Planning. Solutions are also listed in the table.

Problem Solution

You set your preferences to display the To view a Purchase Order/Sales Order graph
Planned Supply/Planned Demand graph you must include the order types Purchase
but are unable to view the graph in the Order and Sales Order in your preference set.

horizontal view. Select the order forecast and supply commit

order types for display.

Security Rules

The following table lists issues you might encounter while using security rules in
Oracle Collaborative Planning. Solutions are also listed in the table.

Problem Solution

You defined a group and its member Your company must be included in a group
companies. You also created a security even if you defined the group and its members.
rule that gives viewing privileges to Add your company to the group using

members of the group. You are unable to  groupcompany.dat.
view any records that group members
should see in the vertical view.

Exceptions

The following table lists issues you might encounter while using exceptions in
Oracle Collaborative Planning. Solutions are also listed in the table.
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Problem Solution

You can view exceptions but are not 1. You must be an item planner or listed as a

receiving any notifications. site contact to receive exception
notifications.

2. Verify in the workflow mailer configuration
file that the AUTOCLOSE_FYI parameter is
set to No.

XML Gateway

The following table lists issues you might encounter while using XML Gateway in
Oracle Collaborative Planning. Solutions are also listed in the table.

Problem Solution

The XML Gateway execution engine fails Review the error messages of the log file located

to process XML messages. ECX: Log File Path profile option. Review ECX_
OBJECTS and verify that 000_sync_fore-cast_
001.dtd is loaded. Review ECX_OBJECTS and
verify that a map is loaded.
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XML

This appendix discusses XML transactions and Oracle Collaborative Planning. The
following topics are addressed:

s Overview of XML on page C-2

s XML Transactions on page C-2

s Set Up XML Gateway on page C-3

= Legacy Integration Loads on page C-3
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Overview of XML

Overview of XML

Oracle Collaborative Planning enables trading partners to establish and maintain an
electronic relationship by transmitting order information via XML. Oracle
Collaborative Planning is capable of receiving as well as sending XML compliant
documents for supply and demand transactions.

Any supply chain participant, with an established trading partner relationship, can
post transactions to Oracle Collaborative Planning. Based on the specifications
embedded in an XML transaction, Oracle Collaborative Planning can interpret
supply and demand order information.

The execution engine is an XML Gateway execution engine interfaces with the
Oracle e-Business Suite to retrieve data from, and populate data into, tables

XML Transactions

There are two major ways by which you can populate Oracle Collaborative
Planning using XML.

= Supply/Demand load
= Legacy Integration Load

Supply/Demand Load

Like loading flat file, you can communicate supply demand transactions using XML
with Oracle Collaborative Planning. By this, your data is populated directly in
Oracle Collaborative Planning. You can post different order types used in
Collaborative Planning, such as sales forecast, purchase order, sales order, order
forecast, or supply commit must be specified in the XML document.

The DTD (Document Type Definition) used for Supply/Demand XML loads is
000_sync_forecast_001.dtd

Some of the key fields in the Supply/Demand XML load are:

s Order’s change status or Sync indicator (R: Replace or Add, D: Delete)

s Order type

s Order number

= Line number

s Customer’s name and site
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= Supplier’s name and site

s ltem
s Quantity
= UOM

s Date information (Ship Date, Receipt Date)

s Shipment information (Ship From or Ship To information)
= Version (if applicable)

s Forecast name (if applicable)

For more information about XML, contact your System Administrator or review the
DTD. The content of an XML transaction for supply and demand information is
similar to flat file loads for supply and demand. You can download the OA
Template using Oracle Collaborative Planning. The supplydemand.dat flat file can be
used as a template for the content of an XML transaction. For more information
about downloading and uploading flat files into Oracle Collaborative Planning,
refer to Loading and Publishing Data on page 2-30.

Set Up XML Gateway

Perform the following steps to set up XML Gateway:

= Set up the profile ECX: Log File Path with a valid path. Include this path in the
utl_file_dir parameter in the init.ora file.

= Set up the profile ECX: System Administrator e-mail Address with the e-mail
address of the error notification recipient.

Legacy Integration Loads

Another type of XML transaction available in Oracle Collaborative Planning is
called Legacy Integration Loads. The difference between Legacy Integration loads
and Supply/Demand loads is that all data loaded through Legacy Integration loads
is also available to other Oracle Advanced Planning products such as Oracle
Advanced Supply Chain Planning. In Legacy Integration loads data from XML
documents are first loaded to interface tables for Oracle Advanced Supply Chain
Planning and then the appropriate data is transferred to Oracle Collaborative
Planning.
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There are separate DTDs used for different entities. Contact your system
administrator to find the right DTD for your transaction.

XML Legacy Integration loads are most suitable for synchronizing setup data
among instances and among trading partners. Supply/Demand loads are most
suitable for communicating supply and demand transactions among trading
partners.
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Key Tables

This appendix lists and describes key tables used in Oracle Collaborative Planning.
The following topic is addressed:

= Key Tables on page D-2
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Key Tables

Key Tables

The following table lists the key tables used in Oracle Collaborative Planning. Their
descriptions are also listed.

Table Name Description

MSC_SUP_DEM_ENTRIES Stores supplies and demands in Oracle
Collaborative Planning. Data is loaded into this table
using:

= Flat file loads

= XML loads

s Collections from ERP

= Manually through the user interface

= Publish processes in Oracle Advanced Supply
Chain Planning and Oracle Demand Planning

MSC_COMPANIES Stores list of companies. The company name in the
profile option MSC: Operator Company Name is
seeded in this table as Company_ID=1.

MSC_COMPANY_SITES Stores the list of company sites. Sites may be
customer sites, supplier sites, or inventory
organizations.

MSC_COMPANY_RELATIONSHIPS  Stores the relationships between companies in
Oracle Collaborative Planning.

MSC_x_EXCEPTION_DETAILS Stores the exceptions generated by the Supply Chain
Event Manager, Custom Exceptions, and VMI
Replenishment Engine.

MSC_SECURITY_RULES Stores security rules defined in Oracle Collaborative
Planning.

MSC_TRADING_PARTNER_MAPS  Stores maps between company and company sites
with trading partner and trading partner sites.

MSC_ITEMS Stores the repository of items.

MSC_SYSTEM_ITEMS Stores the items for each Organization and Instance
combination.

MSC_SUP_DEM_HISTORY Stores the history of transactions. Whenever data is

loaded to MSC_SUP_DEM_ENTRIES, existing
records are transferred to the MSC_SUP_DEM_
HISTORY for archiving.
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Table Name Description

MSC_ITEM_SUPPLIERS Stores relationships between company items and
supplier items.

MSC_ITEM_CUSTOMERS Stores relationships between company items and
customer items.
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allocated on-hand

Inventory amount posted by a trading partner indicating the quantity of inventory
physically in stock that is intended for the use of the trading partner receiving the
communication. The date be used by the trading partner for this order type is
Actual Date. This indicates the physical inventory held by the trading partner for
the intended purpose.

API

An application programming interface (API) is a published interface to accomplish
a business or scientific function. An API defines a contract to its users by
guaranteeing a published interface but hides it’s implementation details.
assembly

An item that has a bill of material. You can purchase or manufacture an assembly
item. see assemble-to-order, bill of material.

available to promise (ATP)

Refers to the ability to promise finished goods availability based on a statement of
current and planned material supply.

ATP

See available to promise.

available capacity

The amount of capacity available for a resource or production line.
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available to promise (ATP)

The quantity of current on-hand stock, outstanding receipts and planned
production which has not been committed through a reservation or placing
demand. In Oracle Inventory, you define the types of supply and demand that
should be included in your ATP calculation.

available-to-promise rule

A set of Yes/No options for various entities that the user enters in Oracle Inventory.
The combination of the various entities are used to define what is considered
supply and demand when calculating available to promise quantity.

basic ATP

This term is used to describe the task of performing an ATP check against a given
organization.

bill of distribution

Specifies a multilevel replenishment network of warehouses, distribution centers,
and manufacturing centers (plants).

bill of material

A list of component items associated with a parent item and information about how
each item relates to the parent item. Oracle Manufacturing supports standard,
model, option class, and planning bills. The item information on a bill depends on
the item type and bill type. The most common type of bill is a standard bill of
material. A standard bill of material lists the components associated with a product
or subassembly. It specifies the required quantity for each component plus other
information to control work in process, material planning, and other Oracle
Manufacturing functions. Also known as product structures.

bill of resources
A list of each resource and/or production line required to build an assembly, model,
or option.

calculate ATP

An item attribute the planning process uses to decide when to calculate and print
available to promise (ATP) for the item on the Planning Detail Report. The planning
process calculates ATP using the following formula:

ATP = Planned production - committed demand.



calendar type

The period pattern used to define a manufacturing calendar.

capable to promise

CTP (Capable to Promise) refers to the additional ability to determine the
availability of component materials and resources to meet unplanned demands.
capacity requirements planning

A time-phased plan comparing required capacity to available capacity, based on a
material requirements plan and department/resource information. See
routing-based capacity and rate-based capacity.

component demand

Demand passed down from a parent assembly to a component.

component item

An item associated with a parent item on a bill of material.

compression days

The number of days the planning process suggests you compress the order (in other
words, reduce the time between the start date and the due date).

discrete job

Discrete jobs are used to manufacture assemblies using specific materials and
resources within a start and end date. (Also known as work order or assembly
order).

end item

Any item that can be ordered or sold. See finished good and product.

engineering change order (ECO)

A record of revisions to one or more items usually released by engineering.

firm planned order

An MRP-planned order that is firmed using the Planner Workbench. This allows the
planner to firm portions of the material plan without creating discrete jobs or
purchase requisitions. Unlike a firm order, a MRP firm planned order does not
create a natural time fence for an item.
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forecast

An estimate of future demand on inventory items. A forecast contains information
on the original and current forecast quantities (before and after consumption), the
confidence factor, and any specific customer information. You can assign any
number of inventory items to the forecast and use the same item in multiple
forecasts. For each inventory item you specify any number of forecast entries.

historical sales

Used by a customer to communicate to supplier the actual sales for a given item,
location, and period combination. The date that used by the customer is the Actual
Date, as an indication of when the sale actual took place.

independent demand

Demand for an item unrelated to the demand for other items.

item routing

A sequence of manufacturing operations that you perform to manufacture an
assembly. A routing consists of an item, a series of operations, an operation
sequence, and operation effective dates. Edits to an Item Routing do not
automatically update a job routing.

material constrained plan

In this plan, all material constraints that can be specified in the form of a supply
schedule from manufacturing plants or by statements of vendor capacity from
vendors are considered. When material availability is not a concern, resource
availability constraints are used only to generate exceptions arising due to over
utilization or under-utilization of resources.

material and resource constrained plan
In this plan, you can generate a plan that respects material, resource, and
transportation constraints. However, no plan objectives are considered.

need-by date

The need-by date for the end item is the demand date. The need-by dates for the
dependent demands are calculated based on the lead-time offsets that are associated
to the Items and routings used.

= Ifaconstrained plan is run, the planning process will use the planned orders and
actual routings for scheduling to derive the suggested due date.



= If an unconstrained plan is run, the suggested due date will simply be the same
as the need by date.

Therefore, any differences between the lead time offsets (need by date) and actual
manufacturing time (suggested due date) created by the planning process, will
show up in the form of multiple exception messages.

negotiated capacity

Used by a supplier to communicate to a customer the capability to produce a
quantity of a certain item at a given location and time period. This capacity may be
negotiated as part of a contract and is for visibility purposes. The date that the
supplier uses in the document is the Ship Date to convey when the goods can ship
to the customer's receiving location.

operation data store (ODS)

It represents all the tables that acts as destination for the collected data from each of
the data sources (both Oracle Applications or legacy systems). This acts as the input
for the snapshot portion of the planning process.

optimized plan

In this plan, you can generate an optimized and executable plan based on plan
objectives as well as material, resource, and transportation constraints.

order forecast

Used by a customer to communicate to the supplier the anticipated future orders for
a given item, period, and location from the supplier. The date that the customer
uses in the document is the Receipt Date to convey when he expects to receive the
goods. Alternately, the customer can provide a Ship Date that conveys when he
wants the supplier to make the shipment. When only a Ship Date is provided,
Oracle Collaborative Planning will derive a Receipt Date from the in-transit lead
time. In the absence of a lead time, the Receipt Date is the same as the ship Date.

pegging

The capability to identify for a given item the sources of its gross requirements
and/or allocations. Pegging can be thought of as active where-used information.
planned order

A suggested quantity, release date, and due date that satisfies net item
requirements.
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Planner Workbench

You can use the Planner Workbench to act on recommendations generated by the
planning process for a plan. You can implement planned orders as discrete jobs or
purchase requisitions, maintain planned orders, reschedule scheduled receipts, and
implement repetitive schedules. You can choose all suggestions from an MRP plan,
or only those that meet a certain criteria.

planning data store (PDS)

It represents all the tables within Oracle ASCP which encompass those in the ODS
and other output tables from planning. When we refer to PDS based ATP, we mean
ATP based on planning output.

postprocessing lead time

The time required to receive a purchased item into inventory from the initial
supplier receipt, such as the time required to deliver an order from the receiving
dock to its final destination.

preprocessing lead time

The time required to place a purchase order or create a discrete job or repetitive
schedule that you must add to purchasing or manufacturing lead time to determine
total lead time. If you define this time for a repetitive item, the planning process
ignores it.

processing lead time

The time required to procure or manufacture an item. For manufactured assemblies,
processing lead time equals the manufacturing lead time.

projected available balance

Quantity on hand projected into the future if scheduled receipts are rescheduled or
cancelled, and new planned orders are created as per recommendations made by
the planning process. Calculated by the planning process as current and planned
supply (nettable quantity on hand + scheduled receipts + planned orders) minus
demand (gross requirements). Note that gross requirements for projected available
includes derived demand from planned orders. Note also that the planning process
uses suggested due dates rather than current due dates to pass down demand to
lower level items. See current projected on hand.

projected on hand

The total quantity on hand plus the total scheduled receipts plus the total planned
orders.



routing

A sequence of manufacturing operations that you perform to manufacture an
assembly. A routing consists of an item, a series of operations, an operation
sequence, and operation effective dates.

safety stock

Quantity of stock planned to have in inventory to protect against fluctuations in
demand and/or supply.

sales forecast

A projection of future sales for a given item, period and location, the sales forecast
order type is used by customers to communicate what they expect to sell.
Alternately, it can be used by a supplier to communicate to the customer what the
supplier projects the customer to ship in the future. This sales forecast order type
will be useful for the sales forecast collaboration in the CPFR business process. In
both cases, the date that will be provided in the document will be the Ship Date to
convey the expected date that the goods will be shipped to a customer.

scheduled receipt

A discrete job, repetitive schedule, non-standard job, purchase requisition, or
purchase order. It is treated as part of available supply during the netting process.
Schedule receipt dates and/or quantities are not altered automatically by the MRP
system.

sell through forecast

See sales forecast.
sourcing rule

Specifies how to replenish items in an organization, such as purchased items in
plants.

suggested dock date

The date you expect to receive an order (to arrive on the receiving dock) as
suggested by the planning process.

suggested due date

The date when scheduled receipts are expected to be received into inventory and
become available for use as suggested by the planning process.
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The need-by date for the end item is the demand date. The need by dates for the
dependent demands are calculated based on the lead-time offsets that are associated
to the Items and routings used.

s If a constrained plan is run, the planning process will use the planned orders
and actual routings for scheduling to derive the suggested due date.

= If an unconstrained plan is run, the suggested due date will simply be the same
as the need by date.

Therefore, any differences between the lead time offsets (need-by date) and actual
manufacturing time (suggested due date) created by the planning process, will
show up in the form of multiple exception messages.

suggested order date

The date that the planning process suggests an order for goods or services is
entered. The earliest order date allowed is today and no compression days are
allowed.

suggested start date

The date you or your suppliers expect to start to manufacture the order as
suggested by the planning process.

supply chain ATP

This term is used to describe the task of performing an ATP check against multiple
sourcing organizations for a given customer request.

Supply commit:

Used by a suppliers communicate to customers anticipated future shipments. The
date the supplier uses in the document is the Ship Date to convey when he expects
to ship the goods to the receiving location. Alternately, the supplier can provide
only a Receipt Date that conveys when he expects the customer to receive the
goods. When only a Receipt Date is provided, Oracle Collaborative Planning will
derive a Ship Date from the intransit lead time. In the absence of a lead time, the
Receipt Date is the same as the Ship Date.

supplier flex-fences

Specifies capacity tolerance percentages that vary over time for each source. This
allows you to represent the ability of your supplier to flex capacity upwards based
on the amount of advanced notice you provide.



time bucket

A unit of time used for defining and consuming forecasts. A bucket can be one day,
one week, or one period.

unallocated onhand

Posted by a trading partner to communicate to another the quantity of inventory
physically in stock that is intended for the use all trading partners who receive such
communication. The date that used by the trading partner for this order type is
Actual Date to indicate the physical inventory being held by the trading partner for
the intended purpose.

unconstrained plan

In this plan, the system performs traditional MRP type planning and assumes
infinite material availability and resource capacity. Statements of material
availability and resource capacity are used to generate exceptions. Demand
priorities are included during the planning run to determine the appropriate
pegging relationships between supply and demand.
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